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LICENSE AGREEMENT FOR MELCO SOFTWARE

IMPORTANT READ CAREFULLY: This License Agreement is a legal agreement between you, the individual or entity using the Melco
software product ("User") and Melco Embroidery Systems ("Melco"). By installing or otherwise using this Melco software Product, User
agrees to be bound by the terms of this License Agreement. 

1. GRANT OF LICENSE. This License Agreement covers the Melco software product, contained on CD-ROM and/or disk, and accompanying
documentation and/or manuals (the "Software"), and the dongle security device (the "dongle"), all of which are referred to as the
"Product." Melco grants to User a non-exclusive, non-transferable, personal, limited license to use the Product according to the terms of
this License Agreement. User may also install the Software on a storage device, such as a network server, used only to install or run the
Software on User's other computers over an internal network; however, User must acquire and dedicate a license for each separate
computer on which the Software is installed or run from the storage device. A license for the Product may not be shared or used
concurrently on different computers. The Product is licensed for use only by User and may not be re-licensed or sub-licensed without
Melco's prior written permission. In the event that Melco grants such permission, a re-licensing fee will be charged.

2. COPYRIGHT. The Product contains proprietary information of Melco. This material is protected by copyright laws, international treaty
provisions, and other laws respecting proprietary rights. Melco retains all rights in the Product, including (without limitation) all copyright
and other proprietary rights worldwide in all media. User may not use the Product except as expressly permitted under this License
Agreement and under U.S. copyright laws. 

3. RESTRICTIONS. User may not and may not permit others to: copy, reproduce, publish, publicly display, distribute, sell, or otherwise use
any material contained in the Product in any manner whatsoever that may infringe any copyright or proprietary interest of Melco (except
that in the case of software contained on a disk, User may make one backup copy); distribute, rent, sublicense, lease, transfer, assign or in
any way commercially exploit, the Product or the License Agreement; decompile, disassemble or otherwise reverse-engineer the Product, or
alter, translate, modify or adapt the Product to create derivative works. This license can only be transferred with written permission of
Melco. This license is not a sale. Title and copyrights to the Product remain with Melco. If User breaches any provision of this License
Agreement, Melco may immediately terminate this License Agreement and all licenses granted hereunder without prior notice and in
addition to any other available rights and remedies. In such event, User shall immediately return to Melco all copies of the Software,
accompanying documentation and/or manuals, and all associated dongles that are within User's custody or control.

4. LIMITED WARRANTY. Melco warrants that the Software will perform substantially in accordance with published specifications and the
accompanying written materials provided that the Software is used on the computer hardware and with the operating system for which it
was designed, for a period of ninety (90) days. Melco does not warrant that the Software will meet the User's requirements or run without
interruption or error. 

Melco warrants, in accordance with and subject to the provisions herein contained, the dongle against defects in materials and
workmanship under normal use and service when properly installed for a period of twelve (12) months from the date of delivery to User.
This warranty does not extend to or cover the dongle or any part of it which, in the reasonable opinion of Melco, has been damaged or
rendered defective by accident, electrostatic discharge, willful act, negligence, misuse, alteration, repair, electrical fusion, or lightning.

Subject to the limitations stated above, Melco will use its best efforts to replace defective media, defective dongles, or correct significant
software error, provided that User returns the defective material to Melco Embroidery Systems, 1575 W. 124th Ave., Denver, CO 80234,
within ninety (90) days of delivery, in the case of Software, and within twelve (12) months of delivery, in the case of a dongle. This is User's
sole remedy for breach of warranty. 

5. NO OTHER WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MELCO DISCLAIMS ALL OTHER WARRANTIES,
EITHER EXPRESS OR IMPLIED, WITH REGARD TO THE PRODUCT, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, OR ANY OTHER WARRANTY WITH RESPECT TO THE QUALITY,
ACCURACY OR FREEDOM FROM ERROR OF THE OPERATION, USE AND FUNCTION OF THE PRODUCT. THIS LIMITED WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS, WHICH VARY FROM STATE/JURISDICTION TO STATE/JURISDICTION.

6. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL
MELCO BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER
PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PRODUCT, EVEN IF MELCO HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

7. CUSTOMER'S RESPONSIBILITY. It is the User's responsibility to verify before purchase that the Product will be suitable for User's intended
purpose(s). It is also the responsibility of the User to disclose to a potential buyer of the Product, that transfer of the Product requires the
prior written permission of Melco and that a re-licensing fee is charged by Melco for transfer of the license to another party.
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Introduction

Welcome
Dear Customer,

At Melco we recognize that ease of use equals productivity. With this
in mind we have redesigned our legendary EDS software. EDS IV
...xtreme is the successor to Melco's EDS III embroidery design
system. It is based on Melco's proven Stitch Generator. The addition
of a new intuitive user interface makes it the most productive
software in the embroidery industry. In order to guarantee a smooth
transition into EDS IV, Melco has maintained compatibility with
existing design formats, such as Condensed, Expanded and
Alphabets, etc. The Digitizing Assistant and other new features give
EDS IV users the fast track to quality designs.

Together with EDS IV you get Melco’s proprietary Embroidery
Network System (ENS). This powerful software allows you to
centralize and automate production management tasks such as
sending and queuing designs to individual Melco embroidery
machines; collecting and displaying machine performance data
including thread and bobbin breaks, run times, and down time;
immediately access machine operation and service information to
assure proper operation and maintenance of all embroidery machines
and components (see ENS User's manual for more information).

Thank you for being Melco’s business partner.

EDS IV xtreme User Guide2
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What’s New in EDS IV Version 3.00

Applies to All Product Levels
• Supports the reading and writing of Janome .jef home

format ( pages 147, 148, 150)

• Graphic Background (Fabric Background) (p. 193)

• Sequenced lettering (p. 221)

• The behavior for Lock Stitches and Trims has changed for
closest point and non-closest point alphabets (p. 226)

• Hoop Manager (p. 213)

• Alignment Tools (p. 124)

• Factory Default Settings (p. 164)

• Hide Stitches Tool (p. 177)

• Two Different Types of OFM File Compatibility (p. 150)

Applies to Base, Midpoint, and Summit Product Levels
• The ability to perform outline editing has been added to

Base level 

• Walk and Manual Walk Digitizing capabilities have been
enabled for Base level

• Accelerator Editor (User defined Hot-Keys) (p. 158)

• Convert / Restore Alphabets (p. 160)

• The option to change the wireframe point size (p. 171)

• Complex Fill Pull Compensation (p. 206)

• Global Scale Factors (p. 138)

• Enhanced Find Feature (p. 138)

• Grouping and Ungrouping Tools (p. 176)

• Design Database Application (p. 114)

Applies to Midpoint and Summit Product Levels
• Capped and Mitered Corners (p. 195)

• Expanded Editing with the Project View Stitches Tab (p. 179)

• Retrace Tool (p. 237)

EDS IV xtreme User Guide 3
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System Requirements
• PC with a Pentium II 300 MHz or higher processor (Pentium

III 450 MHz or higher recommended)

• Microsoft Windows 98 or Windows Millennium or Windows
XP Home or Windows XP Professional or Windows 2000
operating system.

• 128MB of RAM (128MB (+) recommended) for Windows
98/ME; 128MB (128MB (+) recommended) for Windows XP
Home, Windows XP Professional and Windows 2000. 

• Super VGA video adapter and monitor configured for
1024x768 resolution or higher, video driver set to High
Color or better for Windows 98 / Millennium; 32768 color
or higher for Windows XP Home, Windows XP Professional
and Windows 2000. If you want to change the settings of
your screen resolution, please click on the “Start” button of
your Windows taskbar, followed by a click on “Help”. Do a
search for “display, resolution”.

• Parallel port for EDS IV security dongle

• CD-ROM drive (required for EDS IV installation, 16X is
recommended)

• Two or three button mouse (3 button mouse preferred)

• Internet Explorer 5.0 or greater

Incompatible Hardware / Software

EDS IV users should avoid the HP Deskjet G55 printer Driver. Users
have reported unspecified problems with EDS IV when this driver is
installed.

Product Levels
The following product levels are available:

• EZ

• Base (Lettering)

• Mid-Point (Lettering, Editing)

• Summit (Lettering, Editing, Digitizing)

EDS IV xtreme User Guide4
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Product Options
The following options are available with EDS IV ...xtreme:

• Digitizing Assistant (requires Summit)

Installing the Dongle
The dongle is a security device that must re-installed in an active
parallel port of your computer

1. Locate an active parallel port on the rear of your computer.
Usually this is LPT1, but it could be LPT2 if you have two parallel
ports.

2. Turn the computer OFF.

3. Secure the dongle with the captive screws at its sides.

Installing EDS IV ...xtreme
1. Insert the EDS IV ...xtreme Program CD into the CD ROM drive.

2. Follow the auto-run installation program instructions.

3. When asked to enter your access code you will find this by
looking inside your EDS IV CD case. It’s on the white label on
the left side.

If the auto-run installation program doesn’t begin:

1. Click on Start, Run to display the Run dialog box.

2. Browse to your CD ROM drive.

3. Select setup.exe and click Open.

4. Click OK and follow the on-screen instructions to install EDS IV
extreme.

To Start the HTML Help System

Simply go to the Help Menu, select Help or press the toolbar
button. You can also press the ‘F1’ key. When you are in a property
page, press the ‘F1’ key to go directly to help on that dialogue.

EDS IV xtreme User Guide 5
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Tips for using the HTML Help System:

• Use the red navigation bar buttons to easily access topics.

• There are three tabs on the left side to search for topics
using Table of Contents, Index, or Search.

• You can click the Home button to display the initial screen
at any time.

• When viewing Help, you can maximize the Help window or
resize it to suit your preference. However, the Help System
was designed to display optimally in the default window
size.

• Click the Hide or Show navigation buttons to view or hide
the TOC, Index, and Search tabs.

• Click the Back button to return to the previously viewed
topic.

• Click Print to print topics. The Print dialog provides options
for printing the current topic, everything contained in a
current heading (based on the item selected at the TOC), or
everything in the Help system. You can also right-click inside
the topic frame and select Print from the pop-up menu.

• The Options drop-down button provides additional browse
and navigation controls. Click and hold the Options button
to show the additional controls.

• Many topics include a Related Topics button at the end of
the text that displays a pop-up menu of related topics that
you can click on and go to.

To Identify a Tool or Control in EDS IV
Position your mouse pointer over the tool or control and wait one
second. A tool tip will appear showing the name.

For more information on this tool, go to the HTML Help System and
type the name in the index tab, press “Display” or hit <Enter> on
your keyboard.

You can also go to the Reference Page in the HTML Help System and
click on the tool that way.

EDS IV xtreme User Guide6
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Basic Tutorial

Open a Design
Opening a design in EDS IV is very similar to opening a design in EDS III.

Exercise

1. Click on the File Menu.

2. Click on Open (Or, click on the Open tool on the Main
toolbar).

3. Click on Files of Type drop down menu to choose the embroidery
file type.

4. Click on the design you would like to open (if the design is not in
the list, you may have to look in another folder).

5. Click on Open or double click on the design.

Save a Design
Saving a design in EDS IV is very similar to saving a design in EDS III.

Exercise

1. Click on File.

2. Click on Open.

3. Open Earthday.ofm from the \Designs folder.

4. Click on File.

5. Click on Save or Save As.

6. If Save As is chosen, the Save As dialog box is displayed.

7. Type a new filename.

8. Choose the file format from the Save as type drop-down menu.

9. Click on Save.

EDS IV xtreme User Guide8
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Import a Design
Importing designs to an embroidery formats is similar to EDS III.

Exercise

1. Click on File.

2. Click on Import.

3. The Import dialog box is displayed.

4. Click on the file format (if you do not know, click on unknown).

5. Click on the Directory button (there must be a disk in the disk
drive).

6. Select the design.

7. Click on Import or double click on the design.

Export a Design
Exercise

1. Click on File.

2. Click on Export.

3. The Export dialog box is displayed.

4. Type the filename.

5. Choose the Embroidery format.

6. Click on the Export button (an embroidery format disk must be
in the disk drive).

Auto Save
Exercise

1. Open any design.

2. Click on Tools drop-down menu from the Standard toolbar.

3. Click on the File Options tab.

EDS IV xtreme User Guide 9
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4. Click on the (check) to turn Auto Save off (or on).

5. Type a new interval amount in minutes, to Auto Save.

6. Click on OK.

Print a Design 
Exercise

1. Open any design.

2. Click on the Print tool  on the Main toolbar.

3. The Print dialog box is displayed.

4. Choose the parameters to print the designs.

5. Click on OK.

Add Lettering to a Design
Exercise

1. Open EDS IV.

EDS IV xtreme User Guide10
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2. Open Earthday.ofm from the\Designs folder.

3. Click on the Lettering tool .

4. Left click on the screen workspace (View Window) where you
want the lettering text to appear (notice the arrow has an A
attached to it).

5. Type the lettering parameters.

6. Click on OK.

7. The lettering will be inserted on the screen with the design.

8. Adjust as needed.

Combine Two Designs Together in the Same Project 
Exercise

1 Open any design.

2. Click on the Insert File tool on the Main toolbar.

EDS IV xtreme User Guide 11
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3. The Insert dialog box is displayed.

4. Look in the directory where the design is located.

5. Click on the design you want to insert.

6. Click on Open or double click on the design.

Check the Design Status
There are a couple of ways to obtain the design status for your
designs in EDS IV.

Exercise

1. Click on File.

2. Click on Open.

3. Open "Earthday.ofm" design from the \Designs folder.

4. Click on View drop down menu and Properties.

5. The Design Properties dialog box comes up.

6. Click on the Status tab.

OR

Exercise

1. Click on File.

2. Click on Open.

3. Open "Earthday.ofm" design from the \Designs folder.

4. Highlight the design name in the Project View.

5. Right click with the mouse.

6. Choose Properties from the drop down menu.

7. Click on the Status tab.

EDS IV xtreme User Guide12
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Save Notes to a Design 
Exercise

1. Open any design.

2. Click on the Notes tool on the Main toolbar.

3. Type the notes for your design.

4. EDS IV automatically defaults to Word Pad for your notes. (You
can change this to use any Windows application.)

5. The notes will be saved to any design that uses an .ofm file
extension.

EDS IV xtreme User Guide 13
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Scale Designs
There are many ways to scale your designs. Please follow the exercises
below to see just a few.

Exercise

1. Click on File.

2. Click on Open.

3. Open "Earthday.ofm" design from the \Designs folder.

4. Highlight (click to select) the design name in the Project View.

5. Right click on the design name with your mouse button.

6. Select Properties from the drop down menu.

7. Click on the Scale tab.

EDS IV xtreme User Guide14
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8. Enter a percentage scale or specify the design size by typing the
design measurement.

9. If scaling proportional, click on proportional and type a horizontal
size only.

10. Click on OK (or the Apply button).

OR

Exercise

1. Click on File.

2. Click on Open.

3. Open "Earthday.ofm" design from the \Designs folder.

4. Click on the View drop down menu on the Standard toolbar.

5. Click on Select Entire Design.

EDS IV xtreme User Guide 15
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6. Click and drag on any of the black handles with the left mouse
button.

7. To scale the design proportionally, click and drag on any of the
four corner handles.

8. To scale the design in the X or Y position only, click and drag on
the black handles in between the corners.

Rotate a design
To rotate the entire design, following the exercises below:

Exercise

1. Click on File.

2. Click on Open.

3. Open "Earthday.ofm" design from the \Designs folder.

4. Left click to highlight (select) the design name in the Project
View.

EDS IV xtreme User Guide16
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5. Right click on the design name.

6. Select Properties from the drop down menu.

7. Click on the Position Tab.

8. Type the desired rotation amount in degrees.

9. Click on OK (or the Apply button).

OR

Exercise

1. Click on File.

2. Click on Open.

3. Open "Earthday.ofm" design from the \Designs folder.

4. Left click to highlight (select) the design name in the Project
View.

EDS IV xtreme User Guide 17
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5. Right click on the design name.

6. Select, "Select Entire Design" from the drop down menu.

7. Right click anywhere on the design in the window.

8. Choose Rotate/Transform from the drop down menu.

9. You will now have a box with a green arrow.

10. Click and drag the green rotation arrow.

11. To move the anchor point, click and drag with the left mouse
button to place the center green box anywhere on the design.

12. Once you have placed the center rotation, click and drag the
green arrow in the direction you would like to rotate (this is
used as the pivot point of rotation).

EDS IV xtreme User Guide18
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Center Designs 
Before you save or send the design to the machine to sew, you will
need to Center the design, as was the case in EDS III.

Exercise

1. Open any design

2. Click on the Center design tool on the Input toolbar.

3. Your design will be center, now you can save or sew.

Note: The design will not move on the screen if it was already in the
center.

Redraw Speed
Exercise

1. Open any design

2. Click on the View Menu.

3. Choose "Redraw Speed".

4. From the pop-up menu choose a redraw speed from 1-9, 9
being the slowest.

EDS IV xtreme User Guide 19
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Basic Lettering Tutorial

Start Lettering
Exercise

1. Click on the lettering tool on the Input toolbar.

2. Left click on the screen workspace (View Window) where you
want your lettering text to appear (notice the cursor arrow has
an A attached to it).

3. The Lettering Properties box is displayed in your screen.

EDS IV xtreme User Guide20
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Add Color Changes
To add color changes between specific letters, you can use the F6 key
on the keyboard or click on the color change  tool in the lettering
dialog box.

Exercise

1. Click on the Lettering tool .

2. Left click on the screen workspace (View Window) where you
want your lettering text to appear (notice the cursor arrow has
an A attached to it).

3. Type "Melco" in the text space.

4. Place your cursor (left click) between the "M" and the "e" of
word "Melco".

5. Click on the color change tool (notice the ^ is inserted).

6. Click on OK.

7. Double click on the text to adjust further.

Customized Spacing
To add or subtract spacing between specific letters, you can use the

F7 or F8 keys on the keyboard or click on the or tools in
the lettering dialog box.

Exercise

1. Click on the Lettering tool .

2. Left click on the screen workspace (View Window) where you
want your lettering text to appear (notice the cursor arrow has
an A attached to it).

3. Type "Melco" in the text space.

4. Choose "Melco Block" alphabet.
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5. Change letter height to 1 inch.

6. Click on OK (notice the spacing needs to be adjusted between
certain letters).

7. Double click on the lettering to select the lettering.

8. Place your cursor (left click) between the "M" and the "e" of
the word "Melco".

9. Click on the to insert < for less spacing.

10. Click on the  to insert a > for positive spacing.

11. Click on OK.

12. Double click on the text to adjust further.

Add Specific Trims
To add a trim command between specific letters, your can use the F9

key on your keyboard or click on the trim tool in the lettering
dialog box.

Exercise

1. Click on the Lettering tool .

2. Left click on the screen workspace (View Window) where you
want your lettering text to appear (notice the cursor arrow has
an A attached to it).

3. Type "Melco" in the text space.

4. Place your cursor (left click) between "M" and the "e" of the
word "Melco".

5. Click on the trim tool (notice the '¤' inserted).
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Place Letters on an Arc
Exercise

1. Click on the Lettering tool .

2. Left click on the screen workspace (View Window) where you
want your lettering text to appear (notice the cursor arrow has
an A attached to it).

3. Type "Melco Embroidery" in the text space.

4. Click on "Place Letters On Arc".

5. Check the Arc Properties button.

6. The Arc Properties dialog box is displayed.

7. You can now change the Arc values.

8. Click on OK .

9. Click on OK again to apply your changes and get back to the
View Window.

Change Column Width
Exercise

1. Click on the Lettering tool .

2. Left click on the screen workspace (View Window) where you
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want your lettering text to appear (notice the cursor arrow has
an A attached to it).

Click on the Column Tab.

The Column Width is in this dialog box.

Change Density
Exercise

1. Click on the Lettering tool .

2. Left click on the screen workspace (View Window) where you
want your lettering text to appear (notice the cursor arrow has
an A attached to it).

3. Click on the Column Tab.

4. You should see Density in this dialog box.

EDS IV xtreme User Guide24
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Add Underlay
Exercise

1. Click on the Lettering tool .

2. Left click on the screen workspace (View Window) where you
want the lettering text to appear (notice the cursor arrow has
an A attached to it).

3. Click on the Column Tab.

4. Click on the Primary Underlay button to choose the different
types of underlay.

Center Designs
Exercise

1. Click on the Lettering tool .

2. Left click on the screen workspace (View Window) where you
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want the lettering text to appear (notice the cursor arrow has
an A attached to it).

3. Type in the text.

4. Place the lettering in the View Window by pressing OK.

5. Click on the Center Design tool on the Input toolbar.

6. The design will now be centered.

Transform Lettering
Transformed lettering is even more powerful in EDS IV than it was in
EDS III. Please follow the exercise to learn how to use this feature.

Exercise

1. Click on the Lettering tool .

2. Left click on the screen workspace (View Window) where you
want the lettering text to appear (notice the cursor arrow has
an A attached to it).

3. Type "Melco" in the text space.

4. Select "Athletic Block" Alphabet .

5. Change letter height to .75.

6. Click on OK.

7. You will see solid black handles around the text "Melco".

8. Click and hold the left mouse button (about 1 second)
anywhere on the text "Melco" (or, click on the lettering in the
View Window with your right mouse button and choose
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Rotate\Transform from the pop-up menu). You will notice the
black diamonds control points in the corners. You can drag
these in any direction to transform the lettering text.

9. You can also insert input points on the line around the lettering
text to transform even more.

Left click ANYWHERE on the line with the mouse will give you a
straight input point (notice the arrow is different, it changes to

a ).

Right click ANYWHERE on the line with the mouse will give you
a curved input point (notice the arrow is different, it changes to

a ).

10. Once the points have been inserted, click, hold and drag them
to transform.

11. To delete an input point, select the point and press the delete
key on the keyboard.
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12. To select more than one input point, hold the control key down
and left click on each one.

13. To switch the lettering text back to the solid scaling boxes, left
click on any void area on the screen and then back on the
lettering text.

Common Transformations
Pennant - With the left mouse button, select the upper right triangle
control point. Hold down the (Ctrl) key and select the lower right
corner point. Hold down the (shift) key and drag it away from the
word. This works with all four corner points of the word.

Slanting - With the left mouse button, select the upper right triangle
control point. Hold down the (Ctrl) key and select the lower right
triangle point. Click on one of these points and drag it away from the
word. This works with all four corner points of the word.

Bilinear - Select any of the corner triangle control points. With the
left mouse button, click and drag in any direction.
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Upper Bridge - Click the right mouse button on the line below the
text (this will insert a circular control point). With the left mouse
button, click on the point and drag it upward.

Lower Bridge - Click the right mouse button on the line above the
text (this will insert a circular control point). With the left mouse
button, click on the point and drag it downward.

Vertical Bridge (upper) - Click the right mouse button on the line
above the text (this will insert a circular control point). With the left
mouse button, click on the point and drag it upward.

Vertical Bridge (lower) - Click the right mouse button on the line
below the text (this will insert a circular control point). With the left
mouse button, click on the point and drag it downward.
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Vertical ARC (upper) - Click the right mouse button on the line
above the text (this will insert a circular control point). Click the right
mouse button on the line below the text (this will insert a circular
control point). Hold down the (Ctrl) key and left click the other
circular control point. Hold down the (Alt) key, click on one of these
points and drag it upward.

Vertical ARC (lower) - Click the right mouse button on the line
above the text (this will insert a circular control point). Click the right
mouse button the line below the text (this will insert a circular control
point). Hold down the (Ctrl) key and left click the other circular
control point. Hold down the (Alt) key, click on one of these points
and drag it downward.

Ballooned - Click the right mouse button on the line above the text
(this will insert a circular control point). Click the right mouse button
the line below the text (this will insert a circular control point). Hold
down the (Ctrl) key and left click the other circular control point. Hold
down the (Shift) key, click on one of these control points and drag it
away from the center of the text.
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Squeezed - Click the right mouse button on the line above the text
(this will insert a circular control point). Click the right mouse button
on the line below the word (this will insert a circular control point).
Hold down the (Ctrl) key and left click the other circular control point.
Hold down the (Shift) key, click on one of these control points and
drag it toward the center of the text.

Diamond - Click the left mouse button on the line above the text
(this will insert a triangle control point). Click the left mouse button
on the line below the text (this will insert a triangle control point).
Hold down the (Ctrl) key and left click the other triangle control
point. Hold down the (Shift) key, click on one of these control points
and drag it away from the center of the text.

Further distortions - Left or right click anywhere on the line around
the text to insert multiple control points. Click and drag these points
to distort.

*Once you distort the lettering, notice the immediate change on your
screen. This is a nice place to utilize the Undo and Redo tools if the
look is undesirable.
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Rotate Lettering
Exercise

1. Click on the Lettering tool .

2. Left click on the screen workspace (View Window) where you
want your lettering text to appear (notice the cursor arrow has
an A attached to it).

3. Type "Melco" in the text space.

4. Choose "Block" alphabet.

5. Change letter height to 1.00 inch.

6. Click on OK.

7. Select the lettering.

8. Right click on the lettering and select "Rotate/Transform" form
the pop-up menu. You can also click and hold with the left
mouse button on the text for 1 second, this method may be
difficult for some people.

9. Click and drag the green arrow that comes from the middle of
the text to rotate.

10. To move the anchor point, click and drag with the left mouse
button to place the center green box anywhere on the text.

11. Once you have placed the center rotation, click and drag the
green arrow in the direction you would like to rotate (this is
used as the pivot point of rotation).

Basic Editing Tutorial
Most editing will take place in the Project View or using the
"wireframe" points on the design in the view window.

Instead of viewing the design in editing with Mark points as in EDS
III, designs will now be viewed in a list as "elements" using the
Project View on the right side of the screen. For those users who
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have upgraded, adding and deleting functions such as color changes
and trims are just as easy as in EDS III. Changing densities, column
width and moving parts of a design will now all be much easier using
the Project View.

As you will see, the project view is a very powerful tool when editing
designs in EDS IV. The design "Earthday.ofm" will be used in all of
the following exercises. This design was digitized on EDS IV and is
included with your designs on EDS IV.

Work With the Project View
Exercise

1. Open EDS IV

2. Open the Earthday.ofm design in the \Designs folder.

3. The Project View starts with the name earthday. Below is the
actual design with a + next to it.

4. Click on the + to expand and see all the elements associated
with this design.

Note: you can use the scroll bar on the right of the Project View to
scroll through the elements. If you click on a particular element to
select it, notice that it is also selected on the design.

Insert Color Changes and Trims
Functions such as Color Changes and Trims are inserted in the Project
View similar to the way they are inserted in the EDS III stitch list.

Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.
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3. Click on the + to view the elements of the design.

4. Use the scroll bar to scroll to the area where the color change
needs to be inserted.

5. Click on the element above where the color change needs to be
inserted.

6. Click on the Color change tool .

7. The design will automatically regenerate to show the Color
change.

Note: This same exercise can also be used for inserting Trims.

Change Stitch Length
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Click on the + to view the elements of the design.

4. Use the scroll bar to scroll to the Walk stitch element that needs
to be changed.

5. Left click to highlight the element.

6. Right click and click on properties.

7. Click on the Walk tab.
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8. Type in a value for stitch length.

9. Click on OK or Apply.

Change Column Density
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Click on the + to view the elements of the design.

4. Use the scroll bar to scroll to the element where the Column
density needs to be changed.

5. Left click to highlight the column element to change.

6. Right click on the element and choose Properties.

7. Click on the Column tab.
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8. Change the density setting or use Auto Density.

9. Click on OK or Apply.

Note: This changes the properties for this element only. The rest of
the design will not be effected.

Change Column Width
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Click on the + to view the elements of the design.

4. Use the scroll bar to scroll to the element where the Column
width needs to be changed.

5.Left click to highlight the Column element to change.

6. Right click and choose Properties.

EDS IV xtreme User Guide36

16603 Rev.A Melco Embroidery Systems



7. Left click on the Column tab.

8. Change the Width setting

9. Click on OK or Apply

Note: This changes the properties for this element only. The rest of
the design will not be effected.

Change Fill Density
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Click on the + to view the elements of the design.

4. Use the scroll bar to scroll to the element where the Fill density
needs to be changed.

5. Click on the Complex fill element with a left click.
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6. Right click and choose Properties.

7. Click on the Fill tab.

8. Change the Fill density.

9. Click on OK or Apply.

Note: The Fill type number, stitch length, # partitions, partition
sequence and line angle can also be changed using the same
exercise.

Note: This changes the properties for this element only. The rest of
the design will not be effected.

Add Underlay to a Column
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.
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3. Click on the + to view the elements of the design.

4. Use the scroll bar to scroll to the Column element that needs
Underlay.

5. Left click to highlight the Column element to change.

6. Right click and choose Properties.

7. Click on the Column tab.

8. Click the down arrow at Primary Underlay and choose an
underlay (choose a secondary underlay if necessary).

9. Click on OK or Apply.

Note: this changes the properties for this element only. The rest of
the design will not be effected.
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Add Underlay to a Fill
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Click on the + to view the elements of the design.

4. Use the scroll bar to scroll to the Fill element that needs
underlay.

5. Click on the Complex fill element with a left click.

6. Right click and choose Properties.

7. Click on the Fill tab.

8. Click in the box beside Underlay On.
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9. Change Stitch Length, Border Margin, and Density or Angle if
necessary.

10. Click on OK or Apply

Save Partition Fill
This gives the capability to save a user defined fill with a specific
Density, Stitch Length, # Partitions, Partition sequence, and Line angle,

Exercise

1. Open EDS IV.

2. Click on the New tool.

3. Click View drop down menu and choose Properties.

4. Click on the Fill tab.

5. Input the Density, Stitch Length, # of Partitions, Partition
Sequence and line angle of the new fill.
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6. Click on Save Partition Fill button.

7. Type in a number (other than 1 - 18).

8. Type in a name for the new fill.

9. Click OK out of the Save Fill tab.

10. Click OK out of Element Properties.

11. This fill is ready to be applied to an existing fill in any design. To
apply, see change fill density in tutorial.

Note: Also, in the Fill tab, click on Fill tab/Select to view the fill
partition graphically.

Delete Parts of a Design and Functions
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Click on the + to view the elements of the design.

4. Use the scroll bar to scroll to the element to delete.

5. Left click to highlight on the element.
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6. Press the Delete key on the keyboard or go to the Edit drop down
menu and click on Clear.

7. Design regenerates automatically.

Note: EDS IV has unlimited undo's if you deleted the wrong element.

Add Lock Stitches to a Particular Element of a Design
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Click on the + to view the elements of the design.

4. Use the scroll bar to scroll to the element that needs lock stitches.

5. Click on the element with a left click.

6. Right click and choose Properties.

7. Click on the Lock/Trim tab.
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8. Click on the box beside Tie in & Tie off.

9. Click OK or Apply.

Note: If Tie in & Tie off is turned on, EDS IV will insert a lock stitch at
every connector.

Add Lock Stitches to an Entire Design
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Left click on the design in the Project View.

4. Right click and choose Properties.

5. Click on the Lock/Trim tab.

6. Click on the box beside Tie in & Tie off.

7. Click OK or Apply.
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Note: If Tie in & Tie off is turned on, EDS IV will insert a lock stitch at
every connector.

Select Entire Design

Click on "Select All" toolbar button.

Select Design Graphically
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Zoom out if necessary in order to see entire design click here for
help on Zoom.

4. Using a left click, click and drag a box around the entire design.

Select Design Through the Project View
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Click on the + to view the elements of the design.

4. Click on the first element in the design.

5. Use the scroll bar to scroll to end of the Project View.

6. Hold down the Shift key on the keyboard.

7. Click on the last element of the design.
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Note: All elements are highlighted in the Project View and design is
also highlighted.

Select Entire Design Through Keyboard Shortcut Keys
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Hold down Ctrl + A on the keyboard.

Note: This selects the entire design as well as all elements in the
Project View.

Selecting Multiple Parts of a Design
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Click on the + to view the elements of the design.

4. Left click on any element in the design.

5. Hold down the Ctrl key on the keyboard.

6. Left click on other elements while continuing to hold down the
Ctrl key.

7. Once the multiple elements are highlighted they can be moved,
changed, or deleted.
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Scale a Design Through the Project View
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Left click on the design to highlight.

4. Right click on the design and choose Properties.

5. Click on the Scale tab.

6. Type in a percentage or measurement for the entire design.

7. If scaling proportional, click on Proportional and type a
horizontal size only.
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Scale a Design Graphically
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Select the entire design (see Selecting entire design in the
tutorial).

4. Click on one of the four corner box handles and drag in or out
to scale.

Scale Part of a Design Through the Project View
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Left click on the + next to the design to show all the elements.
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4. Use the scroll bar on the right to move to the element to be
scaled.

5. Left click on the element that needs to be scaled

6. Right click on the element and click on properties.

7. Click on the Scale tab

8. Type in a percentage or measurement for the element.

9. If scaling proportional, click on Proportional and type a
horizontal size.

Note: If more than one element needs to be scaled, see Selecting
multiple parts of a design in Editing tutorial.

Scale Part of a Design Graphically
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Left click on the + next to the design to show all the elements.

4. Left click on the element that needs to be scaled or left click
directly on the design to select element.

5. There is now a box around the element on the design.

6. Click on one of the four corner handles and drag in or out to
scale.

Editing Wireframe Data
Exercise

Selecting Wireframe Input points

Please complete this entire exercise to learn how to select, change,
add, move, or delete wireframe points.

1. Open EDS IV.
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2. Open the Earthday.ofm design from the \Designs folder.

3. Zoom in on the Sun in the design using one of the zoom
methods.

4. Click on the Edit mode tool on the Input toolbar.

5. Select the sun on the design by clicking on it with the left mouse
button (there will be an eight handled box around the shape).

Note: Notice the Project View will highlight this element in the design
list.

6. When your cursor is over the input point on the wireframe of the
sun.

• The mouse pointer will show a triangle when placed over a
digitized straight input point.

• The mouse pointer will show a circle when placed over a
digitized curve input point.

• The mouse pointer will show a line when placed over any
wireframe line.
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7. Click on the input point to select it. The input point will be
highlighted and show as a solid triangle or solid circle.

Changing Wireframe Input Points

8. Double click on the wireframe point with your left mouse
button.

9. The Wireframe Point dialog box is displayed.

10. Change to straight or curved.

11. Click on OK (or apply).

Note: An alternative way to change the wireframe point from straight
to curved or curved to straight is to hold down the shift key and left
click on the point.

Adding Wireframe Input Points

12. Left click anywhere on the wireframe line.

13. Left click will add a straight and right click will add a curved
input point.
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Moving Wireframe Input Points

14. Left click on the wireframe point.

15. Click, hold and drag the input point with the mouse button.

Note: Notice the change immediately on the screen.

Deleting Wireframe Input Points

16. Left click on the wireframe point.

17. Press the delete key on the keyboard.

Note: Notice the change immediately on the screen.

Cut, Copy and Paste
Exercise

1. Open EDS IV.

2. Open the Earthday.ofm design in the \Designs folder.

3. Left click on the + next to the design to show all the elements.

4. Left click on the element that needs to be Cut or Copied.

5. Click on the tool to Cut  or Copy .

6. The element is now on the clipboard.

7. Scroll to the area where it needs to be pasted.

8. Click on the paste tool .

9. The Cut or Copy of the element will be pasted in under the
element that's highlighted.

Note: These elements can also be copied to an existing design or new
design.
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Basic Digitizing Tutorial
In this section we are assuming you have some digitizing experience.
All the new digitizing techniques will be covered in the exercises
included with this tutorial. For beginning digitizers, you can also refer
to other tutorials by clicking on the "Related Topics" button at the
bottom of this page. To edit the elements digitized, please see the
editing tutorial.

To complete this part of the tutorial, we will be digitizing elements of
the Earthday.bmp graphic to show you how to digitize in EDS IV
using wireframe techniques. Wireframe points are shown with
straight or curved lines on the screen to give you a visual feedback on
the shape based on the points you digitize. To see a completed
version of the design, open Earthday.ofm from \Designs folder.

Please load Earthday.bmp, located in the \Designs\Graphics folder to
follow along with in the digitizing exercises in this tutorial (see Open
a Graphic).

Scan an Image
Exercise

1. Open EDS IV.

2. Click on File.

3. Click on New.

4. Click on Scan Image.

5. The Scanner drive software dialog box comes up.

6. Scan the Image.

7. After scanning the Image, a dialog box is displayed to save the
graphic.

8. Save the graphic or cancel.

Open a Graphic
Exercise

1. Open EDS IV.
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2. Click on File.

3. Click on Open or Insert.

4. The Open/Insert dialog box is displayed.

5. Click on "Files of Type" drop down menu and choose "All
Graphics" (if the graphic is not in the list, you may have to look
in another folder).

6. Open Earthday.bmp from \Designs\Graphics folder.

7. Click on Open or double click on the graphic filename.

8. Notice the graphic filename is inserted into the Project View list.

Save a Graphic
Exercise

1. Scan or Open a Graphic in EDS IV.

2. Right click on top of the Graphic on the screen.

3. Select "Save As" from the drop down menu.

4. The "Save Image As" dialog box is displayed.

5. Type a filename.

6. Select the directory to save it in.

7. Click on Save.

Note: Choose *.bmp, *.pcx, *.jpg, or *.tif file types.

Scale a Graphic
Exercise

1. Scale graphically

2. Open EDS IV.

3. Open Earthday.bmp from \Designs\Graphics folder.
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4. Left click to highlight the graphic name in the Project View.

5. The graphic will now have 8 black handles around it.

6. To scale the graphic proportionally, click on any of the four
corner handles.

7. To scale the graphic in the X or Y position only, click on the
black handles at the top, bottom, or sides.

OR

Exercise

Scale numerically

1. Open EDS IV.

2. Open Earthday.bmp from \Designs\Graphics folder.

3. Left click to highlight the graphic element in the Project View.
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4. Right click on the graphic name in the Project View.

5. Select Properties from the drop down menu.

Note: You can also double click on the graphic to access the Scale
Properties dialog box.

6. Click on the Scale tab.

7. Enter a percentage scale or specify the measurement.

8. Click on OK (or apply).

Hide a Graphic
Exercise

1. Open EDS IV.

2. Open Earthday.bmp from \Designs\Graphics folder.
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3. Click on the Hide graphic tool on the View toolbar.

4. Click on the Hide graphic tool again to turn it back on.

Note: Even if the graphic is hidden, it will still save with the project.

Set Stitch Length
Exercise

1. Open EDS IV.

2. Open Earthday.bmp from \Designs\Graphics folder.

3. Click on the Walk normal or Walk bean stitch tool on the Input
toolbar with the right mouse button.

4. The Walk Element Properties box is displayed.

5. Change the stitch length to the desired amount.

6. Click on OK (or apply).
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Note: The stitch length will now be set for every element you digitize
forward.

Digitize Walk Normal or Walk Bean Stitches
Exercise

Open Earthday.bmp from \Designs\Graphics folder.

1. Left click either the Walk normal or Walk bean stitch tool on
the Input toolbar. An alternative way is to click with the right
mouse button anywhere on the View Window (work area).

2. Digitize the following run stitch using input reference points to
mark the area of where the stitches will be placed (steps 1
through 5). The Status line will give input prompts to follow
throughout the process. (See the example on the next page)

• The left click on the mouse is used to insert a straight input
point. A triangle represents each straight point.

• The right mouse button is used to insert a curved input point. A
circle represents each curved point.

• Always start with the left click.

• If the shape is curved, in some cases you will need to alternate
between left click and right clicks.

• Notice the wireframe outlines that form on the screen while
digitizing.

• If you make a mistake or click too many points, simply press
your backspace key on your keyboard to delete the last input
point. Each time the backspace key is pressed, the input points
will be deleted in sequence.

3. When you are finished digitizing the shape, press the Enter key
on the keyboard.

4. Notice the stitches on the screen as well as the element created
in the Project View.
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Retrace
Exercise

1. Right click on the Walk normal (or Walk bean) stitch tool on the
Input toolbar.

2. The Walk Elements Properties box is displayed.

EDS IV xtreme User Guide 59

16603 Rev.A Melco Embroidery Systems



3. Check the Retrace button to turn it on.

4. Click on OK (or apply).

Note: The retrace will start from the last input point and retrace back
to the first input point.

Set Density For Columns
Exercise

Open Earthday.bmp from \Designs\Graphics folder.

1. Right click on the Column 1, Column 2 or any Singleline tool on
the Input toolbar.

2. The Column Element Properties box is displayed.

3. Change the Density to the desired amount or use the "Auto-
Density" checkbox.

4. Click on OK (or Apply).

EDS IV xtreme User Guide60

16603 Rev.A Melco Embroidery Systems



Note: The Density will now be set for every element you digitize
forward.

Auto Underlay
Exercise

1. Right click on Column 1, Column 2, or Singleline Center tools
on the Input toolbar.

2. The Column Element Properties box is displayed.

3. Click on down arrow to access Primary Underlay types.

4. Choose Edge Walk, Center Walk or Zigzag as an underlay type.

5. Click on OK (or apply).

Note: The underlay will now be set for every element digitized
forward.
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Digitize a Column Using Column 1 
Exercise

Open Earthday.bmp from \Designs\Graphics folder.

1. Left click the Column 1 tool on the Input toolbar. An
alternative way is to click with the right mouse button
anywhere on the View Window (work area).

2. The Satin stitch tool will automatically be activated on the Input
toolbar.

Note: Columns are usually digitized with satin stitches. However,
other stitch types are available: Zigzag, E stitch, or Fill.

3. Digitize the following column using input reference points to
mark the area where the stitches will be placed. These input
points must placed on alternate sides of the column. The Status
Line will give input prompts to follow throughout the process.
(Follow steps 1 through 10 in the example on the next page)

• The left click on the mouse is used to insert a straight input
point. A triangle represents each straight point.

• The right mouse button is used to insert a curved input point. A
circle represents each curved point.

• Always start with the left click. This is similar to digitizing with
mark points in that you must have even numbers of points on
alternate sides of the column.

• If the shape is curved, in some cases you will need to alternate
between left click and right clicks.

• Notice the wireframe outlines that form on the screen as you
digitize. If they cross, they will show an X and you will get a
bow tie effect of the stitching.

• If you make a mistake or click too many points, simply press the
backspace key on the keyboard to delete the last input point.
Each time the backspace key is pressed, the input points will be
deleted in sequence.
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4. When you are finished digitizing the column, press the Enter
key on the keyboard.

5. Notice the stitches on the screen as well as the element created
in the Project View.

Digitize a Column Using Column 2 
Exercise

Open Earthday.bmp from \Designs\Graphics folder.

1. Left click the Column 2 tool on the Input tool bar. An
alternative way is to click with your right mouse button
anywhere on the View Window (work area).

2. The Satin stitch tool will automatically be activated on the Input
toolbar.

Note: Columns are usually digitized with satin stitches. However,
other stitch types are available: Zigzag, E stitch, or a Fill.

3. Digitize the following column using input reference points to
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mark the area of where the stitches will be placed. The Status
Line will give input prompts to follow throughout the process.
(Follow steps 1 through 9 in the example below)

• The left click on the mouse is used to insert a straight input
point. A triangle represents each straight point.

• The right mouse button is used to insert a curved input point. A
circle represents each curved point.

• Always start with the left click. This is similar to digitizing with
mark points in that you digitize one side of the column (steps 1
through 5 in the example below), press the enter key and then
starting from the top, digitize the other side (steps 6 through 9
in the example below).

• If the shape is curved, in some cases you will need to alternate
between left click and right clicks.

• Notice the wireframe outlines that form on the screen as you
digitize.

• If you make a mistake or click too many points, simply press the
backspace key on the keyboard to delete the last input point.
Each time the backspace key is pressed, the input points will be
deleted in sequence.

4. When your are finished digitizing the column, press the Enter
key on the keyboard.

5. Notice the stitches on the screen as well as the element created
in the Project View.
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Digitize a Singleline 
Singleline is the same on EDS IV as EDS III except now you are
digitizing using wireframe techniques. This Input method is used for
columns with a consistent width. It is most often used for digitizing
boarders and outlines.

Exercise

Open Earthday.bmp from \Designs\Graphics folder.

1. Left click any of the Singleline center , left or right 
tools on the Input toolbar. An alternative way is to click with the
right mouse button anywhere on the View Window (work area).

2. The Satin stitch tool will automatically be activated on the Input
toolbar.

Note Columns are usually digitized with satin stitches. However, other
stitch types are available: Zigzag, E stitch, or a Fill.

3. Digitize the following column using input reference points to
mark the area of where the stitches will be placed. This is similar
to digitizing with mark points, if you choose Center, you will
need to digitizing down the center of the column (steps 1
through 5 in the example on the next page). The Status Line will
give input prompts to follow throughout the process.

• The left click on the mouse is used to insert a straight input
point. A triangle represents each straight point.

• The right mouse button is used to insert a curved input point. A
circle represents each curved point.

• You must always start with the left click.

• If the shape is curved, in some cases you will need to alternate
between left click and right clicks.

• Notice the wireframe outlines that form on the screen as you
digitize.

• If you make a mistake or click too many points, simply press the
backspace key on the keyboard to delete the last input point.
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Each time the backspace key is pressed, the input points will be
deleted in sequence.

4. When your are finished digitizing the column, press the Enter key
on the keyboard.

5. Enter the first width point of the column using the left mouse
button (step 6 in the example below).

6. Enter the second width point of the column using the left mouse
button again to give it the width (step 7 in the example below).
Digitize the column width points anywhere on your screen.

7. Notice the stitches on the screen as well as the element it created
in the Project View.
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Column Width Numerically
Exercise

To specify the exact width for any Singleline column:

1. Right click on any of the Singleline tools on the Input toolbar.

2. The Element Properties box is displayed

3. Click on the Singleline tab.

4. Define the exact column width in the space provided.

5. Click on OK (or apply).

6. Digitize the Singleline column.

7. When the status line prompts you to enter the column width,
press the enter key.
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Digitize Color Changes/Trims
Exercise

1. At any point while digitizing click on the Color Change tool

on the toolbar, or to insert a trim click on the Trim tool

.

2. Notice the Color change element or Trim element added to the
Project View list.

Choose Fill
Exercise

1. Right click on the Complex fill tool on the Input toolbar.

2. The Fill Element Properties box is displayed.
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3. Click on Load Partition Fill to get a drop down menu of the
available fills.

4. Select the desired Fill type.

5. Click on OK (or Apply).

Note: The Fill type will now be set for every element you digitize
forward.

Digitize a Complex Fill 
Exercise

Open Earthday.bmp from \Designs folder.

1. Left click the Complex fill tool on the Input toolbar. An
alternative way is to click with the right mouse button
anywhere on the View Window (work area).

2. The Fill stitch will automatically be activated.
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3. Digitize the following fill using input reference points to mark
the area where the stitches will be placed (steps 1 through 6 in
the example on the next page). The Status Line will give input
prompts to follow throughout the process.

• The left click on the mouse is used to insert a straight input
point. A triangle represents each straight point.

• The right mouse button is used to insert a curved input point. A
circle represents each curved point.

• You must always start with the left click.

• If the shape is curved, in some cases you will need to alternate
between left click and right clicks.

• Notice the wireframe outlines that form on the screen as you
digitize.

• If you make a mistake or click too many points, simply press the
backspace key on the keyboard to delete the last input point.
Each time the backspace key is pressed, the input points will be
deleted in sequence.

4. Press the Enter key on the keyboard when finished with the first
outline.

Note: After pressing Enter, the status line will prompt you through
the next steps to complete the Complex fill.

5. Digitize the second outline (hole) using left or right clicks (steps
7 through 13 in the example below).

6. Press Enter.

7. Digitize the third outline (hole) using left or right clicks (steps 14
through 21 in the example below).

8. Press Enter.

9. When all the outlines are complete, press Enter.

10. Digitize the Complex fill entry point using the left click (step 22
in the example below).
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11. Digitize the Complex fill exit point using the left click (step 23 in
the example below).

12. Digitize two points for the stitch direction using the left click
(step 24 & 25 in the example below).

13. Notice the stitches on the screen as well as the element it
created in the Project View.
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Column Stitches 
This exercise will demonstrate how to digitize a column 1 and a
column 2. When digitizing columns, you should always begin and
end your columns with straight points.

Digitize a column 1 using straight points

Insert a graphic (example, melco_tutor.tif from

C:\Designs\Graphics). Zoom in on the area that you would like
to digitize first. Keep in mind that the stitch list order is the same
order the the machine will perform the sew-out. Select the column 1

element .

1. Input your first point by left clicking in the View Window over
the graphic, which will input a straight point.

2. Now input the second point parallel to the first input point.

3. Input the third point on the same side of the column as your
first input point.

4. Input the forth point parallel to the third point. These steps are
illustrated below in red numbers. Now press the Enter key to
complete your wireframe column and generate stitches. This is
the simplest type of column.

When digitizing
something like a
capital "M", you
will want to plan
ahead on what
column goes first.
For example you
may want to
stitch out the V
area of the
capital "M"
before the
straight column
on the sides of
the capital "M".
By digitizing in
that order, the V
area columns will
lay under the
straight columns.
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The end result after stitching these two columns (and pressing the

"view stitches in 3D" button) will look like this:

Digitize a column 1 using curved and straight points
A simple example of this would be to digitize the letter "c".

1. Input your first straight point (by left clicking).

2. Input your second straight point parallel to the first (left click).

3. Input the third point half way around the "c" on the same side
of the column as your first input point, this point will be a
curved point that you input by right clicking.

4. Input another curved point (right click) on the opposite side of
the column, parallel to the third point.

5. Input the fifth point at the end of the "c" on the same side of
the column as the first and third. This will be a straight point
that you will input by left clicking.

6. Input the final point on the opposite side of the column,
parallel to the the fifth point. This will be another straight point
that you will get by left clicking. Press the Enter key when you
are finished. This example is illustrated on the next page with
the steps labeled with red numbers:
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The end result after pressing the "view stitches in 3D" button ,
looks like this:



Digitize a column 2 using curved and straight points

Select the column 2 element . A column 2 is digitized by
inputting the curved and straight points on one side of the column
first, then press the Enter key. Now input the curved and straight
points on the opposite side of the column. When finished, press the
Enter key to complete the column 2. In the same graphic that was
used for the above columns, there is a stem of a flower. It is a good
idea to think about the sewing order of things before beginning this
column.

In this example, you will probably want to sew the flower stem from
the bottom up so that you can go into the next element easier. Left
click to input straight points, right click to input curved points.

1 - straight

2 - curved

3 - straight

4 - curved

5 - straight

6 - straight

7 - straight

8 - curved

9 - straight

10 - straight

11 - curved

12 - straight

13 - curved

14 - straight

15 - straight

16 - curved

17 - straight
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To determine
proper sewing
order of
elements: When
digitizing, always
keep in mind
that you want
the embroidery
peripheral to be
able to sew from
one element to
another with
very little
movement in
between the
elements.

Remember that
straight input
points are
represented by a
small triangle
and curved input
points are
represented by a
small circle.
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The end result after pressing the "view stitches in 3D" button ,
looks like this:

Digitizing with a column 2 is especially useful in comparison to a
column 1 when you want to digitize a column that isn't parallel.

You can always
refer to the status
line below the
View Window to
give direction for
the next step
while digitizing
an element.
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Decorative Stitch 
Decorative stitch is used to repeat a digitized design along a walk
input line.

Decorative stitches can consist of walks, columns, fills, and lettering
or a combination of elements.

You can choose from several decorative stitches included with EDS IV
or create your own using "Create Decorative Stitch".

To use the standard decorative stitches

Left click on the decorative stitch tool on the Input toolbar.

Choose the stitch that you want to use, press OK.

Digitize the same as a normal walk stitch using straight and/or curved
input points.

Refer to the Walk Stitch Tutorial for more information on digitizing
Walk stitches.

Creating Decorative Stitches
To create a decorative stitch, go to the Custom Menu and select
"Create Decorative Stitch". A screen will pop up where you will
create your decorative stitch.

It is very useful to
load a graphic
into the EDS IV
View Window
before creating
decorative
stitches, so that
you have a
graphic to
digitize more
precisely.
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Zoom in if needed and turn on the grid to be more exact.

Select, the element (Manual or Walk stitch, a Column element, or
Complex Fill) that you would like to digitize with. Follow the basic
digitizing rules.

It is very important that you start and end your element on the
"Stitch Line." If you end somewhere above or below the line,
another stitch will be automatically generated for you to the stitch
line and you may not get the desired decorative stitch. It is also very
important to remember that you cannot begin and end your stitch in
the same place.

In the "Diamond" decorative stitch for example, the steps are labeled
below in red letters.
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Once you are finished creating your decorative stitch, you can name
it and save it. If saved, it will be added to the decorative stitch list
that you can choose from within the Walk Stitch property page.

Test Settings
• Walk Direction will give you a graphical example of how the

decorative stitch will look in different directions.

• Stitch Length will modify the decorative stitch proportionally.

• Width will change the horizontal width of the decorative stitch.

• Height will change the vertical height of the decorative stitch.

1. Start on the "Stitch
Line".

2- 5. Input points.

6. Input last point on the
"Stitch Line" and not on
the same point as the
first input point.

When creating
decorative
stitches, start and
stop on the
"Stitch Line". Do
not end in the
same place that
you began the
stitch. The actual
"Created Stitch
Length" is
determined by
the width
between the first
and last input
points. Where
your last input
point is, the next
stitch will begin.



Editing Decorative Stitches
To edit decorative stitches go to the Custom Menu, "Edit Decorative
Stitches". A pop-up dialog will appear and you can select the name
of the stitch and then press Edit.

To select the stitch by viewing an image of it press the "Stitch
View/Select" button. You will get a pop-up screen with an image of
all your decorative stitches along with the name of each and the date
and time created. Select the one that you would like to edit by
clicking on it and then press "OK".
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Press OK. You will now see the name of the fill that you just selected
in the "Edit Decorative Stitches" pop-up dialog. Press the Edit button.

While editing a decorative stitch, always keep in mind that the
Created Stitch Length is proportional size that you first saved.

Design Elements
An element is an EDS IV term that describes the smallest component
of a design that consists of multiple points. The design elements of
EDS IV are Manual Stitch, Walk Stitch (normal, bean, and decorative),
Column 1 and Column 2, Single line (center, left, and right), Complex
Fill, and Lettering.

To create new embroidery elements click on the toolbar button for
the element type that you want to create. There are several input
sequences that are used for the various elements. Use the left mouse
button to input straight points and the right mouse button for curve
points. Straight points appear as a small triangle; curve points appear
as a small circle. All elements start with a straight point and end with
either the Enter key or the middle mouse button, if available.

Manual and Walk elements are linear input methods that
you create by entering the points in sequence from beginning to end.
Manual stitches give you more control to digitize an exact outline.
Where you place the points is where your needle penetrations will be
without extra needle penetrations in between. This is very useful in
digitizing very small items where you need to be very exact. This is
located as a toolbar button, in the Insert Menu and also by right
clicking in the View Window. Walk stitches are the equivalent to
running stitches in EDS III and are typically generated in making
underlay and outline stitching. Walk stitches are the simplest stitches
to make when digitizing. They can be generated in two methods,
straight lines or automatic curves. For example, If you are digitizing
the outline of a square select walk stitch, then left click at the first
corner of the square. Now, go to the second corner and left click, the
third corner and left click, the forth corner and left click, back to the
first corner and left click. It doesn't matter how big the square is
when you are using walk stitch; needle penetrations will be inserted
every 30 points along the way. The default setting is 30 points and
can be changed under walk stitch properties. This is located as a
toolbar button, in the Insert Menu and also by right clicking in the
View Window.
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While you are
digitizing, you
can change your
current input
element to the
previous element
type by pressing
'P' on your
keyboard.
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Column 1 is used to generate parallel columns. The stitches are
generated back and forth between two outside lines that are parallel
(or nearly parallel) to each other. The simplest representation of a
shape that would lend itself to a column 1 stitching is the letter l. You
can find this function in three locations: the toolbar button, under
the Insert Menu, or by right clicking in the View Window. Column 2

is used more often to generate column stitches for non-parallel
columns. To obtain this, first digitize all of the outline stitches from
the beginning on one side of an element, then from the beginning
again on the other side of the element. You can find this function in
three locations: the toolbar button, under the Insert Menu, or by
right clicking in the View Window.

Singleline is a method of producing columns that maintain an equal
width throughout the column. Single line center, single line left, and
single line right are the three different types of single line input. The
difference between these three types is just the positioning of the
stitch area surrounding the line that you create. You can find each of
these three functions in three locations: the toolbar button, under the
Insert Menu, or by right clicking in the View Window.

When creating a Single line center column you will first digitize
the basic wireframe outline of the design. Then following the
instructions located in the grey area below the View Window (the
status line), input the first and second width points. The distance
between these two points will determine the width of your column
with your wireframe line in the center. This is the same procedure

used to input a Single line left and a Single line right .

Single line automatically terminates after inputting the width of the
second point.

Complex fill is the tool on the left with the red outline. To
digitize a complex fill, select the complex fill tool by left clicking on it,
or by right clicking inside the view window and selecting complex fill.
Now input the wireframe outline of the complex fill. By inputting
straight or curved points. The last point input should end up being
close to the first point that you input, then press Enter or Return. This
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will connect the last point with the first point. Next, if there are any
small holes or places that you do not want the fill to cover, digitize a
wireframe outline around those just as you did the first outline and
press Enter after each one. After you have finished digitizing the
complex fill and any holes, press Enter again.

Now enter the entry point and exit points (where you would like the
first and last needle penetrations to be). The final thing to do is to
enter two points that will determine the direction of stitches.

If you have finished a complex fill and decide later that it should
contain some empty spaces (holes), you can insert them without
having to digitize the fill again. The toolbar button next to the
complex fill button (with the black outline and the filled in hole) is the
complex hole button. Select your design by right clicking on it, then
select the complex hole tool. Now digitize the wireframe outline of
the hole and press Enter.

Complex fill automatically terminates after the second direction point
is put in.

You can get to complex fill and hole with the tools on the toolbar,
through the Insert Menu, or by right clicking in the View Window.

If a point is entered incorrectly, pressing the Backspace key will
remove the input points in reverse order.

Complex Fill and Complex Hole
This exercise will demonstrate how to digitize a complex fill and then
insert a hole. When digitizing complex fills, you should always begin
and end your wireframe outline with straight points.

Digitize a complex fill

Insert a graphic (example, melco_tutor.tif from

C:\Designs\Graphics). Zoom in on the area that you would like
to digitize first. Keep in mind that the stitch list order is the same
order the machine will perform during the sew-out. Select the

complex fill element. Below is an example of a complex fill with
the steps labeled with red numbers.



1. Input your 1st point by left clicking in the View Window over
the graphic. This will input a straight point.

2. The 2nd point for this example is a curved point which you
input by right clicking.

After inputting the last point of the complex fill, press the Enter key.

Now, if you have any holes to input in the complex fill you can
digitize the wireframe outline of these the same way that you
digitized the wireframe outline of the complex fill. If you don't have
any holes to digitize, press the Enter key again.

14. Input the complex fill entry point with a left click. The entry
point is where you would like the stitches to begin on the
complex fill.

15. Input the complex fill exit point with a left click. The exit point is
where you would like the stitches to tie off and end the
complex fill.

3. straight

4. curved

5. straight

6. curved

7. straight

8. straight

9. curved

10. straight

11. straight

12. straight

13. curved

EDS IV xtreme User Guide

16603 Rev.A Melco Embroidery Systems

84



16. Input the first direction point with a left click.

17. Input the second direction point with a left click. The direction of
the line between the two direction points determines the
direction of the fill stitches on the complex fill just digitized. The
stitches will now be generated on the complex fill. The direction
points can be anywhere in the View Window (inside or outside of
the complex fill).

The end result after pressing the "view stitches in 3D" button ,
looks like this.

Digitize a complex hole after completing the
complex fill

After completing the complex fill on the rose pedal, you may decide
you would like to put a shadow of a slightly darker color using stitches
going in a different direction. You wouldn't want to put another fill on
top of the existing one because you will have too many stitches on top
of each other, therefore you want to insert a hole.

You can also use holes on areas that are supposed to be blank or not
filled in with stitches.

1. Select the complex fill by left clicking inside of it, if it is not
already selected. You can tell an element is selected if it has a
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box around it and the wireframe points are shown. When an
element is selected you can edit it.

2. Select the complex hole tool .

3. Digitize the outline of the hole that you want to create. Use the
left mouse click for straight points and right mouse click for
curved points.

4. When finished with the outline, press the Enter key.

The end result of
the above complex
fill with a hole
inserted looks like
this:
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You can always
refer to the status
line below the
View Window to
give direction for
the next step
while digitizing
an element.
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On the example of the rose
pedal, a color change was
inserted and a column fill
was then stitched over the
hole and the end result of
that looks like this:
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Group Names
Group Names is a new feature available in EDS IV. This feature is
most commonly used to individualize uniforms for members of sports
teams or corporate uniforms. The Group Names can be stored in a
variety of different ways.

To Create Group Names
1. Open a new screen in EDS IV.

2. Click on the Tools drop down menu.

3. Select "Create Group Names".

4. "Group Names" is displayed in the layout screen.

Note: The Group Names will pick up the properties from the current
settings in the Lettering Parameters.

5. Double click on the "Group Names" lettering.

6. The lettering Properties dialog box is displayed with "Group
Names" text.
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7. Choose the desired text values for the Group Names (example:
Alphabet style, letter height, Column width, etc).

8. Click on the Group Names Tab.

9. The Group Names Tab is displayed.
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10. To Add Names (use one of the following methods):

Add: Click on the Add Button. This will make a small edit window
available to immediately type each name. You can type a list of
names, separated by commas into that window. (Example; John
Jones, Greg Smith, Paul Johnson) Click on the Add button again to
insert the names into the Available Names list.

Paste: Click on the Paste Button. The names will be inserted in the
Available Names list.

Note: Prior to doing this, the names must first be pasted to the
clipboard from another application. When using another application,
a carriage return is the same as typing a comma in the Add section.

Import: Click on the Import Button. The Open Dialog box is
displayed to choose the directory and text files to insert. Click on the
file and the names will be inserted in the Available Names list.

Note: Prior to doing this, the files need to be saved as a *.txt file
from another application (for example NotePad). When using another
application, a carriage return is the same as typing a comma in the
Add section.
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Clear: If clear is clicked, all the names from both Available and
Selected areas will be emptied.

11. Once all the names have been added to the list:

• Click the All button (>>) to move all the names to the Selected
Names box.

• Or, click on the specific name then click the (>) to send the
names one at a time.

12. Choose First, Last or Both.

• The names displayed in the Selected Name list are the names that
will sew.

• Even if only using the first name, always store the first and last
name for added flexibility at a later time.

• To modify the Selected Name list, click on the (<<) button to
empty the list of Selected Names. Or select a specific name and
click the (<) button delete it from the list.

• If "Copy to Clipboard" is clicked, the names in the Selected
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Name list will go to the Clipboard to be used in another
application.

13. Select a "Condensed and Expanded Save As Option" (see
explanations below). When saving just lettering, it does not
matter which Option is selected.

Condensed and Expanded Save As Options:
Design, Name, Design, Name...

When saved in this format, the design and Group names are saved
together. The embroidery machine will sew the Design, the first
named typed, the design, the next name and so on.

Design, Name, Name...

When saved in this format the machine will sew the Design once and
the each name saved. This format is usually used for multi-head
machines when the same design is sewn on all the heads and then
each name sewn on each garment.

Name, Name...

When saved in this format, the design will not be saved with the
Group Names. This usually means the design is already sewn on the
garment, then you decide you want group names added. This is
typically used for a single head machine.

Design Only

When saved in this format, the design sews where you place it in
relation to the names for a later time. This is typically used for a
multi-head machine.

File for each Selected Name

When saved in this format, each name will be saved as a separate
design. The first two characters of multiple group name files are
numeric, i.e. 01Bill.exp 02Mary.exp, etc. These files can be used at a
later date.

Note: After the design has been saved in Condensed or Expanded
format, a color change command will be inserted after each Group
Name.
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14. Click on OK or Apply (The names will not be shown on the
screen until the lettering is saved).

15. Click on File and Save As.

16. Type the filename and desired directory to save in.

17. Select condensed or expanded (the file must be saved as
condensed or expanded format before it can be stitched.)

18. Click on OK.

Note: The last name displayed in the Selected Name list will display in
the layout screen.

19. Click on File and Close the design.

20. Re-Open the design in EDS IV.

21. The Design will open with the names on top of each other with
color changes added.

22. Send the file to the machine.

23. When programming the design to sew, use a P as Color 1 (in
the machine Color menu) to force the machine to stop after
sewing each name. This will enable you to insert the next hoop
and press start to sew the next name. (Melco embroidery
machines only)

To add names to an existing design
1. Open any design or create the design to stitch the names with.

2. Click on the Tools drop down menu.

3. Select "Create Group Names".

4. "Group Names" is displayed in the layout screen.

Note: The Group Names will pick up the properties from the current
settings in Lettering Parameters.
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5. Left click and drag the eight handled box (Group Names) to the
correct position on the layout screen.

6. Double click on the "Group Names" lettering.

7. The Lettering Properties dialog box is displayed with "Group
Names" text.



Follow steps 8 -23 in the Create Group names to complete.
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Image Modification
In this exercise you will find the different ways to manipulate an
image or graphic file. When a graphic file is loaded, a clipboard is
imported, or an image is scanned into the EDS IV View Window, you
may manipulate it in several areas. You have the options of
Hide/Show a graphic and Dim/Brighten a graphic under the View
Menu. You also have the option to change the position, orientation,
and the scale of the graphic or image. These options are all available
to you by double clicking on the graphic itself or by double clicking
on the graphic in the tree view. You can also Hide/Show a graphic by

pressing the toolbar button.

When you double click on the graphic or image a Properties dialogue
with three tabs will appear.

Under the Graphic General Properties tab you can view the name of
the graphic and it's location. Besides the View Menu, you can also
see on the General Properties tab gives you the ability to Hide/Show
and Dim/Brighten the graphic. You can hide the graphic by putting a
check mark beside Hide with your left mouse button. If the graphic is
already hidden and a check mark appears beside Hide, then click
again on Hide to Show the graphic. You may want to hide the
graphic when you are digitizing. This will allow you to view the
progress of your work better without the graphic behind the stitches.
If you would like to see your stitches a little bit better, but not
completely hide your graphic, you can left click to place a check
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beside Dim. Left click again to Brighten the graphic. Practice
Hide/Show and Dim/Brighten.

Click on the Position tab. Here you can change the position and
orientation of the graphic.

Position represents the number of embroidery points (1/254th of an
inch) that the center of the image is offset from the center of the
design (or View Window). This allows you to move your image with
respect to the design.

X offset allows you to move the image left or right. Enter positive
values to move right. Enter negative values to move left.

Y offset allows you to move the image up or down. Enter positive
values to move up. Enter negative values to move down.

Orientation gives you the ability to manipulate the horizontal and
vertical presentation of the image. This function presents combinations
of axis mirroring and axis property swapping in such a way to present
the 8 views shown in the orientation box as you click on the box.

The F in the orientation box represents the position the image on the
screen is currently being presented.

The image modification attributes are only saved when you save them
as a project.

Practice changing the position and orientation of the graphic to view
how it changes.
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When EDS IV
displays a design
or image at
actual size, it is
displaying the
information at
one embroidery
point per pixel, or
1 pixel per
1/254th of an
inch. To display
an image at
actual size, you
should scan the
image at 254
pixels per inch or
calculate the
scale according
to the following
formula:

scale = 254/ dpi
where dpi is the
dots per inch of
the image.

as an example: a
100 dpi image
would have a
scale of 2.54
(254/100) if you
wanted to display
the image at the
original size for
digitizing.

The third tab in the Graphic Properties is for scaling the graphic or
image. The scale can be proportional or non-proportional depending
on whether or not you have checked the "Proportional" box. If you
left click, which places a check mark in the box, the horizontal scale
is exactly the same as the vertical scale. This will keep the image from
being distorted. If the "Proportional" box is not checked, then you
can scale just the Horizontal axis or the Vertical axis. You can enter a
percentage or a measurement. These are linked, so if you change a
percentage the measurement changes proportionally.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "Okay" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "Okay", your changes will be applied
and the property dialogues will close and you will be back at the
View Window. You can also click "Cancel" and the property
dialogues will close without implementing the last change.
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Loading and Scanning Images
With EDS IV, you have the ability to perform on-screen digitizing.
Before you can do that you may want to have an image on the
monitor screen. This can be done by scanning a new design or loading
an existing graphic image file.

Loading

You can load an existing graphic image with the Insert function
under the File Menu or click on the insert toolbar button .

The other option is to scan an image directly into EDS IV. You can load
and save bitmaps in the following formats:

After selecting "Insert", you may browse the directories to find the
desired graphic file.

Scanning
The scanning function allows you to scan a design directly into the
monitor screen for on-screen digitizing. This function works with any
scanner which complies with the “TWAIN” scanning industry standard
communications format. You may buy any TWAIN compatible scanner
to implement scanning in EDS IV.

Note 1: TWAIN 32 compatible scanners are not the same as TWAIN
compatible scanners and can not be implemented from the EDS IV
program.

Note 2: Be advised that Melco cannot and does not support any
scanners in the market place. Any technical assistance that may be
required with the scanner you purchase must be obtained through the
scanner dealer.

Format
Acronym

Format Description Extension

BMP Windows (and OS/2) Bitmap .bmp
JPEG Industry Standard Compressed Image

Format
.jpg

PCX PC Paintbrush Format (ZSOFT) .pcx

TIFF Tagged Information File Format .tif
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If you attempt to use a scanner which does not comply with TWAIN,
you will not be able to access the scanning program directly from the
EDS IV program. You must go into the scanning program
independent from EDS IV to perform the scanning operation. Then
you will be able to “load” any properly saved graphic files that have
been scanned with that scanner.

The only requirement for loading a graphic file is that the file format
is one of the formats supported by EDS IV. The graphic load and save
functions support most industry standard graphic formats. See the
above section on loading for information on which formats are
supported.

An additional feature in the On-Screen Digitizing and Scanning
option allows you to import graphical data from the clipboard to the
EDS IV Layout window. This feature allows you to import graphics
from any Windows based application.

Once loaded into the Layout window, images can be scaled, rotated,
dimmed, and zoomed to give you the maximum flexibility in
displaying your image for digitizing a design on screen.

Select Scanner
This function need only be performed when you start the scanning
process for the first time. You will not need to return to this function
unless you add a scanner or want to change to a different scanner
that already exists with the system. The last scanner you select in this
function will remain the “default” scanner indefinitely.

1. If you have just opened EDS IV, click on File in the menu bar
and then click on New in the drop down menu. If already in a
View Window go to step 2 to start a graphic load.

2. In the new View Window click on the File Menu then click on
Select Scanner.

The Select Source dialog box will appear showing the available
TWAIN compatible scanners associated with your system.

If your scanner does not appear in the Sources list, refer to the
following discussion:

• For the Select Scanner function to identify the available TWAIN
compatible scanners attached to the computer system, the
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TWAIN software which came with your scanner must first be
properly installed and configured for your system.

• Melco has found that a common mistake is the failure to add the
path for your scanner to the autoexec.bat file.

• Refer to your scanner manual and the Microsoft Windows user’s
Guide for information on modifying the autoexec.bat file.

3. Click on the source you wish to scan with to highlight the
desired source.

4. Click on the Select button to choose the scanner and return to
the current EDS III Layout window.

Each time you open EDS IV and perform the Scan function from this
point forward, the scanner you just selected will remain the selected
scanner. The scanner you select will remain the “default” scanner
until you go into the Select Scanner function and select a different
scanner.

Scan
EDS IV does not directly interface with any scanner. When you select
Scan you are telling EDS IV to load the selected scanner’s software to
perform the scan and return the image to EDS IV. As a result, the
screen that you see when you select Scan will depend on the
software that came with your scanner. When the TWAIN driver you
selected is finished, it will return the image to EDS IV for display. At
that point you can change the scale or orientation, etc.

• In the View Window click on the File Menu then click on Scan
image.

The selected scanner manufacturer’s operating software will appear
on the screen and the scanning operation will begin. You will be able
to work inside the scanner operating software just as if you had
opened it independent of the EDS IV program.

Tips for Successful Scanning
1. High resolutions (such as 300 dpi) will consume lots of memory,

and may slow down your system.



2. Color images may significantly slow your system and make it
harder to see your stitches, even with Dull Graphic.

3. If you use color, use no higher color resolution than the driver
you have installed in Windows. If your Windows uses 256
colors, then scanning a graphic as a 24 bit graphic makes it
larger than it needs to be! Check your scanner manual for
instructions to select your color resolution.

After the scanning operation is completed and you close the scanner
manufacturer’s software program, the screen returns to the active
EDS IV program and you may begin to perform some of the available
image modifications or go directly to digitizing in the View Window.

Pattern Fill
Pattern Fill is a custom stitch type used in digitizing complex fills. It is
used for large areas to obtain artistic effects in designs.

The fill stitching in a pattern fill is a satin stitch with needle
penetrations forming the chosen pattern.

You can choose from several of the standard pattern fills included
with EDS IV or create your own using "Create Pattern Fill".

To use the standard pattern fills

Right click on the complex fill element on the Input toolbar.

Under Stitch Type, choose Pattern.

Select the Pattern from the drop down menu.

Click OK.

Digitize the outline of the shape using the complex fill digitizing rules.

Refer to the Complex Fill Tutorial for more information on digitizing
complex fills.

Creating Pattern Fills
To create a pattern fill, go to the Custom Menu and select "Create
Pattern Fill". A screen will pop up where you will create your pattern
fill. A screen will pop-up to allow you to create the pattern fill.
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Zoom in if needed and turn on the grid to be more exact.

Select, the element that you would like to digitize with (walk or
manual stitch). Follow the basic digitizing rules.
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In the "small diamond" pattern fill for example, the steps are labeled
below in red letters.

Once you are finished creating your pattern fill, you can name it and
save it. If saved, it will be added to the pattern fill list that you can
choose from within the Fill property page.

Test Settings
• Width will change the horizontal width of the pattern fill.

• Height will change the vertical height of the pattern fill.

• Remember that when changing test settings you can always refer
back to the created width and height to see the first saved
settings.

After selecting walk stitch
digitize a diamond shape using
straight input points (left
clicking). Steps 1-4. Press the
Enter Key.

Digitize another diamond shape
with the walk element, inputting
straight points. Steps 5-8. Press
the Enter Key.
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Editing Pattern Fills
To edit pattern fills go to the Custom Menu, "Edit Pattern Fills", a
pop up dialog will appear and you can select the name of the fill and
press Edit.

To select the Fill by viewing it, press the "Pattern View/Select" button
and you will get the following dialog.

Press OK. You will now see the name of the fill that you just selected
in the "Edit Pattern Fill" pop-up dialog. Press the Edit button.



Singleline Columns
This exercise will demonstrate how to digitize singleline columns. When
digitizing columns, you should always begin and end your columns
with straight points.

Digitize singleline columns using straight points

Zoom in on the area that you would like to digitize first. Keep in
mind that the stitch list order is the same order that the machine will

perform the sew-out. Select a singleline element .

1. Input your first point by left clicking in the View Window, which
will input a straight point.

2. Input a second straight point (left click). Press the Enter key to
complete the singleline.

3. Now you have to determine the width of the column that you are
digitizing. Left click to enter the first width point.

4. Move your cursor from the first point to the desired width and
left click again to insert the second width point. An example of
this is illustrated below with the steps labeled with red numbers.

For this example, it didn't matter where the width points were placed,
but if you are digitizing over a graphic (and need to be precise) you
may want to place your width points over the graphic.
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Digitize singleline columns using curved and
straight points:

An example of this would be to digitize a circle.

1. Input your first point by left clicking in the View Window, which
will input a straight point.

2. Input a curved point 1/4 of the way around the circle by right
clicking.

3. Input a straight point 1/2 of the way around the circle by left
clicking.

4. Input a curved point 3/4 of the way around the circle with a right
click.

5. Input the final point a little bit passed the first point to insure that
the stitches meet up when sewn out. The final point should be a
straight point that you get by left clicking. When the wireframe
outline is completed press the Enter key.

6. Now enter the first width point by left clicking.

7. Determine the desired width and place your cursor that distance
from the first width point and left click to enter another width
point. This example is illustrated below with the steps labeled
with red numbers.

You can always
refer to the status
line below the
View Window to
give direction for
the next step
while digitizing
an element.
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To select all
elements in a
design quickly,
press Ctrl 'A'.
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Transform/Rotate
Once you have selected an element by clicking on it and getting a
black box with handles around it, you can do the following:

To resize or edit, place your cursor over the black boxes until a double
arrow cursor appears. This type of cursor lets you know which way
you can move. Move the handles by clicking and dragging them in
the direction that you would like to go. You can manipulate elements
to make them wider, thinner, taller, shorter, or a combination or
these. Also refer to Edit mode in the reference section of this manual.

If you right click on the selected element, you should get a menu of
options. Toward the bottom of the menu, you will see
Transform/Rotate, click on that. You will now have a box around your
element that looks like this:

To rotate the element: you will use the green arrow that comes from
the middle of the element. You can click and drag the center green
box to have the center of rotation anywhere that you would like.
Once you have determined the center of rotation, click and drag the
green arrow in the direction that you would like your element to
rotate.

To transform the element: click and drag the triangles in the corners
of the black box. You can drag them in any direction to transform the
element. You may also use multiple select, click on one of the
triangles, hold down the Control Key, click another triangle. Once
you have selected the desired triangles, let go of the Control Key.
Now click and drag just one of the triangles in the desired direction.
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To transform a lettering job, enter one or more curved or straight
points on the black selection box. Left click and drag on a single
point. To "balloon" a lettering job, enter a curved point on the top
and bottom of the black selection box at the points where you desire
ballooning to occur. Hold down the Shift Key, right click and drag.
Also refer to the Upgrade Tutorial for Lettering on common
transformations.

When you are manipulating an element, all of the stitch information
will be automatically filled in to fit the new shape of the element.



Walk and Manual Stitches
Walk stitches can be digitized with straight and curved points. Straight
points are input using a left mouse click. Curved points are input using
a right mouse click.

Digitize a walk stitch using curved and straight
points

Insert a graphic (example, melco_tutor.tif). Zoom in on the
area that you would like to digitize first. Keep in mind that the stitch
list order is the same order the the machine will perform the sew-out.
Select the walk stitch element .

This exercise goes through digitizing an outline around the letter "e".
This exercise will take two steps.

1. First, digitize the outline inside of the letter "e". The first input point
is a straight point (left click) on the bottom left side of the outline.

2. Now input a straight point on the right side on the bottom.

3. Input a curved point (right click) on the top of the curve.

4. Input the final point in the same place as the first point. Press the
Enter key to complete the outline.

The outline is illustrated below with the steps labeled in red.
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Now digitize the outline around the outside of the letter "e".

The end result after
pressing the "view
stitches in 3D" button ,
looks like this:

1 - straight

2 - curved

3 - straight

4 - straight

5 - curved

6 - straight

7 - curved

8 - straight

9 - straight



Digitize a manual stitch
You can only use straight points for digitizing a manual stitch. This
type of element is usually used for items where you want to be able
to determine where your needle penetrations are. Maybe you would
like to have the look of a long stitch without changing the stitch
length on you walk stitch. An example of when to use a manual
stitch element would be when digitizing grass. When representing
blades of grass with thread, you may not necessarily want needle
penetrations throughout the blades of grass.

1. Left click to input first needle point (penetration).

2. Left click again to input second needle point. Press the Enter key
to end the manual stitch element.

Another use for manual stitch is to aid in manual trimming for
peripherals that do not have trimmers.

Here is an example of
manual vs walk stitch after
zooming in and pressing the
"view stitches in 3D" button:

When using walk stitch,
needle penetrations are
automatically input in
between the wireframe
points; whereas, manual
stitch has a long stitch from
one wireframe point to the
next.
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Design Database
The EDS IV Design Database application allows embroidery shops and
digitizing houses the ability to enter Design-Customer information into
a database. 

It allows you to categorize Designs through subjects, enter and save
customer information and link it to a Design to form an order and to
find any document by any search conditions. 

For further information about the Design Database, please refer to the
Help System once you have opened the Design Database.

Icon Generator
During installation a shortcut to the Icon Generator is added to the
Windows Desktop. Double clicking on this shortcut will launch a small
dialog application that uses, but is independent of, EDS IV. Icon
Generator is separate from EDS IV because it may require a long time
for it to complete its work. We did not want to keep you from using
EDS IV during the time required to generate icons and update design
properties for your designs.

What is Icon Generator?
EDS IV includes a Windows 'shell extension' that displays icons for
embroidery files in Explorer, Find Files, and File Open, Save, and SaveAs
dialogs within EDS IV. EDS III provided a similar but less widely available
capability within its graphical file open. The icon files with extensions
such as .cpf, and .epf, which we call shadow files, that were produced
by EDS III will continue to be used by EDS IV when available. For
designs that were not produced by EDS III, for example those
purchased as a library, these shadow files must be generated.

Icon Generator scans your hard disk(s) searching for embroidery files. It
keeps counts of expanded, condensed, and project (OFM) files that
need to have their icons and design properties generated or brought
up to date. This only needs to be done when you first install EDS IV
and whenever you copy embroidery designs from diskettes or CD-ROM
libraries of designs. EDS IV will function correctly without running Icon
Generator but its integration with Windows will not be as tight from a
visual perspective because the icons for some files may not be correctly
displayed. It will be more difficult for you to locate the embroidery file
you wish to open until Icon Generator has done its work.
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What if I have designs on multiple drives or network connections?

You can easily create multiple Icon Generator shortcuts on your
desktop, each with a different Target path root. Alternatively you
might choose to respecify the Target path root within the shortcut
whenever you wish to launch the Icon Generator. To set or change
the Target path root on a shortcut to Icon Generator simply right-
button click on the shortcut, select Properties from the context menu,
and on the Shortcut Tab note that Target is selected. Target is an edit
field that is of the form path\EdsShadow.exe TargetPath. The Target
Path in a normal install should be C:\Designs and can be changed to
any other path or network share. Normally this will not be needed if
you have organized your system so that all designs are either in
C:\Designs or in sub-directories below that directory, e.g.
C:\Designs\Birds or C:\Designs\JonesConstruction, because Icon
Generator knows how to find designs in all sub-directories of the
Target root.

What will happen when I run Icon Generator?
The visual behavior will be different depending on whether EDS IV is
running when you double-click on the Icon Generator shortcut. If it is
running, Icon Generator will find it and use EDS IV. If it is not
running, Icon Generator will invisibly launch EDS IV and run it in the
background. Note that if EDS IV is not installed on the same
computer from which Icon Generator is run you will not be able to
generate/update icons. The Icon Generator itself is a short, wide
dialog that contains, initially, the EDS IV icon to the left of counts of
files to update. Beneath that icon the Target root path will initially be
displayed, and below that a progress indicator. Begin and Cancel
buttons on the right are the only controls you will use to control Icon
Generator. When you click Begin, the button will be relabeled Pause
and Icon Generator will begin searching for embroidery files in the
Target path root and continue through all sub-directories. You can
click Pause at any time; the button will be relabeled Resume and Icon
Generator will discontinue its work until you click that button. Cancel
allows you to dismiss Icon Generator completely.

What happens if I cancel Icon Generator?
If you cancel Icon Generator before it has completed its work then it
will pick up where it left off when you run it again. Alternatively, you
can click the Pause button if you need to work in EDS IV without the
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distraction of files being opened in your workspace, and then click
Resume should you take a coffee break or go to lunch. There is
almost no system resource cost to leaving Icon Generator launched
but Paused so you can use it to generate and update icons at your
convenience.

How long will Icon Generator run?
This all depends on the number of embroidery files that require icon
generation/update. If all of your embroidery files were generated by
EDS III it may take only a few seconds. If you have placed the entire
Dakota Designs library on your hard disk and you have a slow
computer it can require more than a day to complete its work.
Progress will be indicated by the progress indicator and reduced
counts of files but you should be aware that some files can take
considerably longer than others to process.

What can go wrong ...
Two things can cause Icon Generator to fail. First, if it encounters
non-embroidery files with extensions of EXP, CND, or OFM, a variety
of failures can occur. The offending file can be read from the line that
initially contained the Target root path so you can readily identify the
source of the failure. In addition, a very small number of embroidery
design errors cannot be correctly diagnosed in condensed files. This
occurs fewer than three times in a thousand files among the more
than fifteen thousand files used to test Icon Generator and EDS IV.
Should you experience such a failure, note the name of the offending
file and either remove it or rename it with a different file extension
and restart Icon Generator.

Custom Menu

Decorative Stitch 
Decorative stitch is used to repeat a digitized design along a walk
input line.

Decorative stitches can consist of walks, columns, fills, and lettering
or a combination of elements.

You can choose from several decorative stitches included with EDS IV
or create your own using "Create Decorative Stitch".



To use the standard decorative stitches

Left click on the decorative stitch tool on the Input toolbar.

Choose the stitch that you want to use, press OK.

Digitize the same as a normal walk stitch using straight and/or curved
input points.

Creating Decorative Stitches
To create a decorative stitch, go to the Custom Menu and select
"Create Decorative Stitch". A screen will pop up where you will create
your decorative stitch.

Zoom in if needed and turn on the grid to be more exact.

Select, the element (Manual or Walk stitch, a Column element, or
Complex Fill) that you would like to digitize with. Follow the basic
digitizing rules.

It is very important that you start and end your element on the "Stitch
Line." If you end somewhere above or below the line, another stitch
will be automatically generated for you to the stitch line and you may
not get the desired decorative stitch. It is also very important to
remember that you cannot begin and end your stitch in the same place.
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It is very useful to
load a graphic
into the EDS IV
View Window
before beginning
this procedure, so
that you have a
graphic to
digitize more
precisely.
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In the "Diamond" decorative stitch for example, the steps are labeled
below in red letters.

Once you are finished creating your decorative stitch, you can name
it and save it. If saved, it will be added to the decorative stitch list
that you can choose from within the Walk Stitch property page.

Test Settings
• Walk Direction will give you a graphical example of how the

decorative stitch will look in different directions.

• Stitch Length will modify the decorative stitch proportionally.

• Width will change the horizontal width of the decorative stitch.

• Height will change the vertical height of the decorative stitch.

1. Start on the "Stitch
Line".

2- 5.  Input points.

6. Input last point on
the "Stitch Line" and
not on the same
point as the first input
point.

When creating
decorative
stitches, start and
stop on the
"Stitch Line". Do
not end in the
same place that
you began the
stitch. The actual
"Created Stitch
Length" is
determined by
the width
between the first
and last input
points. Where
your last input
point is, the next
stitch will begin.
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Editing Decorative Stitches
To edit decorative stitches go to the Custom Menu, "Edit Decorative
Stitches". A pop-up dialog will appear and you can select the name
of the stitch and then press Edit.

To select the stitch by viewing an image of it press the "Stitch
View/Select" button. You will get a pop-up screen with an image of
all your decorative stitches along with the name of each and the date
and time created. Select the one that you would like to edit by
clicking on it and then press "OK".
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Press OK. You will now see the name of the fill that you just selected
in the "Edit Decorative Stitches" pop-up dialog. Press the Edit button.

While editing a decorative stitch, always keep in mind that the
Created Stitch Length is proportional size that you first saved.

Pattern Fill
Pattern Fill is a custom stitch type used in digitizing complex fills. It is
used for large areas to obtain artistic effects in designs.

The fill stitching in a pattern fill is a satin stitch with needle
penetrations forming the chosen pattern.

You can choose from several of the standard pattern fills included
with EDS IV or create your own using "Create Pattern Fill".

To use the standard pattern fills

• Right click on the complex fill element on the Input toolbar.

• Under Stitch Type, choose Pattern.

• Select the Pattern from the drop down menu.

• Click OK.

• Digitize the outline of the shape using the complex fill digitizing
rules.

Creating Pattern Fills
To create a pattern fill, go to the Custom Menu and select "Create
Pattern Fill". A screen will pop up where you will create your pattern
fill. A screen will pop-up to allow you to create the pattern fill.



Zoom in if needed and turn on the grid to be more exact.

Select, the element that you would like to digitize with (walk or
manual stitch). Follow the basic digitizing rules.

In the "small diamond" pattern fill for example, the steps are labeled
on the next page in red letters.
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Once you are finished creating your pattern fill, you can name it and
save it. If saved, it will be added to the pattern fill list that you can
choose from within the Fill property page.

Test Settings
• Width will change the horizontal width of the pattern fill.

• Height will change the vertical height of the pattern fill.

• Remember that when changing test settings you can always refer
back to the created width and height to see the first saved settings.

Editing Pattern Fills
To edit pattern fills go to the Custom Menu, "Edit Pattern Fills", a pop
up dialog will appear and you can select the name of the fill and press
Edit.

After selecting walk stitch
digitize a diamond shape
using straight input points
(left clicking). Steps 1-4. Press
the Enter Key.

Digitize another diamond
shape with the walk element,
inputting straight points.
Steps 5-8. Press the Enter Key.
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To select the Fill by viewing it, press the "Pattern View/Select" button
and you will get the following dialog.

Press OK. You will now see the name of the fill that you just selected
in the "Edit Pattern Fill" pop-up dialog. Press the Edit button.

Insert Custom File
This applies to users that have previously installed EDS IV, created
decorative stitches and/or patternfills and are now re-installing EDS IV. 

A new menu item has been added under the Custom Menu. This
new menu item is Insert Custom File. Open Windows Explorer by
right clicking on your Start Menu, browse to your EDS IV directory. In
your EDS IV directory you will have a CustomFactory.cff file that
contains any decorative stitches and pattern fills that you have
created. To keep these decorative stitches, you will need to copy the
CustomFactory.cff file and paste it into another directory other than
EDS IV (Temp directory for example). Now re-install EDS IV. The new
install will overwrite the existing CustomFacotory.cff file. After the
install is complete, open EDS IV. Click on File Menu, New. Click
Custom Menu, Insert Custom File. Browse to the location that you
previously pasted the .cff file into (Temp directory). Once you have
selected it, click Open. This will merge the two .cff files. 
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Editing Tools

Alignment Tools
There are two ways to align you elements within your project.  You
can use "Snap to Grid", which will align element(s) or design(s) in
comparison with the Grid or the "Alignment Tools", which will align
elements or designs in comparison with each other.

Snap to Grid

After pressing the Grid button , you can press the "Alignment

Tools" button to quickly move a design or element to an exact
location around the grid. You can have one or more elements or
design selected when using this feature.

After pressing the "Snap to Grid" button you will see the following
dialogue:

For help on using this dialogue, follow the steps below:

Select the axis you would like to move along (horizontal or vertical or
perhaps both).

Determine the value (in inches) of how far you want to move (keep
at 0.00 if you want to be directly centered, on top or below the axis).
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Click on one of the radio buttons next to "Center on", "Top of", or
"Bottom of".

Click Apply or OK.

Below is an example of a centered design with the following
attributes:

Horizontal, 0.00 in., Top of

Vertical, 0.00 in., Right of

If you have previously used EDS III, the "snap to grid" function works
the same as "Line Type Options". The Line type options were "Line
Center Middle", "Line Center Bottom", "Line Normal", and "Arc
Normal". There isn't an equivalent in EDS IV to "Arc From Center".
Below are examples of how to achieve the same position using
"Snap To Grid":



Line Center Middle

An explanation of how this will sew on EDS IV is:  The lettering object
will start at the center/middle of the lettering then jump to the 1st
letter position to begin to sew.  It will continue to sew the lettering
object, then when finished will jump back to the center of the lettering
object (the lettering is centered both vertically and horizontally).  So, in
other words the design starts and stops in the exact center of the
lettering. This is the most common method used to sew lettering.

1. Create a lettering element

2. Click "Snap To Grid"

3. Select Horizontal, Center on

4. Select Vertical, Center on

5. Click OK

Line Center Bottom

An explanation of how this will sew on EDS IV is:  The lettering object
will start at the middle/bottom of the lettering then jump to the 1st
letter position to begin to sew.  It will continue to sew the  lettering
object, then when finished will jump back to the center/bottom of the
lettering object (the lettering is centered horizontally). This is most
commonly used for placement above a pocket or straight line.  When
the design is traced, you will be able to see where the exact bottom of
the lettering will sew on your fabric.
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1. Create a lettering element

2. Click "Snap To Grid"

3. Select Horizontal, Top of

4. Select Vertical, Center on

5. Click OK

Line Normal

An explanation of how this will sew on EDS IV is:  The lettering
object will start at the current needle position, which is the bottom of
the 1st letter typed.  When finished sewing, the needle will return to
same starting position. 

1. Create a lettering element

2. Click "Snap To Grid"

3. Select Horizontal, Top of

4. Select Vertical, Right of

5. Click OK
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Arc Normal

1. Create a lettering element

2. In lettering property page, select "Place letter on arc"

3. Click on "Snap To Grid"

4. Select Horizontal, Center on

5. Select Vertical, Center on, Click OK.

Align Each Element in Group: Use this feature after you have a
group of elements. For help on Grouping refer to that section of the
manual. To use this feature, select one element in the group, click on
the "Alignment Tools" button, select the type of "Snap to Grid" you
want, click to insert a check mark in the check box next to "Align
Each Element in Group". Now click on "Apply" and "OK".

Alignment Tools
After selecting more than one element or design, click on the
"Alignment Tools" button. You will then see the following dialogue
displaying the different ways that the elements or designs can be
aligned. You may also use the tools that are the Alignment toolbar to
align the tools.  Below is a short description of each type of
alignment and the tool that can also be used to perform that
function.
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Top Edge Alignment: This aligns your selected (or grouped)
elements or designs to the top edge of the highest element or design.

Bottom Edge Alignment: This aligns your selected (or grouped)
elements or designs to the bottom edge of the lowest element or
design.

Left Edge Alignment: This aligns your selected (or grouped)
elements or designs to the left edge of the very left element or design.

Right Edge Alignment: This aligns your selected (or grouped)
elements or designs to the right edge of the very right element or
design.

Center Horizontally: This finds the center point between all of the
selected elements or designs and aligns them on an invisible horizontal
line according to that center point.  Note that this does not center
them according to origin, use Snap to Grid for doing that.

Center Vertically: This finds the center point between all of the
selected elements or designs and aligns them on an invisible vertical
line according to that center point.  Note that this does not center
them according to origin, use Snap to Grid for doing that.



16603 Rev.A Melco Embroidery Systems

EDS IV xtreme User Guide130

Spacing

Space Evenly Horizontally: This feature determines the distance
between three or more elements or designs and spaces the
horizontal distance between them evenly. You must have three or
more elements or designs selected or grouped to use this feature.

Space Evenly Vertically: This feature determines the distance
between three or more elements or designs and spaces the vertical
distance between them evenly. You must have three or more
elements or designs selected or grouped to use this feature.

Edit Mode 
You can enter the Edit Mode by clicking on the black cursor that is in
the input toolbar. You can also simply right click inside of the
element. You can also press the "Esc" key on the keyboard to enter
Edit Mode. Do not use the "Esc" method of entering Edit Mode if
you are in the process of digitizing an element because the element
will be removed.

An eight handled box will appear around the element. You can place
the cursor over the handle and it will change into a sizing or scaling

cursor . Left click and drag when this cursor appears to change
the size of the element.

Left click inside the box to change the eight handled box into a four
handled box. You can place the cursor over the handle to change the

cursor into a rotating cursor . Left click and drag when this
cursor appears to rotate the element.

To move the element simply place the cursor inside the box. When

the move cursor appears, left click and drag to the desired
position.
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Editing Digitized Points
While in the Edit Mode you can move, add and delete digitized
points.

To move a point place the cursor over the straight digitized point

or curved digitized point until that particular cursor
appears then left click and drag it to the desired position.

You can use this same method to move the entry and exit points as
well as the to move the thread direction points.

When the particular cursor appears over a point, you can left click to
select the point. From there you can press delete to remove that
point.

When the digitized point is selected you can also right click to get a
pop-up menu that gives you the properties option. There you can
change the exact coordinates of that particular point.

In Edit Mode you also have the option of adding digitizing points to

the outline. Move the cursor along the outline to get this cursor 
. Then simply left click to insert a straight point and right click to
insert a curve point.
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Mirroring
These tools allow you to quickly mirror an element or a whole design.
Simply, select an element, multiple elements, design(s), or entire
project, then click the vertical or horizontal toolbar button. Below are
examples of vertical and horizontal mirroring:

Previous and Next Element 
After bringing up a design, you may have multiple layers of stitches in
the same area. An easy way to find elements under other elements
without having to search through the stitch list would be to use the
Previous and Next Element tools. Select a point that is digitized over
another element, then click the Previous Element tool. You will see
the selected element move to the previous element in the stitch list.

Original Horizontal Mirroring

Original Vertical Mirroring



EDS IV xtreme User Guide 133

16603 Rev.A Melco Embroidery Systems

Edit Menu

Center Design 
places the design's center in the exact center of the peripheral's
sewing field. This is an important step before sending the design to
be sewn. You can find this function in two locations: the toolbar
button and under the Edit Menu.

Change Element Type 
This feature allows you to select an element and change it to another
element. Besides being able to replace one element type with
another element type, you can also add an element type to another
element type. This feature can be used on all element types except
Manual Stitch. For the different types of element changes that you
can make, look on page 135 - 136

Example of when to replace an element type:

A walk stitch used to outline a design just doesn't seem to be wide
enough to stand out on a "plush" type of fabric (i.e. thick fleece)
that the design is being sewn on. In this case, you can select the walk

stitch outline, click on the "Change Element Type" toolbar
button, select singleline column, click "Replace". This will be a lot
thicker and show up better on the fabric.

Example of when to add an element type:

After creating a complex fill, it is a lot faster to use the "Change
Element Type" to add a border to the fill instead of digitizing around
it. To do this, simply create a complex fill, click on the "Change

Element Type" toolbar button, select walk stitch or column
stitch, click "Add". This is also very useful for changing fills to walk or
singleline column for applique purposes.

There are three different methods for changing element type. They
are through the view window, the project view, or through the Edit
Menu. You can convert one or more expanded elements.



Changing Element Type Through the View Window or Project View:

1. Select the element

2. Right click

3. Select "Change Element Type" from the pop-up menu.

Changing Element Type Through the Edit Menu:

1. Select the element

2. Click on the "Edit Menu"

3. Select "Change Element Type".

You can always edit an element that you have added or replaced.

When you have a complex fill selected that has a hole in it, you will
get one element for the complex fill and another element for the
hole.

You can also select multiple elements to change as long as there are
of the same element type (i.e. all complex fills).

When you add new items, they will be inserted (in the project view
"stitch list") directly after the element that they were created from
except for the following cases:

• When you create a walk, click on "Change Element Type",
select complex fill, click "Add". The complex fill will be inserted
before the walk because there is an assumption that the walk is
supposed to be the border.

• When you have created an element (i.e. fill or column) and
choose to "Add" a "Singleline With Input Line". The Singleline
column will always be inserted before the original element
because there is an assumption that the singleline is to be the
border.

• If you use "Set Insert Here" in the project view, then the new
items will be inserted at that location. This is especially useful
when wanting all of your borders to be at the end.
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• To use "Set Insert Here", go to the desired location in the
project view, right click, select "Set Insert Here". Whatever you
create next will be added in the desired location.

Below are pictures of the dialogues for "Change Element Type":

From Walk Normal Stitch to Singleline or Complex Fill.

From Complex Fill to Walk Normal Stitch, Walk Bean Stitch, or
Singleline.

When using the
"Change
Element Type"
function, some
minor editing
may need to be
performed after.
This is especially
true around
corners of
elements and
first and last
points of
columns. You can
edit your new
element just as
you would any
other digitized
element.



16603 Rev.A Melco Embroidery Systems

EDS IV xtreme User Guide136

From Singleline to Walk Normal Stitch, Walk Bean Stitch, or Complex
Fill.

In the case of the Singleline Column, you also have the option to use
the edge of the column or the input line. When using the "Edge"
complex fill is no longer an option but singleline is added to the list.
Using the "Edge" is used when wanting to put a border around a
singleline column.

Convert Expanded To Wireframe
EDS IV will allow you to convert expanded data to wireframe data. You
can do this at all levels, project, design, and element. There are three
different methods for converting expanded data. They are through the
view window, the project view, or through the Edit Menu. You can
convert one or more expanded elements.

Converting Expanded Data Through the View Window or Project View:

1. Select the element, design, or project

2. Right click

3. Select "Convert Expanded To Wireframe" from the pop-up menu.

Converting Expanded Data Through the Edit Menu:

1. Select the element, design, or project through the view window
or project view

When converting
Expanded data to
Wireframe, it is
always a good
idea to check the
wireframe data.
You may want to
perform some
minor editing on
the elements.
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2. Click on the "Edit Menu"

3. Select "Convert Expanded To Wireframe".

This feature only applies to EDS IV Summit and Midpoint product
levels.

Lettering To Wireframe 
Once you have completed a lettering element, you can convert the
lettering to wireframe. By doing this, the lettering will be converted to
complex fills, columns, and/or walk stitches which can easily be edited.
This is very useful to do when you would like to edit individual parts of
letters within a lettering element. There are four ways to convert
lettering elements to wireframe data. They are through the toolbar
button, through the View Window, though the Project View, or
through the Edit Menu. You can change one lettering element at a
time or multiple lettering element.

The easiest way is through the toolbar button:

1. Select the lettering element

2. Click on the toolbar button .

Converting lettering to wireframe data through the View Window or
Project View:

1. Select the lettering element, design, or project

2. Right click

3. Select "Convert Expanded To Wireframe" from the pop-up
menu.

Converting lettering to wireframe data through the Edit Menu:

1. Select the lettering element, design, or project through the view
window or project view

2. Click on the "Edit Menu"

3. Select "Convert Expanded To Wireframe".
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Copy
copies the selected element to the clipboard. You can find this
function in three locations: the toolbar button, under the Edit Menu,
or by right clicking in the View Window.

Cut
removes an element, once it has been selected, and places it on the
clipboard where it can be pasted into another location if desired. This
function can also be used as a means of deleting an element. You
can find this function in three locations: the toolbar button, under
the Edit Menu, or by right clicking in the View Window.

Find
Under the Edit Menu or by pressing 'Ctrl' F, you can get a dialogue to
search for elements within the project view. After receiving the
dialogue, click on the down arrow to choose the element type to
search for, then click "Go To". This will highlight the element type
you choose to search for within the project view. You can also be
more specific and enter the number of the stitch or element.

Global Scale Factor
You can change the global scaling factors for the wireframe elements
throughout an entire design. To access these scale factors click on the
"Edit Menu", then "ScaleFactors".  You will then see the following
dialogue:

After selecting
one or more
elements, you
can hold down
the Ctrl key and
press 'D' to
Duplicate (copy)
the selection
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An example of this is a design containing fill stitches at different
densities. If you were to change the Global Scale Factor for fill density
to 130 %, each separate complex fill will have 30% fewer stitches.  If
one fill density was set to 4.2, that same fill will now have a density
of 5.5.  Whereas another fill in the same design that had a 8 density
would now be a 10.4 density.

Paste
inserts the contents of the clipboard into the area that you have
selected with your cursor and replaces any item or element that is
selected. You can only use paste after you have cut or copied an
element to the clipboard. You can find this function in three
locations: the toolbar button, under the Edit Menu, or by right
clicking in the View Window.



Split Element
You have the ability to split elements using this feature. You must first
select a point in your element where you would like the split to occur.
Then click on the "Split Element" button or click on the "Edit
Menu", "Split Element". The point that you had selected will exist in
both of the new elements. You can split all types of columns and
walk stitches. The following rules do apply:

You can only split on a straight point, not on a curved point, because
splitting on a curved point would change the shape of the element.

You cannot split at the ends of an element.

For Column 2, you must select two points to split, one on each side.
Hold down the "Ctrl" key to select multiple points.

For Column 1, you can select just 1 point because column 1s have
matching pairs.

Undo
is used to "undo" certain actions. Not all actions are supported by
Undo. By clicking the drop down arrow, that is next to the Undo
toolbar button, you will get a list of items that may be undone. The
keyboard short-cut key for this function is Ctrl Z. You can find this
function in two locations: the toolbar button or under the Edit Menu.

Redo
is used to "redo" certain actions. Not all actions are supported by
Redo. By clicking the drop down arrow, that is next to the Redo
toolbar button, you will get a list of the items that may be redone.
The keyboard short-cut key for this function is Ctrl Y. You can find
this function in two locations: the toolbar button or under the Edit
Menu.
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File Menu

Embroidery Network System
Embroidery Network System (ENS) is a standalone Windows 95/98 32
bit program that allows the remote control and monitoring of EMB,
EMT, and EMC type embroidery machines. ENS can be used by non
EDS users who wish to have EDS like control over their Melco
embroidery network(s). ENS contains the existing EDS Ethernet and
StarLAN networking functionality plus some additional features.

How to send a design to the peripheral:

Click the ENS toolbar button or select Embroidery Network
System from the File Menu.

From within ENS, there are 2 ways to transfer file to a peripheral. You
can use the Send button, or you can use the drag-and-drop method.
Use whichever method is more comfortable for you.

Using the Send button

1. Make sure you have the Transfer tab active (click on it if you do
not).

2. Select the desired machine(s) in the Peripheral List (along the
left hand side of the screen); use the <Shift> or <Ctrl> keys as
you click the mouse button to select multiple peripherals.

3. Choose the drive and/or folder; click in the Look In field to do
this.

4. Select the file(s) to be transferred; use the <Shift> or <Ctrl>
keys as you click the mouse button to select multiple files.

5. Once the desired file(s) are selected, click the Send button to
send the design to the selected peripheral(s).

Using Drag-and-Drop

1. Make sure you have the Transfer tab active (click on it if you do
not).



2. Choose the drive and/or folder; click in the Look In field to do
this.

3. Select the file(s) to be transferred; use the <Shift> or <Ctrl>
keys as you click the mouse button to select multiple files.

4. Once the desired file(s) are selected, click and hold the left
mouse button; move your cursor over the peripheral of your
choice, and release the mouse button. This will send the file(s)
to that peripheral.

Import and Export
Some of the designs you work with may be on a floppy disk. EDS IV
is compatible with DOS, Melco, Premier, Tajima, Barudan FDR and
FMC, and ZSK disks, all of which have unique formats. The
following chart outlines when to use each command.

To perform this
operation

Use this command
for DOS formats

Use this command for
non-DOS formats

Load design file
into EDS IV

Open or Import Import

Save to hard
drive (all files
saved on the
hard drive are
DOS formats)

Save or Save As N/A

Save to floppy
disk

Save, Save As, or
Export

Format the disk
appropriately, then

Export
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Even when you
choose the
wrong format,
EDS IV will
automatically
select the correct
format for you.



Importing a Design
To import a design, click the file menu, then Import. The Import
dialog box will pop-up. The steps for importing are illustrated below
in red numbering.

Formatting
Disks must be formatted to match the file type before a file can be
written to it. You can format the disk from the Export or Import
dialog box. Follow these steps to format a disk:

1. Click on File, Import or File, Export to display the Import or Export
dialog box.

2. Select the correct format.

3. Select the correct drive.

4. Click on Format to format the disk.

Important Information on the Melco Format

The Melco format was developed to work with early Melco
embroidery machines and other older embroidery products. Hardware
required to read the Melco format is becoming increasingly difficult
for Melco's suppliers to provide. Therefore, Melco cannot guarantee
that it will be able to support the Melco format in the future.

1. Click on the desired
format.

2. Click on the desired
drive.

3. Click on the
"Directory" button
to browse for the
location.

4. Select the file to
import from the list
of files

5. Click the "Import"
button.
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If you click on the
Options button
while working
with a Tajima
format disk, a
message box will
ask you if you
want to update
the Boot Record
of the disk. This
refers to some
Tajima disks that
have an improper
internal label and
cannot be read
by a DOS
computer. If you
have problems
loading a Tajima
disk, click on the
Options button
and respond Yes
to the message.



Melco recommends exporting designs in the Melco format ONLY
when the equipment sewing the design requires the Melco format.
Otherwise, save designs in the DOS format or the format associated
with your particular embroidery product.

Other embroidery formats supported by EDS IV are not affected by
this situation.

Exporting a Design
Remember, a disk must be of the proper format before you can
export a design to it.

Click on File, then Export to display the Export dialog box.

If you are not sure of the format, click on Unknown, then on the
Directory button. EDS IV will determine the format of the disk and
make the selection for you.

Needle Sequence (for non-DOS Disk and Tape Output)

Needle Sequencing allows the user to produce designs that contain
embedded needle sequence information particular to Barudan and
ZSK multi-head peripherals. The Needle Sequence dialog box is
displayed when you click on the "Options" button in the Export
dialog box.

The number of allowed Needle Sequences (i.e., color changes) has
increased from 7 to 99. Currently, the maximum needle value is 7.
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File Name Standards

The filename conventions for floppy disk formats are given below.
These rules must be followed for the disk to be read by other
systems:

DOS Format

DOS format names consist of a 1-8 character filename and one of
the following extensions:

.CND - Condensed Format

.EXP - Expanded Format

.OFM - Project (Layout format)

Barudan FDR Format

Barudan FDR uses a numeric format. The file number can be from 1
to 36. In addition, a label of up to 8 characters may be specified with
this file number. The number and the label must be separated by a
colon.

Examples:

3

26:SNAIL

Barudan FMC Format

Barudan FMC uses a numeric format. The file number can be from 1
to 36. No character labels are allowed.

Examples:

3

26

Melco Format

MELCO format names consist of a 1-6 character filename and one of
the following extensions:

.CND - Condensed Format

.EXP - Expanded Format
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Premier/Stellar Format

The PREMIER/STELLAR format uses the Indirect mode of specifying file
names (see your Premier or Stellar manual for a description of Indirect
mode). In general, you can think of a Premier/Stellar filename as a
number between 1001 and 1999.

Examples:

1001

1930

The Options button allows you to specify 5 different sizes for the
hardware scaling of the design at sew-out time. The defaults are:

Smallest: 50%

Smaller: 75%

Larger: 125%

Largest: 150%

Enter new sizes as a ratio to 1.00, for example 125% is entered as
1.25

Note: The Stellar 1 can only read files saved in this format. The
Premier can read Tajima and DOS (.EXP) files as well.

Exporting to Stellar only works on the 'A' drive.

Tajima Format

Tajima format uses a numeric format with numbers ranging from 1-
999. Beginning with EDS IV release 1.32, any 1-8 character name is
also supported. In addition to a filename, a 1-8 character label can be
specified after the filename and separated by a colon (like the
Barudan FDR format.)

Examples:

1

G001 (How the old Tajima format stored the name 1)

1:TEST

APPLE:TEST (The new Tajima Format)



ZSK Format

Zsk format uses a numeric format with numbers ranging from 1-999.

Examples:

1

12

234

Insert
will provide you with the Insert dialogue box. In this dialogue box,
you have the ability to browse for the desired file or project. You also
have the ability to view a thumbnail image of each design as it is
selected. The thumbnail image is displayed on the right side of the
Insert dialogue box. With the Insert dialogue box, you can insert a file
into the current project. You have the ability to insert embroidery
files, condensed files, expanded files, Tajima files, OFM files, and
graphics files. You can not insert a project file into another project
file. You can find this function in two locations: the toolbar button or
under the File Menu. You can insert the following types of files:

In Summit and Midpoint product levels you will have an option on
the insert dialogue box for "Open graphics at resolution settings

Embroidery Files

Graphics Files

Project Files (*.ofm)

Condensed Files (*.cnd)

Expanded Files (*.exp)

Tajima Files (*.dst)

Barudan FDR Files (*.fdr)

Barudan FMC Files (*.fmc)

ZSK Files (*.zsk)

Baby Lock Files (*.pes)

Bernina Files (*.pes)

Brother Files (*.pes)

Elna Files (*.sew)

Janome Files (*.jef)

Janome Files (*.sew)

Pfaff Files (*.pcs)

Pfaff Macintosh (*.pcm)

Poem/Singer Embroidery Files (*.csd)

Singer (*.xxx)

Viking Files (*.hus)

OESD Files (*.oef)
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stored in file". If checked, this option will insert graphics files at there
proper resolution that they were saved at. If this option is unchecked,
the graphic will insert at 254 dpi (100 pixels per cm) which is required
for Digitizing Assistant.

New
creates a new blank view window or project based on default
settings. You can find this function in two locations: the toolbar
button or under the File Menu.

Open
will provide you with the Open dialogue box. In this dialogue box,
you have the ability to browse for the desired file or project. You also
have the ability to view a thumbnail image of each design as it is
selected. The thumbnail image is displayed on the right side of the
Open dialogue box. With the Open dialogue box, you can open
embroidery files, project files, condensed files, expanded files, Tajima
files, OFM files, and graphics files. You can find this function in two
locations: the toolbar button or under the File Menu. You can open
the following formats:

In Summit and Midpoint product levels you will have an option on
the open dialogue box for "Open graphics at resolution settings

Embroidery Files

Graphics Files

Project Files (*.ofm)

Condensed Files (*.cnd)

Expanded Files (*.exp)

Tajima Files (*.dst)

Barudan FDR Files (*.fdr)

Barudan FMC Files (*.fmc)

ZSK Files (*.zsk)

Baby Lock Files (*.pes)

Bernina Files (*.pes)

Brother Files (*.pes)

Elna Files (*.sew)

Janome Files (*.jef)

Janome Files (*.sew)

Pfaff Files (*.pcs)

Pfaff Macintosh (*.pcm)

Poem/Singer Embroidery Files (*.csd)

Singer (*.xxx)

Viking Files (*.hus)

OESD Files (*.oef)



stored in file". If checked, this option will open graphics files at there
proper resolution that they were saved at. If this option is unchecked,
the graphic will open at 254 dpi (100 pixels per cm) which is required
for Digitizing Assistant.

Print
When you click on the Print tool, you will get a dialogue page where
you can select Printer, number of copies, what to print. When
choosing what to print, you have the option of printing the Design,
the Status/Notes, the Object (stitch) list. Print is also located under the
File Menu along with Print Preview and Print Setup...

Files created in EDS IV should be saved as Project files (*.ofm) for
back up purposes. The ability to save as condensed or expanded is
there as well.

Print Preview: Allows you to preview what the print will look like.

Print Setup...: Allows you to choose the Printer, What you would like
to print, Paper, and Orientation.
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Save
will save the active file with it's current file name, location, and file
format. If these properties have not already been defined then you
will receive the Save As dialogue box. You can find this function in
two locations: the toolbar button or under the File Menu.

Save As
when you select Save As from the File Menu or you receive the Save
As dialogue box when selecting the Save toolbar button, you will
need to determine the file name, location, and format. You can save
in the following formats:

Note: This version of EDS IV is capable of producing two types of
OFM files. Files saved as "Melco Project File (*.ofm)" can only be read
with this version or higher versions of EDS IV. Files saved as "Melco
Version 2.00 (*.ofm)" can be read by any EDS IV user that has
version 2.00.006 or higher software. To change the type of OFM file
that is saved, select the desired file type from the "Save as type" list-
box control in the Save As dialog box. 

Insert Menu

Updates Auto Lock/Trim 
Anytime that you make a change to the Lock/Trim Property page, you

should click on the Auto Lock/Trim button to update your
project, stitchlist, etc. When you save your .ofm file as a .cnd or .exp
file the locks and trims will be automatically updated, but it is still a
good idea to always click this button after changing the Lock/Trim
Property page. 

Auto Shapes 
This feature allows you to insert one or more of the following shapes
into a design: circle, ellipse, square, rectangle and star. Each shape
may be inserted as a walk stitch, bean stitch, decorative stitch, single
line center, single line left, single line right and complex fill. This
feature is only available for EDS IV Summit and Midpoint product
levels.
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You can press the
see in 3D button,
save the file as a
graphic file
(*.bmp, *.pcx,
*.jpg, *.tif) and
give this file to
anyone wanting
to view what the
sew out will look
like. The graphic
file can be
opened in any
graphics
program, i.e.
paint, paintshop,
photoshop, etc.

If you open an
EDS III .OFM file
and save it, it will
be converted into
an EDS IV .OFM
file, which is no
longer readable
in EDS III.

Files saved in this
version of EDS IV
cannot be read
by previous
versions of EDS
IV.
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To insert a shape, you must first select the desired stitch type (e.g.
decorative stitch), then select the shape (e.g. ellipse) from the input
toolbar. Now, click the mouse once, then move the mouse and click
again, the selected shape will appear with the selected stitch type
(note: this is not a click and drag operation). See the following tables
for the characteristics of shape and stitch type.

Stitch Types: Single Line Center / Left / Right

 Center
Point

Anchor
Point

Entry Point Exit Point Width

Circle 1st Click N/A 2nd Click 2nd Click 20 Points

Ellipse N/A 1st Click 0 Degrees 0 Degrees 20 Points

Square N/A 1st Click Top Center Top Center 20 Points

Rectangle N/A 1st Click Top Center Top Center 20 Points

Star 1st Click N/A 1/2 way
down on the
right from the
top point of
the star

1/2 way
down on
the right
from the
top point of
the star

20 Points

Stitch Types: Walk, Bean, Decorative
 Center Point Anchor Point Entry Point Exit Point
Circle 1st Click N/A 2nd Click 2nd Click
Ellipse N/A 1st Click 0 Degrees 0 Degrees
Square N/A 1st Click Top Center Top Center
Rectangle N/A 1st Click Top Center Top Center
Star 1st Click N/A Top Point of

Star
Bottom Right
Point of Star

One typical use
for auto shapes is
to create outlines
around designs.
Try this using
decorative stitch
for an interesting
effect.
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Bean Stitch 
Where a normal stitch lays one length of thread down for each stitch,
a bean stitch lays down three lengths of thread. The bean stitch is
often used to digitize a thicker outline around an element. The bean
stitch design consists of laying down a normal stitch in the forward
direction, then going back to the original start of that normal stitch
with another needle penetration, and again forward to the end of
the first stitch with another needle penetration.

Color Change 
is an instruction to the peripheral to pause for a re-thread on a
single-needle machine, or to change to a different needle on a multi-
needle machine. it also changes the color in the View Window to the
next color in the color palette. This function also inserts a color
change command after the currently highlighted data-set in the stitch
list. You can find this function in three locations: the toolbar button,
under the Insert Menu, or by right clicking in the View window. The
keyboard shortcut for this is F6.

Stitch Types: Complex Fill

 Center
Point

Anchor
Point

Entry Point Exit Point Width

Circle 1st Click N/A -90 Degrees
From 2nd
Click

90 Degrees
From 2nd
Click

Drag Line

Ellipse N/A 1st Click 2nd Click 2nd Click Drag Line

Square N/A 1st Click 1st Click 2nd Click Horizontal

Rectangle N/A 1st Click 1st Click 2nd Click Horizontal

Star 1st Click N/A Top Point of
Star

Bottom
Right Point
of Star

Horizontal
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Column 1 
is used to generate parallel columns. The stitches are generated back
and forth between two outside lines that are parallel (or nearly
parallel) to each other. The simplest representation of a shape that
would lend itself to a column 1 stitching is the letter l. You can find
this function in three locations: the toolbar button, under the Insert
Menu, or by right clicking in the View Window.

Column 2 
is used more often to generate column stitches for non-parallel
columns. To obtain this, first digitize all of the outline stitches from
the beginning on one side of an element, then from the beginning
again on the other side of the element. You can find this function in
three locations: the toolbar button, under the Insert Menu, or by
right clicking in the View Window.

If a point is entered incorrectly, pressing the Backspace key will
remove the input points in reverse order.

Complex Fill and Hole 
Complex fill is the tool on the left with the red outline. To digitize a
complex fill, select the complex fill tool by left clicking on it, or by
right clicking inside the view window and selecting complex fill. Now
input the wireframe outline of the complex fill. By inputting straight
or curved points. The last point input should end up being close to
the first point that you input, then press Enter or Return. This will
connect the last point with the first point. Next, if there are any small
holes or places that you do not want the fill to cover, digitize a
wireframe outline around those just as you did the first outline and
press Enter after each one. After you have finished digitizing the
complex fill and any holes, press Enter again.

If you have finished a complex fill and decide later that it should
contain some empty spaces (holes), you can insert them without
having to digitize the fill again. The toolbar button next to the
complex fill button (with the black outline and the filled in hole) is the
complex hole button. Select your design by right clicking on it, then
select the complex hole tool. Now digitize the wireframe outline of
the hole and press Enter.
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Complex fill automatically terminates after the second direction point
is put in.

You can get to complex fill and hole with the tools on the toolbar,
through the Insert Menu, or by right clicking in the View Window.

If a point is entered incorrectly, pressing the Backspace key will
remove the input points in reverse order.

Lettering
After you have clicked on this tool, click inside the view window. A
Lettering Properties Dialogue will appear. Lettering Properties consist
of four tabs: the Lettering Tab, the Column Tab, the Lock/Trim Tab,
and the View Tab. For further information, refer to the Properties
section for each tab.

Besides pressing
the lettering
input tool , you
can also press 'T'
on your keyboard
to begin a
lettering
element.
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Manual Stitch 
Manual stitches give you more control to digitize an exact outline.
Where you place the points is where your needle penetrations will be
without extra needle penetrations in between. You can only use
straight points for digitizing a manual stitch. This type of element is
usually used for items where you want to be able to determine
where your needle penetrations are. This is located as a toolbar
button, in the Insert Menu and also by right clicking in the View
Window.

If a point is entered incorrectly, pressing the Backspace key will
remove the input points in reverse order.

Return to Origin 
This function is normally used at the end of the digitizing process to
tell the embroidery peripheral to return the needle to the design
origin. It is most helpful to you and your customers to start and end a
design at the exact center of the design. You generally want to have
lock stitches at the end of a design, trim, then return to origin.

Single line column 
is a method of producing columns that maintain an equal width
throughout the column. Single line center, single line left, and single
line right are the three different types of single line input. The
difference between these three types is just the positioning of the
stitch area surrounding the line that you create. You can find each of
these three functions in three locations: the toolbar button, under the
Insert Menu, or by right clicking in the View Window.

When creating a Single line center column you will first digitize
the basic wireframe outline of the design. Then following the
instructions located in the grey area below the View Window (the
status line), input the first and second width points. The distance
between these two points will determine the width of your column
with your wireframe line in the center. This is the same procedure

used to input a Single line left and a Single line right .
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Single line automatically terminates after inputting the width of the
second point.

If a point is entered incorrectly, pressing the Backspace key will
remove the input points in reverse order.

Trim
A trim command causes peripherals equipped with trimmers to
perform a trim. This function also inserts a trim command after the
currently highlighted data-set in the stitch list. You can find this
function in three locations: the toolbar button, under the Insert
Menu, or by right clicking in the View Window.

Walk Jump Stitch 
The Walk Jump Stitch element is used to position the needle in the
hoop without sewing stitches to the new position. The Walk Jump
Stitch does not create needle penetrations. The input method is the
same as the Walk Stitch element using a combination of straight and
curve wireframe points. Left click for straight points, right click for
curved points.

The Walk Jump Stitch element is used to manually connect sections
of designs and to position the needle outside of the boundaries of
the design in order to position material for an applique.

This is located as a toolbar button, in the Insert Menu and also by
right clicking in the View Window. This element is available for EDS
IV Summit and Midpoint Product Levels.

Walk Stitch 
Walk stitches are the equivalent to running stitches in EDS III and are
typically generated in making underlay and outline stitching. Walk
stitches are the simplest stitches to make when digitizing. They can
be generated in two methods, straight lines or automatic curves. For
example, If you are digitizing the outline of a square select walk
stitch, then left click at the first corner of the square. Now, go to the
second corner and left click, the third corner and left click, the forth
corner and left click, back to the first corner and left click. It doesn't
matter how big the square is when you are using walk stitch; needle
penetrations will be inserted every 30 points along the way. The



default setting is 30 points and can be changed under walk stitch
properties. This is located as a toolbar button, in the Insert Menu and
also by right clicking in the View Window.

If a point is entered incorrectly, pressing the Backspace key will
remove the input points in reverse order.

Stitch Types 
After selecting a column 1, column 2, or a single line column, you
can choose from four different stitch types. The different stitch types
are Satin Stitch , Zigzag Stitch , E Stitch , and Fill Stitch . If you don't
select the stitch type when first inputting the column, then you will
need to go into the Column Properties to change the stitch type.
Choosing the stitch type is also available under the Stitch Type Menu.

The new Zigzag stitch is similar to a Satin stitch. Zigzag's can be used
for underlays and boarders around lettering. Use Column 1, 2 or
Singleline Input tools to digitize a Zigzag.

The new E stitch is similar to a Satin stitch. E stitches can be used for
applique tack-downs or border stitching. Use Column 1, 2 or
Singleline Input tools to digitize an E stitch.
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Tools Menu

Accelorator Editor
You have the option of assigning EDS IV functions to the hotkey (or
key combination) of your choice. Click on "Tool", then "Accelerator
Editor". You will see the following dialogue:

Commands: This list box contains a list of all of the available
commands from the menus and toolbars.  

Current Keys: This list box displays the accelerators currently defined
for the highlighted selection in the "Commands" box. The gray
selections are default accelerators that cannot be removed or
changed. The black accelerators are user defined (defined by you),
and can be removed or changed. NOTE: Default accelerators are
displayed in gray, and user defined accelerators are displayed in black.

Select New Shortcut Key: This edit box allows you to enter in any key
combination that you wish to be an accelerator/hotkey for the
highlighted selection in the "Commands" list box.

Currently Affected To: Upon clicking the "Assign" key, if the key
sequence in the "Select New Shortcut Key" box has already been
defined for another command, that command text is displayed here.
The Accelerator Manager prevents you from entering in duplicate
accelerators.

Assign Button: This assigns the key sequence in the "Select New
Shortcut Key" box to the highlighted selection in the "Commands"
box. Pressing this button also saves the accelerator key sequence in
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your registry. 

Remove Button: This removes the highlighted selection in the
"Current Keys" box from the list, as well as your registry.

Reset All Button: This removes all of the accelerators that you have
defined from the "Current Keys" box and the your registry, and
reloads the default accelerator table.

Example of use

1. Click on the "Tools" menu, and then click on "Accelerator
Editor". This will display the Accelerator editor dialog box.

2. Choose a command that you wish to add a hotkey for and
then click on it in the "Commands" box. 

3. Now click in the "Select New Shortcut Key" box and type in
the key sequence you want for the hotkey.

4. Click on "Assign"

5. Click on "OK"
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Business Assistant
The Business Assistant is a utility to help you calculate the cost on a
per item basis. You can find the Business Assistant, it is under the
Tools Menu. Below is a picture of the Business Assistant dialogue.

You may select the machine and hoop type. Values may be entered
for a charge for each 1000 stitches and the maximum speed the
design will be sewn at. You may also enter a price for any additional
charges (for example a setup fee price). Click on the "Calculate"
button to see the total sewing time (hours:minutes:seconds) and total
price. The Business Assistant supports all monetary values supported
by the Window's regional settings. Estimates from the Business
Assistant are not available for printing at this time.

Convert / Restore Alphabets
All alphabets currently being sold by Melco contain lock stitches at
the end of each letter in the alphabet.  These lock stitches are what
"ties down" the stitching at the end of each letter. EDS IV allows you
to add lock stitches to a lettering job from the Lock / Trim tab.
However, because the lock stitches are already digitized into the
alphabet, the result is multiple lock stitches that will create an
undesirable knotting effect. 
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To remove all existing lock stitches from all installed alphabets, click
on the "Tools Menu", "Convert Alphabets". You will get the
following dialog box:

When clicking on "Continue", all lock stitches will be removed from
the alphabets that are installed on your hard drive. If you want to
stop click, "Cancel". When converting alphabets, it may take several
minutes to complete.

If you decide that you didn't want to remove the lock stitches from
the alphabets, click on "Tools Menu", "Restore Alphabets". You will
get the following dialogue box:

When clicking on "Restore Now", all of the installed alphabets will
be restored to their backup file.
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Design Filter
This function applies to the editing of Expanded data designs only.

Turn on the functions that you wish to affect you design by left
clicking in the box next to the function (click again and the check
mark, that was just inserted, will be removed). A check mark in the
box symbolizes the the function is ON, whereas no check mark in the
box symbolizes that the function is OFF.

Accumulate Jump Stitches: When you digitize a jump stitch between
two points, the computer makes the move in increments of the stitch
length you are using. For example, if the total distance you are
moving is 360 points, and your stitch length is 40 points; then the
computer will generate 9 stitches (in the jump stitch mode) to cover
that distance.

By turning ON this function, you will force the computer to cover the
360-point distance in increments of the maximum stitch length for
the format you are using. Most multi-head machines have a
maximum stitch length of 127 points.

Assuming we are using a format with a 127-point maximum stitch
length; then the computer would generate only 3 stitches to cover
the 360 point movement. This would decrease the design's stitch
count, and save a little sewing time.
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Since Jump Stitch
elements consist
entirely of
expanded jump
stitches the
"Accumulate
jump stitches"
field in the design
filter should be
disabled. If
"Accumulate
jump stitches" is
enabled the Jump
Stitch element
will be filtered
out and the
needle will not
be positioned
correctly in the
expanded design.

Do not turn on
Accumulate Jump
Stitches or
Accumulate
Needle Ups if you
have a design in
which you want
to use thread
trimmers.



Accumulate Needle Ups: This function is very similar to Accumulate
Jump Stitch except it acts on Needle Up stitches.

Accumulate Short Stitches: This function will delete all short stitches
that are equal to, or less than, the length that you set in Short Stitch
Length. This function will filter out a series of short stitches;
therefore, if you desire to protect your lock stitches, you must enter
the number of consecutive short stitches that you want to protect in
the After Short stitch count box.

The box below Accumulate Short Stitches, labeled "After _ Short," is
the short stitch count. This function is used in conjunction with
Accumulate Short Stitches, and allows you to determine the number
of consecutive short stitches that will not be deleted when you use
the Accumulate Short Stitches function. You may enter any number
up to and including 20 stitches.

Delete Single Short Stitches: This does not refer to your column
stitches; but rather those zero-motion or tiny walk stitches that are
sometimes in designs. There are also some very tiny stitches in the fills
that are digitized when the needle begins sewing a new line of stitch.

This function will only delete a single short stitch; that is, a short
stitch that is preceded by, and followed by, a stitch that exceeds the
length defined in Short Stitch Length. Two or more consecutive short
stitches will not be affected by this function. This function allows you
to filter out any random short stitches without filtering out your lock
stitches.

Maximum Stitch Length: Any stitches greater than this value will be
broken down with intervening jump stitches by the computer. For
most multi-head formats this value should not exceed 127 points. For
Tajima format this value should not exceed 121 points.

Needle Ups to Jumps: Turn this function ON to have all Needle Up
stitches changed to Jump stitches. The advantage of using Jump
stitches is that the main shaft of the sewing peripheral continues to
turn while the jump stitch solenoid holds the needle up to keep it
from sewing. Needle Up movements, on the other hand, stop the
main shaft while the rack moves. This causes you to lose time during
the sewing of a design.

This function literally changes each expanded Needle Up to a Jump
stitch in the design data.
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Short Stitch Length: This function allows you to enter a length, from
0 to 5 points, that defines what a short stitch is. For example, if you
enter a length of 3 points; then any stitch that has a length of 3
points or less will be considered a short stitch, and will be acted upon
the other short stitch functions.

Factory Defaults
The Factory Defaults dialog box can be found by clicking on the
"Tools Menu", then "Factory Defaults". You can restore the default
settings for Complex Fill, Column 1, Column 2, Singleline Columns,
Walk Stitches, Lettering, the Workspace Area (View Window), Color
Palette and Grid/Origin.

An example of how to restore the current settings to the factory
default settings follows: 

1. Start Eds4

2. Open a design with one or more of the element types listed
above.

3. Change the properties for one or more of the element types
listed above.
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4. Display Factory Defaults dialog box (under the Tools Menu).

5. Restore defaults for each type.  This should be done at all
selection levels (Project, design, element).

Group Names
This is a new feature of EDS IV that replaces most of the functionality
of EDS III's Step and Repeat with more powerful, distributed
functionality. Group Names allows you to add a single replaceable
lettering field to a project and a list of names to be stitched into that
field to a project and a list of names to be stitched into that field
whenever you save the project to condensed or expanded files. This list
of names becomes part of the project and can be managed either
within EDS IV or from the Windows Explorer, providing distributed
access to this exciting new feature.

Group Names will always stitch last so it will always be fully visible
regardless of its positioning relative to the other designs in your project.
Choosing the position and lettering properties will often involve some
experimentation and compromise considering that the length of names
to be substituted often varies considerably. Preview capability allows
substitution of any selected name into the replaceable field at design
time to assist with those choices. The full range of lettering properties
are available but cannot be varied from name to name. Similarly, the
position of the Group Names field is fixed and cannot be varied from
name to name during a single Save As operation. It is, of course,
possible to select File Save As to generate expanded or condensed file
output then adjust the position of the field, reselect long names, and
generate another expanded or condensed file.

While Group Names will most commonly be used to individualize
uniforms for members of sports teams, the capability is generally
applicable to batch personalization of multiple embroidered garments.
A simple database of available names is associated with the project and
can be updated, altered, and multiple different sets of names can be
selected from available names. Copying the project file copies the
available names but the list can be cleared and repopulated with a new
set of names, possibly for a different customer. Risks of stitching an
incorrect, or misspelled name on a garment are reduced by allowing
copies of the selected list to be made to the windows clipboard and
then e-mailed or faxed to customers prior to actually generating the
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expanded or condensed files. Sending a copy of this list to your
printer can provide identification of any particular name with the
appropriately sized garment when not stitching on one-size fits all
items.

The range of output options must be set prior to choosing File, Save
As to generate either expanded or condensed files. These output
options can be set from the same property page you will use to
manage the lists of available and selected names. There are five
options that result in generating from one file containing copies of
the design and one name for all of the selected group names
through separate files for each of the names. Understanding which
option to choose from this list will allow you to shorten the total time
required to stitch out embroidery machines that incorporate
"SomeCodeName".

As you can see, there is considerable power and flexibility in the
Group Names feature, but the workflow to add group names to any
existing project could hardly be simpler. First, choose Tools, Group
Names from the EDS IV menu. Position the resulting lettering relative
to the rest of the design. Next, right click on the Group Names object
clipboard or import from a text file. You can then select on or more
names, or even the entire available list by selecting names and
clicking > or >>. If you click on one of the selected names, it will
replace the Group Names text as a preview and you can reposition
the field after dismissing the Property Page. Remember that only a
single position for the Group Names field is available each time you
generate expanded or condensed files. Finally, you will choose File,
Save As and set the file type to either expanded or condensed,
navigate to the directory where you would like to store the resulting
output, and click "OK". You should choose the output directory
carefully when generating multiple group names files to avoid mixing
these with designs that do not contain group names. To assist in
making this distinction, the first two characters of multiple group
name files are numeric, i.e. 01Bill.exp 02Mary.exp, etc. so they will
sort to the top of the list in Explorer when the list is sorted on name.

All of this sounds more complex than it actually is and once you have
used group names for one to two projects your productivity in using
it to personalize designs will soar by comparison with any other
method, in any other embroidery design system. Being able to allow
the production department to manage the database of names form
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computers that do not necessarily have EDS IV installed allows the
workflow to be distributed in shops where networks may include
multiple production workstations but only a single EDS IV design
station. This is the kind of functionality you will come to expect from
your embroidery system and it is available exclusively from Melco.

Workflow
The first and last step handled form within EDS IV, i.e. choosing Tools,
Group Names and later, File, Save As. These are easy and, as noted,
must be completed from within EDS IV.

Managing the list of available and selected Group Names can be
carried out either within EDS IV or within Explorer, by right button
mouse clicking on the appropriate object or file and selecting
Properties. The Group Names tab will contain a property page that
allows you to add, import, paste, clear, copy to clipboard, and
otherwise select names form the available list. Note that the list boxes
are intentionally not self sorting so that names will remain in the order
added and Clear will empty BOTH lists.

Clicking "Add" will make a small edit window available immediately
above the "Add" button. You can type a list of names, separated by
commas, into that edit window and then click "Add" again to place
them in the Available Names List. Note that you can add names that
include First Last names as, for example, "John Jones, Mary Jo
Williams, …". After selecting an individual name you can then choose
to substitute First Name only, Last Name only, or both but you should
be aware that for Mary Jo Williams the first name will be considered
Mary and her last name Jo Williams. If this is not what you want to
happen to such names you should type Mary Jo as Mary_Jo. It will
appear as Mary_Jo in the list but when stitched out the "_" will be
replaced by a space.

Generally you will not Add names individually because of the
possibility of making errors. Moreover, the list of Available Names
cannot be edited after names have been added. There is, however, a
very simple way to edit the list and the order of the names using
NotePad or any word processor. Be sure the list of names has been
saved to the project file if you just added them. First, click << to empty
the list of Selected Names and then click >> to place a complete copy
of Available Names into Selected Names. Select the "Both" radio
button to assure that the complete name is showing for each. Next
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click "Copy to Clipboard" to copy the list of Selected Names to the
Windows clipboard and then paste it into whatever text editor you
regularly use. You may note some additional information enclosed
parenthetically but you can ignore it as balanced parentheses and
enclosed text will be removed when pasting or importing files. With
the list in your favorite editor you are free to Edit, Copy to place it
back into the clipboard. Returning to the Group Names Property Page,
click "Clear" to empty the list and then Paste the edited names back
into Available names list. If something goes wrong, click "Cancel" on
the Property Page and whatever data was in the project file will be
kept safely. If you are happy with the edited data list click "OK" to
save it.

Note that you also can save your list of names into a text file, for
example using NotePad. The value of doing this is that you can
associate comments with each name in the list as in the following
example:

John Jones (male 16-32 left pocket)

Mary Jo Williams (female small left sleeve)

And so on…

Printing this list will assist the embroidery peripheral operator to
associate the proper garment with the name. Note, as mentioned
above, balanced parenthesis and their contents will be ignored and
ends-of-line can be substituted for commas to separate names. Beware
of open parenthesis without a balancing close as you may lose names
from the list.

The real power of this multi-step editing process is that lists of
Available Names can be quickly extracted form e-mail without risk of
misspelling and copied back to e-mail or fax before stitching to verify
the names with customers. The longer the list the more you'll
appreciate this functionality. One misspelled name can turn profits into
losses on expensive uniforms!

After making changes to Group Names properties be sure to click
"Apply" or "OK" if you wish to save those changes to the project file.
If you wish merely to experiment with the lists but not save changes,
click "Cancel". Doing this in Explorer works directly with the project
file but within EDS IV you must actually choose File, Save or click "OK"
to save the project file before it will be permanently recorded on disk.
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Output Options
Group Names must be processed into expanded or condensed files
before they can be stitched on embroidery peripherals. This occurs
when you File, Save As to either expanded or condensed. There are
five optional output formats, the first four will result in the
generation of only a single file, whether expanded or condensed. The
final output option results in multiple files, named 01name1.exp,
02name2.exp, etc. being generated where each file can be sewn
separately. When these files are placed on a diskette and viewed on a
sewing peripheral, the numeric order will help the operator keep
them in sequence.

The reason there are so many output options that result in a single
file is that large Group Name jobs can be run simultaneously on
multi-head machines using <<SomeCodeName>>. Generally, when
stitching on a single-head machine you will use option 1, i.e. Design,
Name, Design, Name and change garments on color changes after
the name, or use option 5, File Per Name for greater control of the
process.

Options
Auto Save: You can turn
auto save on or off by
clicking in the box next to
Auto Save. A check mark
in the box symbolizes that
auto save is on, click
again to remove the
check which symbolizes
that auto save is off. Next
to Interval you can insert
a number that will
determine how often
auto save will save your
file.

Open File: You can have your files open up to actual size or to fit the
whole screen.

Preserve Condensed Connectors On Open: When checked EDS IV will
create a jumpstitch object for each portion of a condensed design
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while you are
working in EDS IV,
the next time you
open EDS IV you
will be given the
option to recover
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Auto Save. After
the recovered files
are open you
should save them
with a new name.
Do not save them
in the temp
directory because
these files are
managed by EDS
IV and will be
deleted.



that was in the needle up mode. If the box is not checked the needle
up sections of the condensed design are discarded and EDS IV
automatically creates connectors to move between sections of the
design.

Auto Scroll: Auto Scroll
works as you are in the
middle of digitizing an
element. When you move
your cursor out of the
view window, auto scroll
will scroll the view
window to follow the
direction of your cursor.
You can change the speed
of the auto scroll from 1
to 10.

Notes Editor: If you choose to use a different editor than the default
(microsoft word for example), click in the radio button next to Specify
Editor and then browse to the desired one. Notepad is the default
editor.

Measurement Units:
You have the option of
changing the
measurement units on the
properties listed. You can
have the units in
embroidery points,
millimeters, centimeters,
or inches.

EDS IV xtreme User Guide170

16603 Rev.A Melco Embroidery Systems



Editing Properties

Wireframe Point Size

You have the option of
changing the size of the
wireframe points when
you view them in the View
Window. The default is
Small (9 pixel).

Tablet Digitizer

This option applies only to
EDS IV Summit product
level.

The process of digitizing
with a tablet is similar to
on-screen digitizing. You
can create elements by
inputting a series of
straight and/or curved
points. Please scroll down
for further information.

The required components
for tablet digitizer are as
follows:

• Digitizing Tablet - Any tablet that conforms to
Summagraphic's Microgrid Format (most tablets supported
by EDS III fall into this category).

• Tablet Toolbar - A "stick on" template that closely resembles
the EDS IV input toolbar

• Computer Serial Port - capable of handling 2400baud, no
parity, 8 data bits and 1 stop bit.

• EDS IV Summit Level - The tablet will only function with the
EDS IV Summit Level product.
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Tablet Setup

If you have the Summit product level, the tablet may be set up by
clicking on the "Tools:Options" menu in EDS IV. Then click on the
"Digitizing Properties" tab.

All controls (except sound) will initially be disabled. To enable all
controls, click on the "Tablet Present" checkbox. Select the COM port
per your hardware capabilities. You can select how your puck buttons
are mapped. Default mappings are as follows:

• Button 1 - Straight Point

• Button 2 - Enter

• Button 3 - Curved Point

• Button 4 - Move Tablet Toolbar

The Tablet Toolbar

The tablet toolbar is a stick on device that contains tools for the
various digitizing functions. Because of it's similarity to the EDS IV
input toolbar, only differences are described below.

Set Origin - To set the origin of the artwork, click on this tool
followed by a puck click (any puck button not mapped as the "Move
menu" button) on the origin of the artwork.

Set Horizontal - To set the angle of the artwork, click on this tool
followed by a puck click (any puck button not mapped as the "Move
menu" button) on the bottom left edge of the artwork followed by
another click on the bottom right edge of the artwork.

Move Artwork - This function allows you to digitize a design which
has artwork larger than the active area of the tablet digitizer. You are
able to digitize up to a point, then move your artwork and resume
digitizing with no break in the design. To move artwork and maintain
the original origin, perform the following steps:

1. Click on the Move Artwork tool
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toolbar function
can be used, the
toolbar position
must be given to
the computer by:

1. position the
menu to the
desired
location on
the tablet.

2. click on the
orientation
mark on the
bottom left of
the toolbar
(use the puck
button
mapped as
"Move
Menu")

3. click on the
orientation
mark on the
bottom right
of the toolbar
(use the puck
button
mapped as
"Move
Menu")



2. Click on a point (example point x) on the artwork

3. Move the artwork

4. Click on point x again

5. Click on the bottom left edge of the artwork followed by
another click on the bottom right edge of the artwork

6. Continue digitizing as normal

Retrace On/Off - Click on the retrace button to switch from 'On' to
'Off'. When this function is 'On", an newly digitized walk stitches will
retrace back to the first digitized point.

Backspace - This tool simulates the pressing of the "Backspace" key
on the keyboard. Each time this tool is clicked on, the last entered
point is removed from the screen.

Escape - This tool simulates the pressing of the "Escape" key on the
keyboard. Click on this tool to remove the last digitized element.

Digitizing Hints

1. The artwork origin and angle are saved in the registry. Once the
parameters are set, it is only necessary to change them when
the artwork is moved.

2. It is not necessary to "start a digitizing session" as it was in EDS
III. Once the tablet is configured the user may enter points by
choosing the appropriate input tool from the tablet toolbar or
the EDS IV input toolbar and then entering straight and/or
curved wireframe points.

3. While an element is being digitized from the tablet, mouse
input from EDS IV is ignored. Mouse input will be recognized
once the element is finished being digitized.

4. All element parameters such as density, underlay, stitch length,
etc. are set from the property sheets as done for on screen
digitizing. 
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Digitizing Sound Effects

This feature only applies to EDS IV Summit product level. EDS IV
supports the ability to produce audible sounds when a mouse button
or puck button is clicked during digitizing. To enable this effect, click
on the menu item "Tools:Options" followed by a click on the
"Digitizing Properties" tab (you must have the Summit product level). 

When "Sound" is selected to "On", an audible tone will be heard
from the computer each time a button is pressed on the active
digitizing device (mouse / puck). The following table shows what
tones will be heard depending on the operating system and
hardware present:

Windows NT / 2000 with a sound
card

Unique tone from sound card

Windows NT / 2000 without a
sound card

Unique tone from computer speaker

Windows 98 with sound card Unique tone from sound card
Windows 98 without sound card Standard system "beep" from

computer speaker

EDS IV xtreme User Guide174

16603 Rev.A Melco Embroidery Systems



Security
There are three tabs under the Tools Menu, Security. The three tabs
are General, Levels, and Options.

The Levels Tab displays
the Current Level. If
upgrading to another
level, here is where you
will type in the password
for the higher level. The
first level is "Base",
which is primarily a
lettering system. The
next Level is "Mid-
point", which contains
lettering and editing. The
top level is "Summit",
which contains lettering,
editing, and digitizing.
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The General Tab displays
The Melco Dongles that
are attached to that
particular computer and
the Serial Number
associated with each
dongle.



View Menu

Design Notes 
Design Notes is a useful tool for documenting information of the
design (i.e., maximum & minimum height, with, stitch count, colors,
etc.) To insert notes, simply click on the "Notes" tool. Type the
desired text and save. To view design notes, right click on the top
level project in the stitch list and select Design Notes. This is also
located under the View Menu.

Display Hoop
By selecting Display Hoop, a dialogue will pop-up. This dialogue will
give you the ability to choose the machine type, which hoop, display
that hoop on the screen and even trace your design to make sure the
current design fits in the selected hoop. You can also create new
hoops, look in the Properties section of this manual under Hoop
Control.

Grouping Ungrouping
You can access Grouping or Ungrouping through the "View Menu"
or by clicking on the toolbar buttons.
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the available options
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would type the
password for purchased
options.



After selecting more than one element, you can group them by

simply clicking on the Group Button . After doing so a number
is automatically assigned to that group. You can view this number in
the Project View. 

If you click on any of the items within the group, the whole group
will be selected. The only exception to this is if you click in the View
Window and drag a box around part of the design to select
elements, then the whole group may not be selected. The reason for
this exception is so that you can still have temporary grouping
without having to ungroup your numbered groups.

The Group Button also has a drop down arrow for easy selection. If
you click on this arrow you can select the number of the group and
the whole group will be selected in the Project View and the View
Window.

To ungroup a group, select an element from that group and click on

the Ungroup Button . This will remove all of the currently
selected elements from their group.

Hide/Show Graphic 
After you have inserted a graphic, you can click on this tool to hide.
Click again to show the graphic. These options are also located under
the View Menu.

Hide/Show Stitches
After you have inserted an element or design, you can click on this
tool to hide the stitches. Click again to show the stitches. These
options are also located under the View Menu.

Color Palette
The color palette displays a large choice of colors. Each square
represents a color. These colors are used to draw out your design in
the View Window. Color one can be thought of as needle one on
the peripheral, but color palette does not control the peripheral.
Colors are supplied to aid in visualizing what the final sew out will
look like. Color one will sew out first, color two will sew out second,
and so on. A number will appear on the color box in the color palette
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only when the color is active in the design. Every color is editable. To
edit the colors, you can right click anywhere on the color palette.
Once you right click a color menu will appear with several features.
The first feature is that you can hide the color that you right clicked
on. The second feature is that you can show the color if it is already
hidden. If a color is hidden it will have an X on top of it. You can also
simply left click on a color to show or hide it. An X on top of the
color symbolizes that it is hidden. No X on top of the color
symbolizes that the color is not hidden. From the color menu, you
can also hide all of the colors in the design. If you would like to have
one color displayed at a time, to show the order of sewing for

example, you can use the "Walk Through Colors" tool . The
"Walk Through Colors" tool is displayed after the background color
button.

If you would like to change the color of the background (the View
Window area behind the design), right click on the first box in the

color palette .

Another feature of the color menu is the Drag Customization. Once
you are in the Drag Customization mode you can click on a color,
drag it and drop it onto the position where you would like it to be.

The last box in the color palette , represents the color wrap. This
image is always displayed at the end of the colors in the color
palette. Color wrap is explained in more detail under Color
Properties.

The final feature of the color menu is Properties. Refer to Color
Properties for more information.

Project Views
When selecting Project Views from the View Menu, a portion of the
EDS IV screen will be given to a box containing three tabs. These
three tabs are Project, Navigator, and Palette. These tabs are designed
to function as an assistant while you are working on a project. If you
would like to not have the Alternate Views displayed, you can un-
select them from the View Menu. You can also un-select them by
right clicking in the empty grey space to the right of the toolbars.
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Customization
Mode, you will
not be able to
get out of that
mode until you
right click and
end Drag
Customization.



The Project Tab displays a tree view or a list of everything
that you have done within a project. The highest level in the tree
view is the project. The project name is editable in the project
properties general tab. You can get to the properties menu by
selecting the name of the project from the tree view and then right
click.

The next level in a project is the Design Level. A project can consist of
one or more designs. The name of the design is editable in the
design properties general tab. You can get to the properties menu by
selecting the name of the design from the tree view and right click.

The next level in a project consists of the elements of each design.
Each design can consist of one or more elements. The elements that
make up a design can be Manual Stitch, Walk Stitch, Column1,
Column 2, Single line center, Single line left, Single line right,
Complex Fill, Lettering, Color Change, Trim, and Return to Origin.

The next level that follows after the elements is the stitch list that
displays the data-sets that are present. A data-set is any command
that produces a stitch. If the design is wireframe (.OFM), the stitch list
information will be in wireframe outline parameters. If the design is
condensed (.CND), the stitch list information will be in mark point
parameters. If the design is expanded (.EXP), the list will be in stitch
parameters.

The Stitches Tab was designed to aid you with expanded
editing. It displays two windows. The first window is the Project
window and the Second is the Stitches window. The Stitches window
shows all of the expanded stitches for an entire project. The
expanded stitches are also numbered. This expanded data is only
editable in an expanded design or an expanded element. When
viewing the expanded data from a wireframe or condensed design,
the expanded data will have (RO) next to it. This indicates that data is
Read Only and cannot be edited.

To navigate through the expanded data list you can scroll using your
mouse, use the "Home", "End", "Page Up", "Page Down" keys, or
the arrow keys on your keyboard. If you want to edit a particular
expanded piece and can see it in the Project window, click on the
icon in the Project window and it will take you to the beginning of
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that segment in the Stitches window. The picture below is
demonstrates this. When the outline of the yellow bear was clicked
on, the expanded stitch list moved down and highlighted where the
data for the yellow outline starts.

The Navigator Tab is a very useful tool within the tree
view. Here you will find a small version or a thumbnail image of your
project. There are two ways of moving within a project using the
navigator tool.

One way to use the navigator is to left click and drag while your
cursor is in the view box (the red box). This view box represents the
area that will be displayed in your View Window.

The second way to use the navigator is to left click in the thumbnail
image of the navigator tab. The area that you click on will now be
the center of the view box.

As you use the zoom tools in the View Window, the size of the view
box in the Navigator Tab will get larger or smaller.
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The Palette Tab displays a large choice of colors. Each
square represents a color. These colors are used to draw out your
design in the View Window. Color one can be thought of as needle
one on the peripheral, but color palette does not control the
peripheral. Colors are supplied to aid in visualizing what the final sew
out will look like. Color one will sew out first, color two will sew out
second, and so on. A number will appear on the color box in the
color palette only when the color is active in the design. Every color is
editable. To edit the colors, you can right click anywhere on the color
palette. Once you right click a color menu will appear with several
features. The first feature is that you can hide the color that you right
clicked on. The second feature is that you can show the color if it is
already hidden. If a color is hidden it will have an X on top of it. You
can also simply left click on a color to show or hide it. An X on top of
the color symbolizes that it is hidden. No X on top of the color
symbolizes that the color is not hidden. From the color menu, you
can also hide all of the colors in the design. If you would like to have
one color displayed at a time, to show the order of sewing for

example, you can use the "walk through colors" tool . The
"walk through colors" tool is displayed after all of the colors boxes in
the palette.

If you would like to change the color of the background (the View
Window area behind the design), right click on the first box in the

color palette .

Another feature of the color menu is the Drag Customization. Once
you are in the Drag Customization mode you can click on a color,
drag it and drop it onto the position where you would like it to be.

The last box in the color palette , represents the color wrap. This
image is always displayed at the end of the colors in the color
palette. Color wrap is explained in more detail under Color
Properties.

The final feature of the color menu is Properties. Refer to Color
Properties for more information.
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Ruler
This is a very useful tool to use if you would like to measure
elements. This function is located as a toolbar button and also under
the View Menu. If you would like to change the units of measure,
you can do that by going to the Tools Menu, selecting Options,
clicking on the Measurement Units and look for Ruler in the list. 

To use this feature click the ruler toolbar button, click on the starting
point from which you would like to measure and drag your mouse to
end point of your measurement. While doing this look to the bottom
of your screen on the status bar to view the measurement. Let go of
your mouse button to start a new measurement. To turn off the Ruler
feature, click on the ruler toolbar button again.

Show Grid 
By selecting Show Grid, a framework of evenly spaced vertical and
horizontal black (default color) lines will be displayed behind the
design in the View Window. The default setting for the spacing of
the grid is .5 inches. All default settings can be changed by right
clicking over the tool and entering the properties menu. You can find
the Show Grid function in two locations: the toolbar button or under
the View Menu.

Show Origin 
By selecting Show Origin, two grey (default color) lines will be
highlighted along the center X and Y axis of the View Window.
Where the two lines cross is where the origin and center of the
design are located. When you center your design it will be centered
here at the origin. All default settings can be changed by right
clicking over the tool and entering the properties menu. You can find
this function in two locations: the toolbar button or under the View
Menu.

Show Stitches in 3D 
This will generate the stitches of a design in the View Window in a
three dimensional perspective.

Besides pressing the toolbar button, you can also hold down the Alt
key and press '3' to turn on "View Stitches in 3D".
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design in 3D
view after
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, then print 



Status Bar
The status bar displays helpful information about your project. The
first box tells you the placement of your cursor. The second box tells
you what level of zoom that you are at. The third box gives you very
important steps for digitizing when you are inputting an element.
Below the status bar boxes you will find helpful information on each
tool when your cursor is above it.

Toolbars
The Menu Bar consists of a window icon , the standard minimize
application, maximize application, exit application, and nine different
menus. The nine menus are file, edit, view, insert, tools, custom,
window, and help.

The Main Bar consists of new file, open file, insert, save, notes, ENS,
cut, copy, paste, undo, redo, print, and about. 

The View Toolbar consists of the zoom tools, ruler, origin, grid, snap
to grid, view in 3D, hide/show graphic, and hide/show stitches.

The Object Toolbar consists of select all, group, ungroup,
previous/next element, color change, trim, return to origin, lettering
to wireframe, change element type, split element, auto lock/trim,
center design, mirroring tools, digitizing assistant (partial), and
digitizing assistant (full) if available.

EDS IV xtreme User Guide 183

16603 Rev.A Melco Embroidery Systems



The Input Toolbar consists of edit mode, manual stitch, walk jump
stitch, walk (normal) stitch, bean stitch, decorative stitch, column 1,
column 2, singleline columns, complex fill, complex hole, lettering,
retrace, satin stitch, zigzag stitch, E stitch, fill stitch, and auto shapes.

The Mini-Palette Toolbar consists of background color, walk through
color, colors, and wrap colors if used. You can also hide/show colors
by clicking on them.

If you would like to not have the toolbars showing, you can turn
them off by selecting View Menu, toolbars, click on the individual
toolbars to hide/show them. You can also do this by right clicking in
the empty grey space to the right of the toolbars.

You can also customize your toolbars to not show some of the tools
or to change the order in which the tools are displayed. To do this,
right click on the toolbar. When a the "customize" pop-up menu
appears, left click on it.

You can move your toolbars around to any place on the screen. To do
this, place your cursor in the far left corner of the toolbar, hold down
the left mouse button and drag it to where you want and let go.

Zoom

Graphical Zoom in allows you to click and drag a box around
the area that you would like to zoom in on. This operation is more
specific than Zoom in.

Zoom in enlarges a portion of the design on the screen. To
move to a different portion use the scroll bars. This is useful for more
precise editing. It does not affect sewing size.

Zoom out decreases the design size on the screen. It does not
affect sewing size.
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keyboard.



Zoom actual displays on the screen the actual sewing size of a
design. After changing the design view, click this tool to bring the
design view back to it's actual sewing size.

Zoom to fit will increase or decrease the design size to fit the
entire design on the screen. Click this tool to display the full design. It
does not affect sewing size.

Fit Selection Zoom allows you to zoom in on a specific area that
you would like to edit. After you have an area selected to edit, click
on the fit selection tool.

Zoom previous will return one previous zoom level. It does not
affect sewing size.

You can find all of the Zoom functions in two locations: the toolbar
buttons or under the View Menu.

Window Menu

View Window
is where you will view the project. The view window can also be
thought of as your work area or work space.

You can have multiple view windows (projects) open at a time.
Through the Window Menu you can arrange multiple windows by
tiling or cascading them.

Inside the view window is also where you will do your editing and
digitizing. This can be done using the menu bar or the toolbar, but
the easiest way is to use your mouse and the right mouse button
function.
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Shortcuts

Zoom Out - ‘-’

Zoom Actual - ‘A’

Zoom to Fit - ‘F’

Zoom Previous - ‘L’
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Color Properties
The three tabs for changing color properties are the Select Tab,
Options Tab and Graphic Background Tab.

Color Chart: The Select Tab lets you choose colors from three
different color charts included with EDS IV. The three different color
charts to choose from are System RGB Colors, ARC Poly Embroidery
Thread, and ARC Rayon Embroidery Thread. To select the different
charts, click on the down arrow and make your selection. If you have
other color charts already installed on your computer (color charts
have a file extension of .tch), you may copy these files through
Windows Explorer and paste them into the EDS IV\Color Data
Directory. These files can now be viewed directly in EDS IV via the
Color Chart list box.

Color: Once you are in the color properties dialogue, you can change
all of the colors in your design. The box next to Color: displays the
number of the color on the palette that you are currently changing.
You can use the up and down arrows to move to the desired color
on the palette. This is very useful. It allows all of the colors to be
changed at one time instead of having to double click on each one
to change them. The current color displays in the color box below.
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The name of the currently applied color and it's graphical
representation display on the top half of the box. If you choose
another color it will display on the bottom of the color box (until
applied, then it is the current choice on top). In the Property page
above shows "640 ARC Rayon" as the applied (current color) and
"345 ARC Poly" as the new color (recent color that has been clicked
on). If the user clicks on "Apply" "345 ARC Poly will be the current
color and displayed on top. When you choose a different Color Chart
than the current one, the Color Selection will automatically scroll to
the closest match color (this is determined by the RGB value of the
color). This closest match color will display on the bottom. You can
choose to apply it or scroll through the Color Selection to another
color.

Color Selection: On the right side of the color properties dialogue
you can choose from a list of colors. The system RGB colors are like
that of other color property dialogues in graphics programs and works
the same.

The ARC Poly and ARC Rayon embroidery thread menus display the
colors of embroidery threads that are available. This is very useful if
you would like to match your colors in EDS IV with the actual thread
colors. The color code numbers are listed below the color. Click to the
right of the color list bar to get close to the desired color, then use the
scroll bar to move through the zoomed version to get the exact color.

Find Color Code: This is very useful to use if you have the code from
the spool of thread and you would like to apply the exact color to your
design. Simply enter the code and once it is highlighted in the zoomed
version of the color list (it will have a blue box around it), click on the
color in the color list. For most color charts, you can also do a find
(search) by name of thread.

Match Chart: If you would like to apply a different color thread chart
than the current one, you can select a different color chart, click on
match chart and all of the colors in 

Order Thread: If you are connected to the internet, this link will take
you directly to everythingembroidery.com where you can order threads
online. The link goes directly to the everythingembroidery.com store.
Once you are in the online store look to the left of the screen where
you will find a link to the section for ordering thread.

Match Chart is a
great tool to
match the color
palette colors to
your "Custom
Color Chart".



Replacement Box: The top half of the color box (on the left of the
color property dialogue) displays what color is currently applied to the
particular color in the color palette. The bottom half displays the new
selection.

Save As Custom: using "Save As Custom", you can create custom
color charts and custom color palettes.

Custom Color Chart: You may want to put together a Custom
Color (thread) Chart that contain certain thread colors. Custom
Color Charts may consist of thread colors from multiple Color
Charts (i.e. colors from both ARC Poly and ARC Rayon).

To save a Custom Color Chart, right click on the color palette, then
click on the "select tab".

1. choose your colors by clicking on the desired color chart (from
the drop down list of color charts).

2. select the color (this is the number next to Color:, for instance
start with color 1).

3. choose a color from the color selections in the chart.

4. click apply.

5. move on to the next color (number next to Color:, for instance
next would be number 2).

6. at this point you may also change the Color Chart for different
color selections.

7. after you have selected all of your desired colors, click on the
"Save As Custom" button.

8. type in a desired name, select the number of colors for your
palette, make sure that Color Chart has a black circle in the
button to the left of it.

9. click OK.

Custom Color Palette: You may want to put together Custom
Color Palettes. For example an embroiderer may have different
custom color palettes that they use for particular designs. When
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Great way for an
embroiderer to
save a color chart
consisting of the
threads they
personally have
on hand (in
stock).



saving a Custom Color Palette you can just right click on the
color palette, select "Load Custom Palette", choose your
desired palette, and click OK.

To save a Custom Color Palette, follow the same steps as you
would for saving a Custom Color Chart (described above), with
the exception of step number 8. In step 8, make sure that
Palette (not Color Chart) has a black circle in the button to the
left of it.

Save As Default: Anytime that you change a setting or settings and
press the Save As Default button your changes will be saved. Even if
you exit out of EDS IV and get back in again, your default settings
will be saved.

The Options Tab gives you several options to change that directly
effect Color Properties.

Color Wrap: This is where you can select how many colors you
would like to have in a color wrap. The way that a color wrap works,
is that for example you have two colors in a wrap. As you are
digitizing you insert a color change, this will bring you to the second
color. When you insert another color change you will be back at the
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first color. In other words you will go through the colors to the last
one and then wrap around to the beginning color. This option also
has a "Save As Default" button.

Left Button Click: The default setting for this is to have the left
mouse button click over a color toggle you through hide/show of
colors. You can change this to "Displays color selection," which will
bring you directly into the color properties.

Select Settings: When you are in the color properties and you are
selecting the colors for your color palette, you can select the desired
color for number 1, click "Apply", select the desired color for number
2, click "Apply", and so on.

Window Settings: If you do not want to have the background color

button shown on the color palette, click in the box next to
"Show background color button". This will remove the check mark
from the box which signals that the button is hidden. The same
applies to the walk through color button "Walk Through Colors"

.



The purpose of graphic background is to provide a view of the
embroidery design against a graphic of fabric. 

To display a fabric on your screen, right click on any existing color box
in the Palette tool bar. Select "Properties". The Color Properties
Dialog box is displayed. Click on the "Graphic Background" Tab.You
can now select a fabric file that will be displayed into the background
of the View Window. To display a fabric, click on the "Browse"
button. Navigate to the C: Program Files directory/Melco Embroidery
Systems/EDSIV/Fabrics. Select a fabric from the list and click on
"Open".

Click on "Apply" to immediately see the fabric on your screen.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.
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Column Tab

Auto-Density: most columns aren't going to be straight from
beginning to end. The width may increase, decrease, and increase
again. In this situation it is very useful to use the Auto-Density option
instead of having to manually insert density changes throughout your
stitchlist. Auto density will determine the density changes for you. To
implement the Auto-Density function, left click in the box. Click again
to remove the check mark which turns Auto-Density off. Below is an
example of Auto Density turned on.

Density = 4

Auto Density On
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Density: refers to the space between each line of stitching. When
this space is decreased, the lines of stitching per inch increases. To
create more lines of stitching per inch, decrease the density value. A
general rule of thumb is:

• As design size increases, density value should decrease.

• As design size decreases, density value should increase.

The default Density setting is 4 points.

Refer to the density conversion chart below for further information:



Column Effects:

There are four effects that can be applied when digitizing columns,
these are Capped Corners, Mitered Corners, Random Edge and
Custom Density.

Corners

Capped and Mitered Cornering are for Singleline and Column1 type
columns. These two methods of stitching around corners give EDS IV
the ability to drastically change its direction of stitching without taking
anything away from the stitch quality or appearance. 

Mitered Corners can be described as two columns with slanted edges
that match up or blend together at the corner (imagine how a corner
comes together on a picture frame, this is what the stitches will look
like on a Mitered Corner when it is sewn out). By inserting a degree
value (75 degrees for example) for Mitered Corners, you are telling EDS
IV that you want the corners of singleline or column 1 columns to have
Mitered Corners once the angle is 75 degrees or smaller. Refer to the
example below to better understand the angle value. 

You also have the ability to determine how much the overlap should
be when the two edges of a Mitered Corner meet (20 points is an
example). Refer to the example below to visualize the overlap of a
Mitered Corner. The following example has a very loose density and
exaggerated overlay values on the stitches view for better visualization.
The highlighted area illustrates the overlay area.
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Capped Corners look like there is a "cap" over the area where two
columns meet at a point. By inserting a degree value (45 degrees for
example) for Capped Corners, you are telling EDS IV that you want the
corners of singleline or column 1 columns to have Capped Corners
once the angle is 45 degrees or smaller.

You also have the ability to determine how much the overlap should
be (3 points for example). Refer to the example below to visualize the
overlap of a Capped Corner. The following example has a very loose
density and exaggerated overlay values on the stitches view for better
visualization. The highlighted area illustrates the overlay area.

Automatic Smooth Cornering is for Singleline and Column1 type
columns. This involves automatically inserting pairs of straight points
on each corner edge to allow for smoother stitching around the
corner. Automatically inserted points may be converted to wireframe
points by right clicking on the element and selecting "Convert Corners
to Wireframe".

You have full control over this feature via the "Column Effects"
property page, which gives you the ability to toggle each feature. You
also have control over which angles capping and mitering will occur,
allowing one method to take precedence over the other. 

Column 1 and Singleline corners only have the ability to be capped
and/or mitered if a pair of straight points binds them. A mismatch of
points (i.e. a straight point on the inside edge and a curved point on
the outside edge or vice versa) or a pair of curved points, will result in
our current standard method of cornering being applied. For
automatic smooth cornering to occur the corner must be bound by
straight points as well as having straight edges. 

You can have multiple types of corners turned on and set for different
degrees of angles. On the next page is a picture of the Corners Tab.
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Random Edge

Random Edge is very useful in embroidery to create the effects of
shading, the look of hair and many other possibilities.

Random Edge allows the user to specify a column edge stitch length
variance. This means one or both sides of a column are randomly zig
zaged in and out instead of the usual even column edge. This effect
can be applied to side one, side two or both column sides. Random
Edge applies to all of the following column stitch types: Satin Stitch,
Fill, E Stitch, and ZigZag.

When applying Random Edge to a column, select edge one, edge
two, or both edges. Next select the width percentage from 0 to
100%. The width percentage represents the range of variation width.

Note that the Random Edge Data cannot be saved as part of a
condensed file.

On the next page is a view of the Random Edge Property Tab:
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Below is an example of Random Edge combined with Custom
Density
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Custom Density

Custom Density has been added to this version of EDS IV. Custom
Density allows the user to specify variable density often used for color
blending. Accordion Effect will apply to all of the following column
stitch types: Satin Stitch, Fill, E Stitch, and ZigZag.

Note: Custom Density Data cannot be saved as part of a condensed
file.

Inverse check box will be applied to the standard accordion types
listed in the combo box. It will have the following effects:

• Linear Increasing shows Linear Decreasing

• Convex shows Concave

• Exponential Increasing shows Exponential Decreasing

• Wave Increasing shows Wave Decreasing

• Custom

Below is a view of the custom density property tab:
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Below is an example of Custom Edge Combined with Decorative
Stitch

Save As Default: Anytime that you change a setting or settings and
press the Save As Default button your changes will be saved. Even if
you exit out of EDS IV and get back in again, your default settings
will be saved.

Short Stitches: When digitizing columns, particularly letters or
numbers, stitches will build up on the inside of a sharp arc or turn in
the design. This build-up often causes thread breaks because stitches
begin to fall on top of each other at the same location. Even if thread
breaks don't occur, the look of the stitching may not be ideal. Using
the short stitch option prevents this build-up by inserting shorter
stitches throughout the curve or turn making it a much smoother
transition. The software determines where short stitches should be
inserted based on the relative length of the sides of a column
segment, their length as a percentage of the actual distance across
the column, and how many will be generated between any two
normal length stitches as shown in the example on the next page.



The default setting is for short stitches to be On since short stitches
will only be generated where the software determines short stitches
will be needed to prevent stitches on top of stitches. If you would like
to turn short stitches Off, left click in the box next to the short
stitches option.

Stitch Type: You have the option of choosing from four different
stitch types which are Satin, Fill, E Stitch, and Zigzag.

Column Fills: When choosing a "Fill" type of column,
besides the standard column properties you also have the options to
enter the stitch length, the number of partitions, and the partition
sequence. Refer to the Fill Tab section (page 204) where you can find
information on partition fills. Note: you can not use pattern fills on
columns.  

Underlay: Underlay is used to help keep the material from stretching
or distorting during the top stitching process and to hold the stitches
out of the nap of the fabric. The Primary Underlay is the first underlay
that will stitch out. Secondary Underlay may be selected as well if you
would like two types of underlay. There are three types of underlay:

• Center Walk Underlay: is a walk stitch down the middle of the
column. After selecting a center walk underlay, you have the
option to change the stitch length. The default stitch length is set
at 30 points.

• Edge Walk Underlay: is a walk stitch that runs along the edge of
the column. After selecting an edge walk underlay, you have the
option to change the stitch length and the percentage of the
column width where you would like the edge walk to appear.
The default stitch length is set at 30 points. The default width
percentage is set at 70%.
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A good reason
for changing your
column type to fill
is in the instance
where your
columns are too
wide for a
standard satin
type of stitch.
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• Zigzag Underlay: is a walk stitch that zigzags from left to right
down the length of the column. After selecting a zigzag underlay,
you have the option to change the stitch length and percentage of
the column width where you would like the underlay to appear.
The default stitch length is set at 15 points. The default width
percentage is set at 70%.

Underlay is available for Satin, Fill, and Zigzag type columns.

Width: You can change column width by percentage. The default
setting for column width is 100%, which can also be referred to as
actual size. To make columns bigger, choose a percentage over 100%.
To make columns smaller, choose a percentage below 100%.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is that
you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.

Design Tab

Name: This will display the name of the design. You can change the
design name by clicking in the white area, selecting the text, and
typing the desired name.
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Fill Tab

Partition Fill: There are 16 pre-defined fills containing from 1 to 8
partitions in various combinations of fill parameters. These fills may
be selected and used in digitizing.

The different parameters are as follows:



Load Partition Fill: By pressing the down arrow below Load
Partition Fill, you can select the desired fill by name.

Fill View/Select: By pressing this you will get a graphical list of all of
the saved partition fills.

From here you can click and select the desired fill then press OK. This
is very useful to visualize how the fill will stitch out.

EDS IV xtreme User Guide 205

16603 Rev.A Melco Embroidery Systems



Pull Compensation: The primary use of this feature is to
compensate for the pull. When the pull compensation value for a
given complex fill is changed, all adjustments will be made with
respect to each individual stitch line length and direction. For
example, if the pull comp. is set to 103% for a given complex fill,
each individual stitch line will be increased in length by 3% with
respect to its current stitch direction. To visualize how the stitches
compensate in the direction of your stitch direction, grab an end of
your stitch direction line and rotate it to another position, view the
example below:

The reason for using pull compensation has to do with the way
stitches pull on different types of fabric. For example, you may have a
circle type of fill with an outline, sewing this on certain fabrics may
cause the circle to pull inward after being sewn on the fabric and not
be the perfect circle that it was digitized as. Also, the outline may not
exactly line up with the circle as it should. Using the pull comp
feature can correct a situation like this. Like many things in
embroidery, knowing which values are best for the different types of
fabric will take practice.

You can slide the slider bar using your mouse, click and drag the
rectangle to the right side for positive pull compensation and to the
left for negative pull compensation. 

Beside the click and drag method, you can also use your left and
right arrow keys on your keyboard to change the percentage value. 
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Wireframe Outline

Stitch Direction Line

If you want to
remove the pull
compensation
from the fill,
simply move the
slider bar back to
the 100.0 (100%)
position. 
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Save As Default: Anytime that you change a setting or settings and
press the Save As Default button your changes will be saved. Even if
you exit out of EDS IV and get back in again, your default settings will
be saved.

Save Partition Fill: You can create your own partition fills by selecting
different combinations of parameters. If you would like to save the
new set press the Save Partition Fill button.

From here you can then designate a number and a name for the new
fill then press OK. It will then be added to the partition fill select list,
which you can get to by pressing the down arrow under "Load
Partition Fill" or by pressing Image Select.

Trapunto: will allow you to move the underlay of a complex fill to the
side of the element, instead of through the middle. This will prevent
the underlay from being conspicuous on larger space values or higher
density fills. Click to insert a check mark in the box next to Trapunto to
apply this type of underlay, click in the box again to un-apply trapunto.
You have the option to apply trapunto or underlay, not both. Below is
an example of a complex fill with trapunto applied.

Without Trapunto With Trapunto



Underlay: You have the options of turning on underlay and applying
it to a fill. Click to insert a check mark in the box next to Underlay to
apply underlay, click in the box again to un-apply underlay.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.

Graphic Properties
When you double click on a graphic or image a Properties dialogue
with three tabs will appear.

Under the Graphic General Properties tab you can view the name of
the graphic and it's location. Besides the View Menu, you can also
see that that General Properties tab gives you the ability to
Hide/Show and Dim/Brighten the graphic. You can hide the graphic
by putting a check mark beside Hide with your left mouse button. If
the graphic is already hidden and a check mark appears beside Hide,
then click again on Hide to Show the graphic. You may want to hide
a graphic when you are digitizing to view the progress of your work
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better without the graphic behind the stitches. If you would like to
see your stitches a little bit better, but not completely hide your
graphic, you can left click to place a check beside Dim. Left click
again to Brighten the graphic. Practice Hide/Show and Dim/Brighten.

Click on the Position tab. Here you can change the position and
orientation of the graphic.

Position represents the number of embroidery points (1/254th of an
inch) that the center of the image is offset from the center of the
design (or View Window). This allows you to move your image with
respect to the design.

X offset allows you to move the image left or right. Enter positive
values to move right. Enter negative values to move left.

Y offset allows you to move the image up or down. Enter positive
values to move up. Enter negative values to move down.

Orientation gives you the ability to manipulate the horizontal and
vertical presentation of the image. This function presents
combinations of axis mirroring and axis property swapping in such a
way to present the 8 views shown in the orientation box as you click
on the box.

The F in the orientation box represents the position that the image on
the screen is currently being presented.



The image modification attributes are only saved when you save
them as a project.

Practice changing the position and orientation of the graphic to view
how it changes.

The third tab in the Graphic Properties is for scaling the graphic or
image. 

The scale can be proportional or non-proportional depending on
whether or not you have checked the "Proportional" box. If you left
click, which places a check mark in the box, the horizontal scale is
exactly the same as the vertical scale. This will keep the image from
being distorted. If the "Proportional" box is not checked, then you
can scale just the Horizontal axis or the Vertical axis. You can enter a
percentage or a measurement. These are linked, so if you change a
percentage the measurement changes proportionally.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.
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Grid and Origin Properties

Display Above Embroidery Objects: Click in the box next to this
option to have the grid and origins lines displayed above the
embroidery that is in the View Window. A check mark in the box
symbolizes that the lines will be displayed in front of (above) the
embroidery whereas having no check mark in the box symbolizes that
the lines will be behind the embroidery.

Grid: You can click in the box next to Display Grid to display or not
to display the grid lines in the View Window. A check mark in the
box symbolizes that the grid lines will be displayed whereas no check
mark symbolizes that the grid lines will not be displayed.

• Grid Color: If you would like to change the color of the grid
lines, click on the box next to Grid Color:. This will take you to a
color dialogue where you can choose another color then click
OK. The default color is grey.

• Grid Spacing: This gives you the option to change the spacing
between the grid lines. Click in the white area next to Horizontal:
to change the spacing between the horizontal lines. After clicking
in the white area simply type in a desired measurement. You can
also use the up and down arrows to change the measurement
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value. Click in the white area next to Vertical: to change the
spacing between the vertical lines.

• Grid Type: You can choose whether you would like the grid lines
to be displayed as lines or as dotted lines. To do this, click in the
radio button next to the desired choice.

• Method: This gives you the option to display only horizontal
lines, only vertical lines, or both horizontal and vertical lines. To
do this, click in the radio button next to the desired choice.

Origin: You can click in the box next to Show Origin to display or not
display the origin lines in the View Window. A check mark in the box
symbolizes that the origin lines will be displayed whereas no check
mark symbolizes that the origin lines will not be displayed.

• Origin Color: If you would like to change the color of the origin
lines, click on the box next to Origin Color: This will take you to a
color dialogue where you can choose another color then click
OK. The default color is black.

• Origin Type: You can choose whether you would like the origin
lines to be displayed as lines or as dotted lines. To do this, click in
the radio button next to the desired choice.

Save As Default: Anytime that you change a setting or settings and
press the Save As Default button your changes will be saved. Even if
you exit out of EDS IV and get back in again, your default settings
will be saved.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.



Hoop Manager
This feature allows the user to display numerous different types of

hoops on the screen.  Right click on the "Hoop Control" button 
to access the hoops.

The Hoop Manager dialog box will appear.  

Machine Manufacturer: Click on the "Machine Manufacturer"
arrow to display a list of many embroidery machine manufactures.
The manufacturer will determine which hoops are shown in the
"Machine Name" list.  By selecting ARC - Melco in the "Machine
Manufacturer" list, the user may then use the "Machine Name" list
to select the specific ARC - Melco hoop types.

Hoop Attributes: Hoop Attributes may be viewed by selecting the
hoop type from the "Name" list.  The pre-defined hoops have
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programmed dimensions which will display but will be grayed out,
which means the user can not change the information. 

Click on apply to view the hoop on the screen.  The solid line
represents the inside edge of the inner hoop.  The dotted line
represents the inside edge of the inner hoop minus the sew margin.  

New Hoop: User defined hoops may be setup by selecting "New
Hoop" from the "Name" list.  The type of hoop can also be defined
(Rectangular, Circular, square, etc.).  

• The X Dimensions the width of the hoop from left to right and
the Y Dimensions are the height of the hoop from top to
bottom. These measurements should be the outside edge of
one side to the outside edge of the other side.

• The X and Y offset is the distance from the machine origin to
the hoop center.  All the Melco hoops have offsets
preprogrammed to work. 

• The Hoop Thickness is the width of the outside edge of a hoop
wall to the inside edge of a hoop wall.

• The Sew Margin is the distance between the inside of the hoop
wall to your hoop limit. By saying Hoop Limit, this is the very
edge that stitches may be sewn. The sew margin area should
give ample clearance for the needle/pressure foot. This is
important so that your needle/pressure foot does not touch the
hoop.

Trace: After selecting a hoop, you can click on the trace button and
EDS IV will trace your design and give you a message stating that
your hoop fits or that it does not fit in the selected hoop.

Advanced: Under the advanced button you will find the individual
sew margins for let, right, top, and bottom of the hoop. These are
adjustable in the case that you would like to have a larger sew
margin on one side then on the other.
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Lettering Tab

Alphabets: To select the font or alphabet that you would like the
text design to appear in, left click on the down arrow on the
Lettering Tab, located under the Letter Stitch Order box and above
the Letter Height box.

Closest Point: When a closest point alphabet is used, you may
choose to have the letters connected using the closest point. Click
the box next to Closest Point Connection to place a check mark in
the box that symbolizes that the function is On. This will
automatically insert the entry and exit points at the closest point
between the letters. Click in the box again to remove the check
which symbolizes that the function is Off.

Color Change Command (keyboard shortcut F6): A color
change command will instruct the peripheral to pause for a rethread
on single-needle machines, or to change to a different needle on a
multi-needle machine. It also changes the color in the View Window
to the next color in the palette.

For instructions
on using
alphabets, please
refer to the
alphabet code
sheet for that
alphabet.
(alphabets.pdf,
also located in
your HTML Help
System).
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To add a color change in the text dialogue box, place the cursor

between the letters and click . A ^ symbol marks the color
change.

Customized Spacing: Sometimes text is too crowded or
too loosely spaced. This often happens to arc lettering. To illustrate
customized spacing, you can do the following exercise:

"Place Letters On Arc" box. Click "OK". Your image should look like
the first one in the image to the right, Notice that E,M, and B are
closer together than the rest of the letters.

Right click or double click anywhere on the element to get to the
properties page. Now place your cursor between the Letters E and M.

Click the button or press F8 to add space. Click between the
letters M and B. This command will display in the text dialogue box
as this » symbol. Press "OK". Your image should now look like the
second one that is displayed to the right. Each » adds a space equal
to 1/16 of the letter height. For example, with a 1" letter, the space
would be 1/16". With a 0.5" letter, the space would be 1/32".

You can also decrease the space between letters that are too far
apart. Again, you should place the cursor in the text box between the
letters that are too far apart, in the text dialogue box. Next click the

button or press F7 and a « symbol will appear in the text box.
Click OK and the letters will move closer together. Each « subtracts a
space equal to 1/16 of the letter height.

First, select Athletic Block (do
this by clicking the drop-
down arrow that is below the
spacing buttons). Now set
letter height to .75 and type
DECEMBER in the text
dialogue box. Next click a
check mark into the 

Increases
Space = F8

Decreases
Space = F7
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Fabric Adjust: When you click on this button, a Fabric Adjust
Dialogue box will appear.

Because lettering is so exact and may be very small, it is possible for
the actual sew out to turn out different from the way that it looks in
the View Window when it was digitized. This is especially true when
you are sewing on different types of material. The lettering may
bunch up or become knotted, even in a way that is illegible. This may
happen because of the material that you are sewing on. You can
prevent this from happening by first selecting the type of fabric that
you are using, here on the Fabric Adjust Dialogue box. Select the
fabric by left clicking on one of the types. Light knit is an example of
type. After you have selected the type of fabric, you must select the
Letter Size Range as well. Fabric Adjust will not implement any
changes without both the Fabric and the Letter Size Range being
selected.

After you have selected the fabric and letter size range, Fabric Adjust
will change some of the default settings on the Lettering Properties
accordingly. You will notice a change in Stitch Length on the Lettering
Tab. You will also notice changes in Density, Column Width, and
Primary Underlay Type on the Column Tab.

Letter Height: This is where you can set the overall height of a
capital letter. The default is one inch.
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Letter Width: This increases or decreases the overall width of each
letter. The value is set at 100%, which is actual size. To increase the
letter width, type in a percentage that is greater than 100% up to
190%. To decrease the letter width, type in a percentage less then
100% down to 0%. Below is an example:

Monogram: When using a non-monogram alphabet to create a
monogram you can do this by clicking in the box next to monogram.
A check mark in the box symbolizes that this function is on whereas,
no check mark symbolizes that this function is off. For standard
monogram alphabets (3 letter alphabets like 3 Letter Circle), you
don’t have to turn on the Monogram feature in EDS IV.  This is
automaically turned on for you.

Monogram Properties: When using a non-monogram alphabet you
have the option to change the letter height and/or density of the
individual monogram letters, click the "Monogram Settings" button.
The following dialogue box will pop-up:

Place Letters On Arc: When you choose to place letters on an arc
the text will curve, To select this function left click. A check mark will
appear in the small box to the left symbolizes that this function is
turned on.

For instructions
on using
monogram
alphabets and
their borders,
please refer to
the alphabet
code sheet for
that alphabet.
(alphabets.pdf,
also located in
your HTML Help
System).
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Arc Properties: When placing letters on an arc you have the option
to change the arc properties. You can change the radius, the angle,
and the direction. To change the direction, click the radio button for
CW (clock wise) or CCW (counter clock wise).

Arc Radius: The radius of a circle is the distance from the center of
the circle to the circumference of the circle. The longer the radius, the
less the amount of curvature in the arc (an arc is a piece of a circle).

Arc Angle: The arc angle is a position on a circle where the center of
your lettering will be located. This position is entered in degrees; with
0 (zero) degrees being the top of a circle, and 180 degrees being the
bottom of a circle.
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Angle Type CW or CCW: The angle type is a direction of sewing. In
most cases, you will want to be sewing in a CW (clockwise) direction
if the arc angle is in the top half of a circle. You will want to be
sewing in a CCW (counterclockwise) direction if the arc angle is in
the bottom half of the circle.

A common occurrence when sewing counterclockwise is that the
letters may touch. To correct this, you must use some positive
horizontal spacing between the letters. 

Even though the word "Denver" was entered first before
"Colorado", the design sews as shown above when you have your
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arc properties set at 180° and CCW. This can be corrected by making
the "Line Spacing" a negative value, example -1 instead of the
default 1. The Sewout will then look like the example below.

Save As Default: Anytime that you change a setting or settings and
press the Save As Default button your changes will be saved. Even if
you exit out of EDS IV and get back in again, your default settings
will be saved.

Sequenced Lettering: There are many options available that can be
applied to the stitch order of your letters or lines of text.  

Letter Stitch Order: This option gives you more control of how
each letter will sew out.

Left to Right - Stitching will start with the left letter and proceed
to the right.

Right to Left - Stitching will start with the right letter and
proceed to the left.

Center Out - Stitching with start in the middle and proceed to
the farthest right, then come back to center and proceed to the
farthest left.  

Note:  Center out stitching  is commonly used to solve problems with
registration, such as caps and difficult fabrics.
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Line Stitch Order: This option gives you more control of how each
line will sew out.

Top to Bottom - Stitching order will start with the top line of
letters and proceed to the bottom line.

Bottom to Top - Stitching will start with the bottom line of
letters and proceed to the top.

Line Wrapping - Stitching will start at the side specified by the
letter stitch option, left-to-right or right-to-left and alternate the
direction for each of the lines of the lettering object.  Center out
letter stitch order is not available with line wrapping.

Slant Angle: This inclines lettering in increments of one from +15 to
-15. Positive values slant lettering to the right and negative values
slant lettering to the left. Below is an example:

Spacing

• Horizontal Spacing: By putting a positive value here,space will be
added in between the letters. A negative value will take away
space between the letters.

• Line Spacing: If you have multiple lines of text, you can increase
or decrease the spacing in between the separate lines. 

• Vertical Spacing: By putting a positive value here, vertical height
will be added in between each letter, so that each letter is higher
than the one before. A negative value will cause each letter to be
lower than the one before.

Here is an
example of
changing line
spacing: If you
have 1.00 inch
letter height you
could add half of
that (.50) to
equal 1.50 inch
line spacing for a
sufficient amount
of space between
the lines.



Stitch Length: This determines the length of each walk or manual
stitch used to move from one area of sewing to another or as the
underlay. These stitches are often covered by column stitching. The
default is 30 points for 1 inch letter height. Use the table to the right
as a guide when changing letter height:

Text Dialogue Box: When you click inside the large white box, your
cursor will appear in the top left corner. This is where you will type
out your text design.

Trim (keyboard shortcut F9): A trim command causes
peripherals equipped with trimmers to perform a trim between each
letter. Trims between lower case script lettering are unnecessary. Add
a trim in the text dialog box placing your cursor (left clicking)
between the letters you want to trim. When the cursor appears, click

the button or press F9. A ¤ symbol will appear in the text
dialogue box to mark the trim. There will be no visible difference in
the View Window.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.

Stitch Length

30-40 points

25-30 points

20-25 points

Lettering Size

0.5 inch or greater

0.25 inch to 0.5 inch

0.25 inch or smaller
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It is a good idea
to press the
“Auto Lock/Trim”

button on
the toolbar to
update your
project view.
Especially if you
have already set
your Lock/Trim
settings and then
continued
digitizing.



Lock Stitch/Trim Tab

Lock Stitches are several small stitches sewn to prevent stitching from
being pulled out. The term "tie in" refers to lock stitches that are
placed at the beginning of an embroidery element to lock the first
stitches in to place. The term "tie off" refers to lock stitches at the
end of an embroidery element to lock the last stitches in to place.

Lock Stitch If Connector Greater Than: You can click in the box
next to this function to have lock stitches inserted only when the
connector length (distance between two elements) is greater than a
desired length. A check mark in the box symbolizes that this function
is on whereas no check mark symbolizes that this function is off. To
specify length, click in the white area next to this option and enter
the length.

None: No automatic lock stitches will be inserted.

Save As Default: Anytime that you change a setting or settings and
press the Save As Default button your changes will be saved. Even if
you exit out of EDS IV and get back in again, your default settings
will be saved.
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Tie In: Will only insert a “tie in” in every element.

Tie In & Tie Off: Select to insert a “tie in” and “tie off” in every
element.

Tie Off: Will only insert a “tie off” in every element.

Trim If Connector Greater Than: You can click in the box next to
this function to have trims inserted when the connector (distance
between two elements) is greater than a desired length. A check
mark in the box symbolizes that this function is on whereas no check
mark symbolizes that this function is off. To specify length, click in
the white area next to this function and enter the length.

The Lock/Trim Tab allows you to make lock and trim settings per
element including the connector length settings. In the situation
where multiple elements are selected:

• If the elements do not all have the same lock settings, then the
property page will not have any of the choices selected. If you
select one, then all of the selected elements will now have that
option.

• In some of the elements have trim on and others off, the Trim
checkbox will show up with a gray check mark.

• If the elements do not all have the same connector greater than
fields, then a 0 will show.

All of the "Lock Stitch" properties also apply to the individual letters
in a lettering element as well. Please consider the following tips when
it comes to lettering:

• Many alphabets already have (tie off) lock stitches already in
them. If lock stitches are turned on through the Lock/Trim
properties, existing lock stitches will not be deleted and additional
lock stitches may be generated.

• When "Trim if connector greater than" is on, it places a trim
command at the end of each letter in a lettering element, but
trims that are generated through the function will not be
displayed in the text box on Lettering Tab.

• No trims will be allowed between letters of closest point
alphabets.
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In order to view
actual tie ins /
tie offs in your
view window,
you can save
the design as a
machine format
and then open
and look at the
expanded stitch
view.



Lock Stitches and Trims for Lettering:

When inserting a lock stitch or trim into a lettering element, what
happens will depend on if the alphabet is a closest point alphabet or
a non-closest point alphabet. Refer to the chart below for help.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View

Lock Stitch
Function

Closest Point
Alphabet

Non-Closest Point
Alphabet

Tie In & Tie Off A lock stitch will
exist at the start of
the first letter and
the end of the last
letter.

A lock stitch will exist at
the start of each letter and
at the end of each letter.

Tie In A lock stitch will
exist at the start of
the first letter.

A lock stitch will exist at
the start of each letter.

Tie Off A lock stitch will
exist at the end of
the last letter.

A lock stitch will exist at
the end of each letter.

Add Lock There will not be
any lock stitches
generated, unless
there are color
changes between
letters.

A lock stitch will exist at
the end of any letter and
the start of any letter
where the distance
between those stitches is
greater than the user
specified length. Also, a
lock will exist if there are
color changes between
letters.

Add Trim There will not be
any lock stitches
generated, unless
there is a trim
between letters.

A lock stitch will exist at
the end of any letter and
the start of any letter
where the distance
between those stitches is
greater than the user
specified length. A trim
will be added between the
letters.
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Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.

Position Tab

Orientation: Sometimes design orientation must be altered for
proper results. To change the orientation, click on the F to the right
of Orientation until the desired orientation displays.

Rotate: Positive degree values rotate the element clockwise and
negative degree values rotate the element counter-clockwise.

X: This type of movement will move the element to the left or right
on the X axis in inch values. Positive values move the element to the
right. Negative values move the element to the left.

Y: This type of movement will move the element up or down the Y
axis in inch values. Positive values move the element up. Negative
values move the element down.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
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changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.

Project Tab

File: The location and file name of the project will be displayed here.

Project Level Settings: These settings let you change the Maximum
Stitch Length for all elements within a project, The Connector Stitch
Length throughout a project, and you can have Return To Origin on.

Save As Default: Anytime that you change a setting or settings and
press the Save As Default button your changes will be saved. Even if
you exit out of EDS IV and get back in again, your default settings
will be saved.

Workspace Area: The Workspace Area is the area within the View
Window where you do your editing and digitizing. If your stitches fall
out of the Workspace Area, you can use the scrollbars to move
around your project. You can also change the height and the width
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measurements by clicking in the white area and typing the desired
measurement. The default settings are 16 inches by 16 inches. You
can press the Save As Default button to have new projects open with
the desired measurements.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.

Scale Tab

By scaling, you can reduce or enlarge an element horizontally,
vertically, or equally in both directions. When you scale an element,
all of the embroidery properties are preserved. After the scaling
modifications are complete, the stitches are re-generated according
to the new outline that you have created.
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You can scale multiple elements. You can also scale elements
manually in the View Window.

Proportional: By having this option on (with a check mark in the
box), you are sure to scale the design equally both the horizontally
and vertically. If you would like to only scale horizontally or only scale
vertically, you can turn this option off by clicking on the Proportional
box (which will remove the check mark).

Horizontal: This is where you can specify an exact percentage or
measurement to scale horizontally.

Vertical: This is where you can specify an exact percentage or
measurement to scale vertically.

Expanded Stitch Processor: This version of EDS IV contains an
expanded stitch processor. The stitch processor is invoked when
scaling an expanded design. It will automatically increase or decrease
the design stitch count when the design is scaled up or down.

Note that when scaling expanded designs the stitch length does not
change.

The expanded Stitch Processor is always enabled when graphically
scaling an expanded design. To scale an expanded design without
stitch processing, follow the steps listed below:

1. Un-check the "Expanded Stitch Processing" control on the Scale
Tab.

2. Enter the desired scale factors.

3. Click on Apply or OK.

When wanting to scale an expanded design with stitch processing,
you also have the options to change the Column/Satin Density
percentage and Fill Density percentage. To do this, you will need to
click on the "Stitch Processing" Tab. Below is a picture of the Stitch
Processing Tab:
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Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.
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To maintain
approximately
the same density,
the Column and
Fill Density
controls should
be set to 100%.

You may not
want to use
stitch processing
while scaling an
expanded design
for the following
reasons:

• If you are
scaling 30 -
40% more or
less than
original.

• If you are
scaling more
than twice
the size of
the original.



Singleline Tab

Save As Default: Anytime that you change a setting or settings and
press the Save As Default button your changes will be saved. Even if
you exit out of EDS IV and get back in again, your default settings
will be saved.

Width: This gives you the option of changing the width
measurement for Single line center, Single line left, and Single line
right.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.
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Status Tab

The Status Tab allows you to quickly review the statistics of the
selected element, design, or project. This tab is not editable.

Distance From Origin

• End: The end measurement that is below the X displays the
distance of the last stitch point in relation to the X axis. The end
measurement that is below the Y displays the distance of the last
stitch point in relation to the Y axis.

• Minimum: The minimum measurement that is below the X
displays the most minimum point of an element in relation to the
X axis. The minimum measurement that is below the Y displays
the most minimum point of an element in relation to the Y axis.

• Maximum: The maximum measurement that is below the X
displays the most maximum point of an element in relation to the
X axis. The maximum measurement that is below the Y displays
the most maximum point of an element in relation to the Y axis.

Size: This shows the status of the element in inches and points. The
measurement below the X is basically the horizontal measurement of
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the element. The measurement below the Y is basically the vertical
measurement of the element.

Stitches

• By Color: This gives you a list of how many colors and the total
stitch count per color.

• Longest: This gives you the longest stitch of the element, design,
or project.

• Shortest: This gives you the shortest stitch of the element,
design, or project.

• Total: This gives you the total stitch count of the element, design,
or project.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.
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View Tab

Here is where you can choose what you would like to display in the
View Window. To show these items in the View Window, click in the
box that is to the left of the option. A check mark in the box
symbolizes that the option will be displayed. Click again to remove
the check mark, which symbolizes that the option will not be
displayed.

Save As Default: Anytime that you change a setting or settings and
press the Save As Default button your changes will be saved. Even if
you exit out of EDS IV and get back in again, your default settings
will be saved.

Show Connectors: This lets you view the connecting lines between
elements. Basically they can be thought of as the needle movement
from a tie off on one element to the tie in of another element.
Connectors are viewed as dotted black lines in the View Window.

Show Expanded Points: This lets you view the expanded points of
a design.

Show Stitches: This lets you view the stitches as they would appear
in a sew-out.

EDS IV xtreme User Guide 235

16603 Rev.A Melco Embroidery Systems



Show Wireframe Lines: This lets you view the wireframe outline of
the element.

Show Wireframe Points: This lets you view the wireframe points of
the element.

Anytime that you are in a property page, you can click "Apply" after
making a change and it will immediately apply your change. The
advantage of using "Apply" verses clicking "OK" after a change is
that you can apply your changes and still move on to making other
changes. Once you click on "OK", your changes will be applied and
the property dialogues will close and you will be back at the View
Window. You can also click "Cancel" and the property dialogues will
close without implementing the last change.

Walk Stitch Tab

Retrace: When you digitize a walk stitch and have the retrace on,
the walk stitch will be stitched out twice, the second walk stitch on
top of the first walk stitch. This is useful in making a single walk
stitch appear thicker. To turn this function on, left click in the box
next to "Retrace." A check mark will appear to symbolize that this
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function is on. Click again to remove the check mark, which
symbolizes that this function is off.

Another method to click on the Walk Stitch Button , click on the

Retrace Button and start digitizing. Click again on the Retrace
Button to turn Retrace off. If Retrace is applied to a walk stitch, it will
display "Retrace" in the Project View. To un-apply Retrace to a
particular element, you need to go into the Walk Stitch Property
page, un-click the checkmark next to "Retrace", click "OK.

Save As Default: Anytime that you change a setting or settings and
press the Save As Default button your changes will be saved. Even if
you exit out of EDS IV and get back in again, your default settings
will be saved.

Stitch Length: Here you can a insert a measurement to determine
stitch length.

Stitch Type: The three stitch types that you have to choose from are
Normal, Bean, and Decorative.

• Walk Normal Stitch: This is a normal walk stitch with automatic
needle penetrations in between each element input point.

• Walk Bean Stitch: Where a normal stitch lays one length of
thread down for each stitch, a bean stitch lays down three
lengths of thread. When choosing Bean stitch you have the
option to change the thickness of the stitch.

• Walk Decorative Stitch: From within the Walk Stitch Properties
you can select Decorative Stitch under Stitch Type. You can then
select which saved stitch you would like to use, by pressing the
drop down arrow next to Stitch: or press the Image Select button
to see a graphical version.
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Anytime that you are in a property page, you can click "Apply"
after making a change and it will immediately apply your change.
The advantage of using "Apply" verses clicking "OK" after a
change is that you can apply your changes and still move on to
making other changes. Once you click on "OK", your changes
will be applied and the property dialogues will close and you will
be back at the View Window. You can also click "Cancel" and
the property dialogues will close without implementing the last
change.
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Digitizing Assistant

Introduction
This is an overview of the Digitizing Assistant module, how it works,
and its intended use.

Digitizing Assistant is an advanced automation software module,
which allows custom artwork (either from a scanner or paint
program) to be directly converted to embroidery design data for EDS
IV. More specifically, Digitizing Assistant has been designed to
dramatically reduce the amount of time and expertise needed to
create sophisticated embroidery designs from original artwork. To
accomplish this design goal, Digitizing Assistant incorporates state-of-
the-art image processing and artificial intelligence technologies that
effectively duplicate the operations that an expert digitizer would
perform when punching artwork by hand. For the digitizer, this
translates into tremendous time savings, in some cases allowing work
that would normally take hours, to be completed within minutes.
Alternatively, for the small embroidery shop, Digitizing Assistant may
allow users to forgo the cost and time required to send out basic
artwork for custom embroidery punching. Digitizing Assistant
software does not eliminate the need for expert digitizers. However,
for typical business logo artwork or basic clipart the software can
provide an enormous savings in time and effort and can significantly
reduce the amount of training or expertise required to quickly create
custom embroidery designs.

Documentation Overview
The remainder of this chapter covers the general principles that must
be understood in order to use Digitizing Assistant for EDS IV most
effectively. This includes an explanation of the type and quality of
images that should be used as input, as well as some common pitfalls
that you may encounter when using an automation system such as
this. After this overview is presented a basic tutorial is provided that
allows you to become familiar with most of Digitizing Assistant's
features while working on real designs. After completing all of the
tutorials, a user should be fairly proficient using the system. Finally,
you will find references that contain detailed descriptions of all
program features and their intended use.
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What kinds of images will Digitizing Assistant for EDS IV work
with?

Digitizing Assistant will only import 24-bit color graphic files or
scanned images that are scanned using 24-bit color (i.e. millions of
colors). Images must be of a high resolution for the software to work
properly, usually at least 300dpi (dots per inch). Within these
restrictions, the software is designed to convert two classes of
images, "clean" images or "noisy" images. Clean images require less
processing and typically originate as clip art or some other machine
generated artwork (i.e. they are not scanned or if they are scanned,
they have been cleaned of all noise prior to processing). Clean images
do not have half-toning, dithering, anti-aliasing or any other feature
that may make the image appear blurry or imprecise. Thus, clean
images basically consist of clear large well-defined regions of solid
colors. What follows below are more specific descriptions of these
two classes of images and how to distinguish between them.
Knowing about the quality and type of source image that one is
working with will allow a user to determine what types of operations
need to be performed such that high quality embroidery may be
generated. Also note that the examples directory (installed with your
EDS IV software; default: C:\Designs\Graphics) contains some
complete examples of noisy and clean images (all Floral designs and
Earthday are noisy, others are clean). You may want to review some
of these examples in order to gain a better idea of the differences
between these types of images. In terms of using Digitizing Assistant
with these types of images, clean images typically require less
processing and can be automatically converted to embroidery using a
simple three-step process. Alternatively, noisy images must undergo
some additional processing by the system that effectively transforms
them into clean images first. Or if a user prefers, an image may also
be cleaned using third party photo editing or paint programs.

How to determine whether an image is clean or noisy

As briefly described above, noisy images may have several distinct
features which distinguish them from clean images. In many cases,
the differences between these two types of images are more clearly
seen by zooming in on (or magnifying) the image. The Figure below
highlights some of these distinctions.
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Noisy versus Clean Image Samples. The left side is the original (noisy)
image as it was acquired using a 24-bit color scanner. The right side
is the same image after cleaning was performed. The lower two
pictures show magnified sections of the images above. Notice that
colors in the noisy image are not solid (e.g. the red appears to have
darker gold polka dots - an effect caused by half-toning in the
original image). Also notice that the boundaries between different

colors are not sharp. This "blurriness" is commonly attributable to a
process known as anti-aliasing. Thus, in the clean image on the right,
the effects of half-toning and anti-aliasing have been completely
removed.

How to determine the proper resolution to scan or store
images

The images that Digitizing Assistant converts must be stored at a high
resolution in order for optimal results to be achieved. To understand
what this means, it is useful to discuss how scanned pictures are
stored in a computer and what is meant by the term high-resolution.

When a picture is loaded into the computer via a scanner, it is broken
down and stored as a series of colored dots (termed picture elements
or pixels for short). As seen in the magnified portions of the above
figure, each pixel can be viewed as a small square dot of a single
color that corresponds to a specific location within the original image.
However, the number of dots (i.e. pixels) that are scanned and stored
for any given picture is dependent on the resolution at which the



picture was scanned. Specifically, the resolution specifies how many
dots (i.e. pixels) are generated per square inch (or per square
millimeter). In order for humans to see a sharp image (i.e. without
noticing these small dots), an image must have a high resolution. For
example, at a resolution of 300 dots per inch (dpi), the dots become
so small that they typically go unnoticed when viewed by the human
eye. Alternatively, a low-resolution image, for example stored at 100
dots per inch, may appear jagged or unclear because the individual
dots are much larger and become more noticeable. Thus as expected,
in order for Digitizing Assistant to be effective in generating accurate
embroidery designs that do not appear jagged, the source image
must be relatively sharp and must be stored at a high resolution.

The total number of dots (or pixels) needed to accurately store a
specific image depends on the resolution (dpi) and on the desired
output size of the image. For example, a 2 inch by 1 inch picture
stored at 300 dpi (dots per inch), should have a width of 600 dots
and a height of 300 dots. The bare minimum dpi resolution that
Digitizing Assistant requires when generating artwork of a desired
size is approximately 250 dpi, which roughly corresponds to the
inherent resolution at which condensed data points are stored. If all
of this talk about dpi, pixels, and resolution is a bit confusing, don't
worry, this information is only provided to help you understand the
requirements of Digitizing Assistant. If this information doesn't help,
forget it and simply follow the general guidelines presented in the
next section.

Basic guidelines for determining required scan resolutions

1. You need to have relatively clean and reasonably sized source
material. The size of the logo present on a typical business card
may not be sufficient source material, especially if the logo on the
card is 0.2" x 0.1" and you want embroidery that measures 5.0"
x 2.5". Thus, it is generally recommended that at least letterhead
sized artwork be obtained and used with Digitizing Assistant.
Ideally, you would like to have a large clearly printed logo (camera
ready) before you employ the use of Digitizing Assistant.
However, we realize that in reality, this is not practical. Hence,
most logos or artwork taken from business letterhead are
typically large enough to be scanned and used with Digitizing
Assistant. The basic idea to remember here is that you can't start
with very tiny artwork and expect to generate large accurate
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embroidery because when you blow up or enlarge the artwork it
will become extremely blurry.

2. Important: Keep the target resolution in mind when you are
scanning the source material. If the logo measures approximately
2"x1" and you want embroidery that measures 4"x2" you
should consider scanning the image at 600 dpi to produce the
equivalent of a 300 dpi 4"x2" image. This is where scanner
resolution becomes a factor. If your scanner supports 4800dpi X
4800dpi scanning but has a specification stating that it only has a
300dpi x 300dpi optical resolution, this will produce a blurrier
image than if you had a scanner with a true 600 dpi optical
resolution. The biggest things to remember here are: A) you need
a decent quality scanner, and B) there are limits to how much you
can blow up (or enlarge) an image. If you only have .5" x .25"
artwork, even if you scan it in at 1200dpi, it is going to become
extremely blurry and produce poor results.

3. When scanning an image and deciding upon the optimal scan
resolution, there are two factors that are always in opposition to
one another. The first factor is to reduce noise and blurring
(attributable to features such as half-toning) when scanning. One
way of accomplishing this is to scan at a low resolution or a low
dpi (e.g. 100dpi). Unfortunately, the second factor requires that a
large enough design be produced so that the design is processed
at the correct scale. To provide for this second factor, it is often
necessary to scan at a high resolution (e.g. 600dpi). Hence, there
are two opposing considerations that must be balanced when
picking a scan resolution. The larger the source material, the
more flexibility one has in balancing these considerations. Thus, it
is always better to have large artwork (i.e. from advertising
materials, etc.), versus having small artwork (i.e. from business
cards, etc.). For example, if you have a 6"x3" logo and you only
need to produce embroidery that measures 3"x1", you may be
able to scan the logo in at as little as 150dpi. Besides effectively
reducing the size of the logo, this allows much of the noise or
half-toning that may be present in the image to be reduced even
before cleaning is performed from within Digitizing Assistant.

4. Clipart: All of the information mentioned in items 1 and 2 above
also applies to clipart. It is most favorable if the clipart is in a
vector format like that used in Corel Draw (e.g. a cdr file). In this



case, all you need to do is think about what size image you need
(e.g. 2"x1" logo = 600 x 300 pixels), and then just export the
clipart as a bitmap image of this size. If the clipart is not in a vector
format (e.g. pcx, bmp, etc.), you are basically limited to the size it
was saved as, since if you try to enlarge it a lot, it will become
blurry. For example if the clipart was saved at 100dpi and measures
2"x1" (i.e. 200 dots x 100 dots), this really means that you could
only produce a .66"x.33" design. Since .66"x.33" is, in most
cases, an impractical size for embroidery, you would have to
conclude that this clipart image is not usable. Other considerations
when generating images to be processed from clipart include
making sure that paint program features such as anti-aliasing and
super-sampling have been turned off or disabled. While these
features, in many cases, make the image appear clearer to the
human eye, they actually distort the appearance of an image from
the computer's perspective.

As far as obtaining all of this information about dpi, size, etc. from a
stored image file, the information is usually stored with the image and
can be viewed using most paint programs. For example, if you open
the image in Microsoft Photo Editor (included with Microsoft Office),
you can go to Page/Properties and look at the resolution and size tabs
in the dialog box that opens and this will tell you the specs for the
image.

A good rule of thumb that may be used to decide whether an image
has a high enough resolution is to view the image at a zoom factor of
50% on screen. At this zoom factor the image should still appear quite
large, consume almost the entire screen area, and appear relatively
sharp. Oppositely, to determine the presence or amount of noise
within an image, it is often useful to zoom in or enlarge an image to
more than 200% for close examination (as shown in the noisy vs.
clean figure). Quite often, parts of an image that need to be adjusted
or eliminated may only be visible when the image is viewed at this
enlarged scale.

As with any tool, through continued experience scanning images and
using Digitizing Assistant, the user should be able to gain an intuitive
feel for how an image should be scanned without having to spend any
significant amount of time thinking about or computing sizes and dpi.
Hence, most of the information that has been provided in this section
has been intended to simply supply a foundation for this intuition.
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Invoking Digitizing Assistant
1. Start EDS IV and load desired graphic - meeting requirements

discussed in previous chapter (e.g. select one from
\Designs\Graphics).

2. Scale and position graphic, if necessary.

3. Invoke Digitizing Assistant by clicking one of the following icons
on the toolbar

Digitizing Assistant (full) will allow you to trace the whole
image;

If you want to trace only a selected region of the graphic then click
the following icon:

Digitizing Assistant (partial) will allow you to trace the selected
part of the graphic. After partial mode is selected you have to click
on the area you would like to trace.

Overview of Digitizing Assistant Use
As mentioned previously, Digitizing Assistant operates upon both
clean and noisy images. Noisy images (images which contain various
types of noise as explained earlier) must undergo some additional
preprocessing steps which effectively transform them into clean
images before they are converted to embroidery. Thus, there are
fundamentally two different processes that the user may perform
when using Digitizing Assistant. The first is a cleaning process and
the second is the process of converting a clean image to embroidery.
What follows below is a brief overview of each of these two
processes (each of which consists of 3 distinct steps).

Cleaning Images 
The three pictures shown above indicate the three buttons used to
clean images. These buttons also represent the first three basic steps
that must be performed in order to process a noisy image.

The Clean Image Button The first button (depicting a picture of
a scrub brush) is pressed immediately after a noisy image is loaded or
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scanned. The processing performed after pressing this button
attempts to rid the image of various types of noise that may be
present as well as to determine the number of unique solid colors
that compose the image. At the completion of this processing a
dialog box is displayed that indicates the number of solid colors
detected. This number may be corrected by the user (if desired) to
reduce the number of colors used to create a clean version of the
image. Once the dialog box is closed, a rough outline of the image is
also created which delineates contiguous shapes within the image.
Note that at any point, view controls may be used to hide or display
the generated outline and/or bitmap. After the image has been
processed using the clean image button, additional "touch-ups" may
be required. Hence, one or more of the image editing tools may be
used to further correct any inaccuracies or noise remaining within the
image. In this case, temporarily hiding the image's outline may be
useful if pixel editing around the boundary of an object is required. It
is also at this point that any objects which are particularly small or of
a very fine thickness should be removed (if they haven't already been
eliminated during the cleaning step). The paint can flood fill tool is
often useful for performing this task if required. One other common
"touch-up" that may be required is the use of the line tool such that
those objects that have bled into one another or merged may be
properly divided.

The Re-Segment Image Button This button should be pressed
after the bitmap is cleaned and any touch-up image editing is
complete. Pressing this button effectively generates a new, more
precise outline of the processed image. Additionally, if curve fitting
has been enabled, smooth curves along the boundaries of regions
within the image are automatically detected and appropriate arcs are
generated. After pressing this button, the user may adjust the
positioning of outline points using the mouse cursor. Additionally, the
point/arc add and delete tools may be used to add or remove points
from the image's outline.

The Regenerate Image Button This button should be pressed
after all outline editing has been completed. Processing performed
here effectively "regenerates" the artwork by filling in the specified
outlines with the appropriate solid fill colors. After this step is
completed, the bitmapped artwork that is produced should be clean,
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sharp, and free of all noise. At this point, the user may proceed to the
final 3-step process that converts the clean artwork into an embroidery
design. Or alternatively, the user may save the cleaned graphic to disc.

Tutorial - processing a clean image
This is a tutorial designed to familiarize you with the program's main
features.

Step 1: Invoke EDS IV and start new project by pressing the New 
button.

Step 2: Press the Open button and click on the file type drop
down menu and select "All Graphics".

Step 3: Browse to \Designs\Graphics and open "Fun Hat.bmp".

Step 4: Invoke Digitizing Assistant (full) , which will allow you to
trace the whole image.

Step 5: Click on the Punch Design button to generate the final
embroidery information. A simulation of the file is displayed on the
screen. It is more noticeable that the stitching is only simulated for fill-
stitch objects (not shown here) since no complex fill routines are
generated.

The light blue color of the FunHat object indicates that it will be
generated using satin stitches. Larger red circles at the centers of
column intersections indicate control points that may be clicked upon
to provide alternatives to a chosen intersection's interpretation. Also,
displayed are the detected outlines of the objects. A segment
containing a circle indicates a detection of the smooth arc (curved
input point), while small squares indicate straight line segments
(straight input points).



Step 6: Click on the Send to EDS IV Button. Embroidery data
will be sent to EDS IV. You can now work with this as any other
project in EDS IV where the digitizing was done manually.

Note: your embroidery data, created by tracing, will not be saved if
you select "Exit" from the file menu.

Tutorial - processing a noisy image
This is a tutorial designed to familiarize you with the program's main
features.

Step 1: Invoke EDS IV and start new project by pressing the New

button.

Step 2: Press the Open button and click on the file type drop
down menu and select "All Graphics".

Step 3: Browse to \Designs\Graphics and open "Floral1.bmp".
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Step 4: Invoke Digitizing Assistant (full) , which will allow you to
trace the whole image.

Step 5: For the purposes of this tutorial, it will be useful to
ensure that curve fitting has been enabled. Hence, after the image
has loaded, open the processing settings dialog box by clicking on
the button displayed to the left and make sure the check box at the
bottom of the dialog is checked. Then, click OK to close this dialog
box.

Step 6: Click on the Clean button which will attempt to remove
noise from the image and segment the picture into well-defined solid
regions. After processing you will be asked for the number of colors
in the image (as a double check compared to what the software has
determined).

Step 7: Click on the Re-Segment button to re-outline the
image. If curve fitting is enabled, this will also prompt the system to
detect the presence of smooth curves along the edges of objects.
Detected curves will be shown as sections of green arcs containing
small green circles at their centers.

Step 8: Click on the Regenerate button to fill in the outlines
extracted. Slight adjustments may be made to outline vertices by
clicking and dragging them before clicking the regenerate button.

Step 9: Click on the Punch Design button to generate the final
embroidery information. A simulation of the file is displayed on the
screen. It is more noticeable that the stitching is only simulated for
fill-stitch objects (not shown here) since no complex fill routines are
generated.

Step 10: Click on the Send to EDS IV Button. Embroidery data
will be sent to EDS IV. You can now work with this as any other
project in EDS IV where the digitizing was done manually.
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Digitizing Assistant Reference

The Main Bar 

Save Bitmap
Saves current bitmap and over writes existing bitmap if it was changed
by Digitizing Assistant.

Copy to Clipboard
Copies selection to the clipboard to pasted later.

Undo/Redo
Can undo actions and redo actions after they are undone.

Processing Settings
Modifies the default settings used to convert images into embroidery
design data. Specifically, clicking on this button will open up a dialog
box containing various user adjustable settings. These settings include
various thresholds that determine how closely an outline will follow
the exterior edge of a bitmap region. Also included here is a setting
that determines the default amount of overlap that occurs when
embroidery objects are adjacent to one another. Lastly, at the bottom
of the settings dialog box is a check box indicating whether curve
fitting should be used during the conversion process.

Clean
Cleans an imported bitmap. This button (depicting a picture of a scrub
brush) should be pressed immediately after a noisy image has been
loaded or scanned. The processing performed upon pressing this
button attempts to rid the image of various types of noise that may be
present and also attempts to determine the number of unique solid
colors that compose the image. At the completion of this processing a
dialog box is displayed that indicates the number of solid colors
detected. This number may be corrected by the user (if desired) to
reduce the number of colors used to create a clean version of the
image. Once the dialog box is closed, a rough outline of the image is
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also created which delineates contiguous shapes within the image.
Note that at any point, view controls may be used to hide or display
the generated outline and/or bitmap. After the image has been
processed using the clean image button, additional "touch-ups" may
be required. Hence, one or more of the image editing tools may be
used to further correct any inaccuracies or noise remaining within the
image. In this case, temporarily hiding the image's outline may be
useful if pixel editing around the boundary of an object is required. It is
also at this point that any objects which are particularly small or of a
very fine thickness should be removed (if they haven't already been
eliminated during the cleaning step). The paint can flood fill tool is
often useful for performing this task if required. One other common
"touch-up" that may be required is the use of the line tool such that
those objects that have bled into one another or merged may be
properly divided.

Re-Segment
Re-Segment bitmap and create outlines after modifying pixels. This
button should be pressed after the bitmap is cleaned and any touch-
up image editing is complete. Pressing this button effectively generates
a new, more precise outline of the processed image. Additionally, if
curve fitting has been enabled, smooth curves along the boundaries of
regions within the image are automatically detected and appropriate
arcs are generated. After pressing this button, the user may adjust the
positioning of the outline points generated using the mouse cursor.
Additionally, the point/arc add and delete tools may be used to add or
remove points from the image's outline.

Punch Design
This button performs the final processing step that creates the actual
condensed embroidery data file from the interpreted objects. This
button should be pressed after the cleaning and Re-Outline process
has completed and the user has made any necessary changes or
corrections. Upon completion of generation, the screen will display a
simulated stitch output of the artwork. Note that this is not an actual
stitch file, rather it is simply a simulated view that allows the user to
quickly see the fill angles and general directions of stitching specified
by the condensed data. This simulation may be animated using the
View Stitching button. This animation, for example, allows one to view
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the specific sequences or paths that were generated to create satin or
fill stitching. After clicking this button, the final embroidery design
may be saved to disk as a condensed data file or directly imported
into a compatible embroidery design system.

If an object has a light blue color that indicates that it will be
generated using satin stitches. If an object has a pink color that
indicates that it will be generated using fill stitches. Larger red circles
at the centers of column intersections indicate control points that
may be clicked upon to provide alternatives to a chosen intersection's
interpretation. Also, displayed are the detected outlines of the
objects. A segment containing a circle indicates a detection of the
smooth arc (curved input point), while small squares indicate straight
line segments (straight input points).

Send to EDS IV
After converting the graphic into embroidery, the next step is to send
the data to EDS IV by pressing the Send to EDS IV button. Your
embroidery data will not be saved if you exit from the file menu
without sending the data to EDS IV.
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The Zoom Bar 

Zoom In
Allows the user to zoom in on a specific location within an image. To
use this tool, first click on this button (the button will then be shown
as depressed). Then, position the mouse cursor at the upper left-most
point of the area that you wish to view enlarged (notice the mouse
pointer changes its appearance to a magnifying glass). Finally, while
holding down the left mouse button, drag the magnifying glass
cursor to the lower right-most point of the area to be viewed
enlarged and then release the left button. Notice as you drag the
magnifying glass that a rectangle is drawn showing the enclosed area
that will be magnified.

Zoom Out
Zoom out to view an image at a smaller scale. After clicking on the
Zoom Out button, more of an image should be viewable within the
document window if parts of that image were hidden previously (i.e.
if the image was too large to fit within the window previously). The
design currently being viewed should appear smaller.

Zoom Last
Zoom the image using the most prior selected zoom setting. This tool
is useful it is desired to momentarily zoom in on a particular area of
an image for closer examination. Then, upon completion of this
examination, the user may simply press the Zoom Last button to
again view the design at the scale that was selected prior to the
zoom in operation.

Zoom to Fit
Automatically zooms the image such that it is displayed to completely
fit within the boundaries of its window. Pressing this button is useful
if one wishes to see an image or design in its entirety without using
the window's scroll bars.
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The View Bar 

View Bitmap
Displays or hides the current bitmap image being processed. It is often
useful to hide or show the original bitmap image being processed
when the user is adjusting, adding, or removing outline points. This
allows the user to ensure that the outlines appropriately match the
underlying bitmap artwork. When this button is shown as being
depressed, the bitmap image should be visible.

View Edges
This button (depicting a picture of a sharp edged sword) displays or
hides the detected edges (i.e. outer outlines) of objects contained
within a design. When this button is shown as being depressed, the
outline (or edges) of objects should be visible.

View Stitching
Displays or hides a simulation of the generated embroidery design
stitching. When this button is shown as depressed, simulated
embroidery stitching should be viewable on screen if condensed data
has been generated. If the simulated stitching is hidden (by un-
pressing this button) and then the View Stitching button is depressed
again (via a second mouse click), this will cause an animation of the
stitching to be re-displayed. The speed of this animation may be
controlled via the Stitch Slower and Stitch Faster buttons. This
animation gives a general indication of the order and direction of
stitching for objects that have been generated.

Stitch Slower
Decreases the rate at which stitch animation occurs. See the
description of the View Stitching button above to learn how to trigger
a simulated stitching animation.

Stitch Faster
Increases the rate at which stitch animation occurs. See the description
of the View Stitching button above to learn how to trigger a simulated
stitching animation.
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The Tools Bar 

Level
Levels an image by aligning it with an imaginary line drawn or
indicated using the cursor. This tool is useful when it is necessary to
slightly rotate a scanned or loaded image so that its orientation is level
or straight in the horizontal direction. To use this tool, first depress this
button. Then, move the mouse cursor to a point somewhere on the far
left side of the bitmap image (notice that the mouse pointer changes
to indicate that the level tool has been selected). Then, press and hold
down the left button while dragging the mouse to the right. The line
that is generated while you are dragging the mouse should be
positioned such that it is aligned with an imaginary line that would
appear to be perfectly level with items contained in the bitmap image.
When such a line is indicated, release the left button and the image
should be automatically rotated such that this imaginary line is
perfectly level or parallels the horizontal window boundaries

Eye Dropper
Selects the color of an area clicked upon with the mouse as the new
current drawing color.

New Color
Opens a color selection dialog box that allows the user to choose a
new drawing color. This tool is useful when the current drawing color
needs to be changed to a color not already contained within the image
(in which case the eye dropper tool may not be used).

Fill
Fills an area clicked upon with the mouse using the currently selected
drawing color. For information on how to select a drawing color see
the descriptions of the Eye Dropper and New Color buttons.

Pencil
Marks pixels with the currently selected drawing color when they are
clicked upon with the mouse cursor. For information on how to select
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a drawing color see the descriptions of the Eye Dropper and New
Color buttons.

Line
Draws a user-specified line using the currently selected drawing color.
For information on how to select a drawing color see the descriptions
of the Eye Dropper and New Color buttons.

Fill Rectangle
Fills a rectangle drawn with the mouse cursor using the currently
selected drawing color. For information on how to select a drawing
color see the descriptions of the Eye Dropper and New Color buttons.

Brush
Colors groups of pixels clicked upon with the mouse cursor using the
currently selected drawing color. For information on how to select a
drawing color see the descriptions of the Eye Dropper and New Color
buttons.

Regenerate 
Regenerate color segments by filling within outlines. This button
should be pressed after all outline editing has been completed.
Processing performed here effectively "regenerates" the artwork by
filling in the specified outlines with the appropriate solid fill colors.
After this step is completed, the bitmapped artwork that is produced
should be clean, sharp, and free of all noise. At this point, the user
may proceed to "Punch the Design", which converts the clean
artwork into an embroidery design. Or alternatively, the user may
copy the image to the Windows' clipboard to paste and save within
other Windows paint programs. This may prove useful if the
conversion to embroidery will occur at a later time, in which case, the
cleaned image can be quickly reloaded into Digitizing Assistant
eliminating the need to perform the cleaning process again.

Order Objects
Alters the sewing sequence of objects by repositioning them on the
object bar in the order in which they are clicked upon with the
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mouse. This tool provides a quick way of specifying the precise order
in which objects should be sewn. Note that as objects are clicked
upon and repositioned on the object bar, they also become selected.
This is to allow easy movement of a block of objects that have been
precisely ordered to another location on the object bar (e.g. so this
block of objects sews after another block of objects).

Entry/Exit Points

Digitizing Assistant shows an objects entry point by displaying a 
icon at the needle entry location and an objects exit point is indicated
by an icon. It may be useful to modify these entry or exit points to
change the way an object is sewn.  Thus, these icons may be
dragged with the left mouse button to any newly desired location
along the edge of the associated object.  To undo such a
modification, the user may simply open the objects properties dialog
box and re-select the closest point option (under entry exit point
connections) to have the system re-adjust the entry and exit points
for the object so that they lie closest to the objects sewn before and
after the current object respectively.

Object Properties

The Object Properties Dialog Box. Shown above are both pages (i.e.
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tabs) of the object properties dialog box. The General page is
displayed allowing settings that are applicable to all types of objects
to be modified.

The Fill page is displayed allowing settings that are applicable to fill
stitch objects to be modified.

The object properties dialog box may only be opened if there are one
or more objects within the current document window that are
selected. After selecting one or more objects, this dialog box may be
opened by selecting Object | Properties from the menu bar. Settings
that may be modified once this dialog box is opened include:

Stitch Type: This setting is located on the left side of the general page
and allows the user to select what type of stitching should be used to
sew the selected object(s).

Auto-Overlap Depth: This setting is located on the right hand side of
the general page and specifies the degree to which adjacent objects
overlap one another. For example, if a fill stitch type object is sewn
prior to another adjacent (touching) object, the fill stitch boundary at
the location where this adjacency occurs will be automatically
extended by the amount specified here. Then, when the second
object is sewn it will actually overlap or sew on top of the previously
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sewn fill such that accurate registration is guaranteed. This setting
works similarly for satin stitch type objects and also controls the
degree to which satin columns extend underneath one another at
column intersections.

Entry/Exit Point Connections:  This setting is located in the lower right
side of the general page and allows the user to select how entry and
exit points should be calculated for the selected object(s).  The initial
value for this setting is Closest Point; however, when modifying a
starting or ending point for an object manually, this setting is
automatically changed to Custom (user-defined) for that object.
Choosing the Default setting will allow the software to arbitrarily
place entry and exit points for the selected object(s).

Enable Lock Stitches:  This setting is located below the entry/exit
point connections settings in the lower right side of the general page.
It specifies whether a series of lock stitches are sewn near the exit
point of an object before proceeding to the next object to be sewn.
If this option is not checked, no lock stitches are generated.

Fill Direction: This setting is located on the right hand side of the Fill
page. To access this page simply click on the tab at the top of the
dialog box labeled Fill. There are two main choices relating to fill
direction that may be selected here. The first choice, labeled Minimize
# of simple fill regions, causes the system to automatically select a fill
stitch direction that appropriately blends with surrounding adjacent
regions while attempting to minimize the complexity of the fill that
will be generated. The second choice, labeled Angle (degrees), allows
the user to override the automatic settings and specify a desired fill
angle in the text box to the right. There is also a preview area shown
below these two choices which graphically illustrates the selected
stitch direction.

Other items displayed on the general and fill pages (including the
preview area in the lower left corner) are reserved for future use.

Processing Settings

The processing settings dialog box may be opened whenever there is
an open document window displayed within Digitizing Assistant. To
open this dialog box, simple click on the Processing Settings button
or select Process Settings from the menu bar. Typically, most of the
settings contained within this dialog box will never require
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modification. They have already been set to produce optimal results
in the most common situations. However, expert users may have a
need to gain additional control over how images are processed. The
top slider is still reserved for future use and will allow more precise
control over the degree to which an image is cleaned during initial
image processing steps. The middle two sliders control the accuracy
with which outlines are generated. The lower the number (or the
further left the slider is moved), the closer the outlines will match
their associated bitmap areas. Note, too much accuracy can actually
have a negative impact on final results since there will be little or no
tolerance for slight noise that is common around region boundaries.

The bottom slider within this dialog box determines the default auto-
overlap setting applied to all objects generated. This setting may also
be set or overridden on a per object basic as described previously in
the object properties section.

The small check box at the bottom of the first tab in this dialog box
(labeled Curve Fitting) allows the user to enable or disable curve
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fitting. If this box is checked, the system attempts to automatically fit
curved arcs to boundaries that appear curved within an image. Curve
fitting is useful for a variety of image types, however, it may be useful
to disable this feature in certain cases where curves are known to be
absent. There are also similar check boxes which allow other features
(e.g. closest point connection processing & lock stitches) to be
enabled or disabled. Closest point processing organizes stitching to
minimize thread cuts. Specifically, this feature is responsible for
choosing suitable entry and exit points (displayed via the and 
markers) for embroidery objects.  The lock stitches check box
indicates whether or not lock stitches should be generated
automatically at the entry/exit points of embroidery objects.

The user should always adjust the settings displayed here with care
since inappropriate settings may produce undesired results.  Lastly,
the second small check box at the bottom of this dialog determines if
closest point processing will be enabled or disabled.  The View tab
displays the current colors used to display the various types of
stitching.  These colors can easily modified by clicking once on the
color to be changed, bringing up a dialog box, and selecting the new
color from this dialog box.

Addendum: Tips Concerning Sewing Order

A default object ordering is determined automatically after punching
a design . During this step, Digitizing Assistant will try to produce a
reasonable ordering taking into consideration which objects touch
each other as well as each object's stitch type and their relative
locations. However, it is certainly possible that this ordering is not
optimal or that the system may have made some "mistakes" in
determining object ordering. In this case, there are several ways a
user may easily override the chosen object ordering depending on
how much re-ordering is necessary.

If only one object seems to be ordered inappropriately, the user may
simply select that object and then drag its associated button on the
object bar to a new location. This technique also works when
selecting multiple objects. Specifically after several objects are
selected (while holding the CTRL key to do multiple selections), the
user my drag the group of object buttons to a new location on the
bar. At the new location, all selected objects will be inserted while
maintaining their ordering relative to one another. Oppositely,
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buttons on the object bar may be clicked upon and their associated
objects will be shown selected in the design window. This is a quick
way of seeing what object corresponds to a particular button in the
sewing sequence.

If more drastic re-ordering is required, the Order Objects tool button
may be used. After this button is depressed, objects will be ordered
precisely in the order that the user clicks upon them. Note that while
clicking the objects, they are ordered on the object bar and also
selected. Thus, after ordering a small group of objects in a particular
order, the user may then drag this group of objects to a new position
in the sequence by dragging their buttons on the object bar (as
mentioned above).

In general, modifying object ordering in Digitizing Assistant has been
designed to be very easy and intuitive. Even with large designs, the
user should be able to completely change sew order within a few
seconds with a minimal amount of mouse clicks and/or drags.

Addendum: Corner Mitering

The corner mitering feature is used to improve how certain columns
that connect at sharp angles are sewn.  Examples include the tops of
letters such as As, Ms, Ns, or others shapes that contain sharp
corners.  Specifying a corner miter allows these sharp corners to be
sewn using a constant angle satin stitch within and around the
connection.  The order in which these connected columns are sewn
does not matter since the software will automatically ensure that the
appropriate sections of the miter are sewn in the correct order (i.e.
the portion of the column that should be underneath the other
column is always automatically sewn first).

Follow the instructions on the following images to understand how
orner mitering is done.



Here is an 'A' after loading the image, going through the steps of
"create objects", "interpret objects", for an already cleaned artwork.

Inserting a junction
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Inserting a junction

Setting the miter angle



Completing the miter

The finished miter
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